## Contents

### Introduction

<table>
<thead>
<tr>
<th>Subject</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Parallels Desktop</td>
<td>8</td>
</tr>
<tr>
<td>About This Guide</td>
<td>9</td>
</tr>
<tr>
<td>Organization of This Guide</td>
<td>10</td>
</tr>
<tr>
<td>Documentation Conventions</td>
<td>10</td>
</tr>
<tr>
<td>Getting Help</td>
<td>12</td>
</tr>
<tr>
<td>Feedback</td>
<td>12</td>
</tr>
</tbody>
</table>

### Virtual Machine Technology Basics

<table>
<thead>
<tr>
<th>Subject</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Machine Technology Overview</td>
<td>13</td>
</tr>
<tr>
<td>Parallels Virtual Machine</td>
<td>14</td>
</tr>
</tbody>
</table>

### Installing Parallels Desktop

<table>
<thead>
<tr>
<th>Subject</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Requirements</td>
<td>17</td>
</tr>
<tr>
<td>Installing Parallels Desktop</td>
<td>18</td>
</tr>
<tr>
<td>Upgrading to Parallels Desktop 6</td>
<td>21</td>
</tr>
<tr>
<td>Activating Parallels Desktop</td>
<td>22</td>
</tr>
<tr>
<td>Trial Activation</td>
<td>23</td>
</tr>
<tr>
<td>Registering Parallels Desktop</td>
<td>24</td>
</tr>
<tr>
<td>Updating Parallels Desktop</td>
<td>25</td>
</tr>
<tr>
<td>Automatic Updating</td>
<td>26</td>
</tr>
<tr>
<td>Manual Updating</td>
<td>27</td>
</tr>
<tr>
<td>Removing Parallels Desktop</td>
<td>28</td>
</tr>
<tr>
<td>Removing Parallels Desktop Without Installation Disc</td>
<td>29</td>
</tr>
</tbody>
</table>

### Starting Parallels Desktop

<table>
<thead>
<tr>
<th>Subject</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Welcome Window</td>
<td>31</td>
</tr>
<tr>
<td>Parallels Virtual Machines List</td>
<td>33</td>
</tr>
<tr>
<td>Virtual Machine Window</td>
<td>36</td>
</tr>
<tr>
<td>Menus</td>
<td>38</td>
</tr>
<tr>
<td>Status Bar</td>
<td>39</td>
</tr>
<tr>
<td>Customizing Toolbar</td>
<td>41</td>
</tr>
<tr>
<td>Hiding and Showing Parallels Desktop</td>
<td>41</td>
</tr>
</tbody>
</table>

### Parallels Desktop Preferences

<table>
<thead>
<tr>
<th>Subject</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Preferences</td>
<td>42</td>
</tr>
<tr>
<td>Keyboard Preferences</td>
<td>45</td>
</tr>
<tr>
<td>USB Preferences</td>
<td>49</td>
</tr>
<tr>
<td>Mobile Preferences</td>
<td>51</td>
</tr>
<tr>
<td>Advanced Preferences</td>
<td>53</td>
</tr>
<tr>
<td>Shared Networking Settings</td>
<td>56</td>
</tr>
<tr>
<td>Host-Only Networking Settings</td>
<td>59</td>
</tr>
</tbody>
</table>
Setting Up a Virtual Machine

Supported Guest Operating Systems ................................................................. 61
Creating a New Virtual Machine ....................................................................... 63
  Default Configurations ................................................................................. 66
  Installing a Guest Operating System ........................................................... 67
  Like a Mac or like a PC? ............................................................................... 69
Opening an Existing Virtual Machine ............................................................. 70
Using Boot Camp Partition in Virtual Machine ............................................... 71
Moving Data from PC to a Virtual Machine .................................................... 72
Downloading Virtual Appliances ..................................................................... 73
Installing Parallels Tools ................................................................................ 74
  Parallels Tools Overview ........................................................................... 75
  Parallels Tools for Windows ....................................................................... 77
  Parallels Tools for Linux .......................................................................... 79
  Parallels Tools for Mac .......................................................................... 82
  Parallels Tools for OS/2 and eComStation Guest OSs ............................... 83
  Parallels Tools for Windows 98 ................................................................. 85
  Updating Parallels Tools .......................................................................... 86
  Removing Parallels Tools ......................................................................... 88

Working With Virtual Machines

Basic Operations ............................................................................................ 90
  Starting a Virtual Machine and Shutting it Down ....................................... 90
  Suspending and Pausing a Virtual Machine ............................................... 91
  Changing the View Mode ......................................................................... 93
  Capturing Keyboard and Mouse ............................................................... 98
  Using Keyboard Shortcuts in a Virtual Machine ...................................... 99
  Installing Applications in a Virtual Machine ............................................ 99
  Placing an Image on Top of the Virtual Machine Window ...................... 100
  Making Screenshots ............................................................................... 101
  Changing the Configuration at Runtime ................................................... 102
Working With Virtual Machine's Applications ............................................ 104
  Setting Up Virus Protection ................................................................... 104
Getting Acronis Applications ...................................................................... 105
Using 3D Graphics Applications ................................................................ 106
Using Touchpad Gestures and Apple Remote ........................................... 107
Configuring Network in Virtual Machines .................................................. 109
  Shared Networking ................................................................................. 109
  Bridged Ethernet Networking ................................................................ 111
  Host-Only Networking ........................................................................... 112
  Using WiFi in a Virtual Machine .............................................................. 113
  Bridging a Virtual Machine to VLAN ....................................................... 113
Connecting USB Devices to a Virtual Machine ......................................... 114
  Synchronizing a USB Palm OS Device With the Guest OS .................... 117
Setting Up a Printer in a Virtual Machine .................................................... 117
  Sharing a Mac Printer ............................................................................ 118
  Setting Up a Printer via Bonjour .............................................................. 120
  Setting Up a Network Printer ................................................................. 122
Managing Virtual Machines ......................................................................... 125
  Backing Up a Virtual Machine ............................................................... 125
  Encrypting the Virtual Machine .............................................................. 127
  Using Safe Mode ................................................................................... 128
  Cloning a Virtual Machine .................................................................... 129
  Working With Virtual Machine Templates ............................................ 130
  Working With Snapshots ...................................................................... 134
  Managing Virtual Machines Using Spoken Commands ......................... 140
Configuring the Virtual Machine 170

Integrating Mac OS and Virtual Machine 143

Managing Virtual Machines from Parallels Mobile .......................................................... 141
Removing a Virtual Machine .................................................................................................. 142

Integrating Mac OS and Virtual Machine 143

Working in Coherence ........................................................................................................... 144
Crystal Mode ......................................................................................................................... 148
Working in Full Screen ........................................................................................................... 151
Using the MacLook Theme in Windows ............................................................................... 152
Sharing Applications and Files ............................................................................................. 154
Sharing Folders and Disks ..................................................................................................... 154
Using Shared Profile .............................................................................................................. 158
Using Shared Applications .................................................................................................... 159
Using SmartSelect .................................................................................................................. 162
Sharing Web Applications .................................................................................................... 165
Browsing Virtual Hard Disks in Finder ................................................................................... 167
Copying and Pasting Between Mac and Windows ................................................................. 168
Enabling Parental Control in a Virtual Machine ................................................................. 169

Configuring the Virtual Machine 170

General Settings ..................................................................................................................... 171
Options ................................................................................................................................... 173
Start up and Shutdown Settings ............................................................................................. 174
Optimization Settings ............................................................................................................ 176
Security Settings .................................................................................................................... 179
Sharing Settings ..................................................................................................................... 181
Applications Settings ............................................................................................................. 184
Backup Settings ..................................................................................................................... 186
Coherence Settings ................................................................................................................ 188
Full Screen Settings .............................................................................................................. 190
Modality Settings ................................................................................................................... 192
Advanced Settings ................................................................................................................ 193
Hardware Settings ................................................................................................................ 195
Boot Order Settings ............................................................................................................... 195
Video Settings ......................................................................................................................... 197
Floppy Settings ....................................................................................................................... 199
CD/DVD-ROM Settings ......................................................................................................... 200
Hard Disk Settings ................................................................................................................. 202
Network Settings .................................................................................................................... 206
Printer Port Settings .............................................................................................................. 208
Serial Port Settings ................................................................................................................ 208
Sound Settings ....................................................................................................................... 212
USB Settings .......................................................................................................................... 214
Adding and Removing Devices ............................................................................................... 215
Troubleshooting and Limitations

Getting Technical Support ................................................................. 224
Reporting a Problem to Parallels Team ............................................. 225
Checking the Build Number .............................................................. 226
Installing Windows 98 as a Guest OS ............................................ 227
Using the F8 Key in Windows Virtual Machines ............................... 229
Upgrading or Installing Parallels Tools in Text Mode in a Linux Guest OS ...................................................... 230
Installing the GCC Package and Kernel Sources in Linux ................. 231
Memory Usage Problems .................................................................. 232
Configuring Network in Linux ........................................................ 233
If Your Virtual Machine Is Slow ...................................................... 234
Problems with Setting Up Network .................................................. 235
Problems with Antivirus Software .................................................... 235

Glossary

Index
Parallels Desktop for Mac lets you seamlessly run Windows and Mac OS X side-by-side, drag-and-drop your files between operating systems, and run Windows software on your Apple computer without rebooting. This chapter provides general information about Parallels Desktop for Mac and this User Guide.

In This Chapter

About Parallels Desktop.......................................................... 8
About This Guide...................................................................... 9
Getting Help........................................................................... 12
Feedback .................................................................................. 12
About Parallels Desktop

Parallels Desktop® is a virtualization solution that allows you to create virtual machines on Macintosh computers with Intel® processors (1.66 GHz and faster). You can install a Windows, Linux, Mac OS X, or any other supported guest operating system in each of your virtual machines, and work with them and their applications side by side with your Mac OS X applications.

Built on Parallels’ award-winning hypervisor-based virtualization technology, Parallels Desktop allows you to:

- create powerful and easy to use virtual machines
- use 32-bit and 64-bit operating systems inside your virtual machines
- use Windows and Linux applications side by side with your Mac OS X applications, without restarting your Mac
- concurrently work with the files and applications from your Mac and your virtual machine
- create Parallels virtual machines from physical computers and third-party virtual machines

To enhance your experience of running more than one operating system on your Macintosh computer, Parallels Desktop for Mac includes Parallels Transporter® for transferring data from physical computers to Parallels virtual machines and Parallels Mounter for accessing your virtual machine's files and folders even when it is not running.

* You can install only the server versions of Mac OS X in virtual machines.
About This Guide

This guide is aimed at a wide range of users who want to use Parallels Desktop to create, configure, and run Parallels virtual machines on Mac computers.

Abbreviations Used in the Text

The following abbreviations are used in the guide:

- **OS** is used instead of *operating system* in long sentences where using it will not change the meaning of the sentence.
- **VM** is used instead of *virtual machine* in long sentences where using it will not change the meaning of the sentence.

Definitions

*Primary operating system* (primary OS): In this guide, this term is used to refer to the operating system that controls the I/O devices of the computer and that is loaded when the physical computer is turned on, that is, Mac OS X.

*Guest operating system* (guest OS): The term is used to refer to an operating system that is installed in a virtual machine.

Help Usage Tips

Use the icons in the upper part of the help window to:

- go to the online documentation page
- watch the online video tutorial
- contact the Parallels support team

To print a help page, click on the **Print** icon. If this doesn’t work, right-click the **Print** icon and choose **Print Frame**.

Organization of This Guide

This guide consists of the following chapters:

- **Introduction** (p. 7) (you are reading it now). Provides basic information about the product and this guide.
- **Virtual Machine Technology Basics** (p. 13). Provides information on the specification and technologies of virtual machines.
- **Installing Parallels Desktop** (p. 16). Provides instructions on product installation.
- **Starting Parallels Desktop** (p. 30). Provides basic information on how to work with Parallels Desktop.
- **Parallels Desktop Preferences** (p. 42). Provides information on how to configure the Parallels Desktop preferences.
- **Setting Up a Virtual Machine** (p. 60). Provides instructions on creating a new virtual machine and adding an existing one.
- **Working With Virtual Machines** (p. 89). Provides basic information on how to work with virtual machines.
- **Integrating Mac OS X and Your Virtual Machine** (p. 143). Provides information on how to enhance the integration between Mac OS X and your virtual machine.
- **Configuring a Virtual Machine** (p. 170). Provides information on how to change the virtual machine configuration.
- **Troubleshooting and Limitations** (p. 224). Provides the solutions for some of the known issues.

Documentation Conventions

Before you start using this guide, it is important to understand the documentation conventions used in it.

The table below presents the existing formatting conventions.

<table>
<thead>
<tr>
<th>Formatting convention</th>
<th>Type of Information</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Bold</td>
<td>Items you must select, such as menu options, command buttons, or items in a list.</td>
<td>Go to the Resources tab.</td>
</tr>
<tr>
<td></td>
<td>Titles of chapters, sections, and subsections.</td>
<td>Read the Basic Administration chapter.</td>
</tr>
</tbody>
</table>
Italics

Used to emphasize the importance of a point, to introduce a term or to designate a command-line placeholder, which is to be replaced with a real name or value.

These are the so-called *EZ templates*.

To destroy a Container, type `vzctl destroy ctid`.

**Monospace**

The names of commands, files, and directories.

Use `vzctl start` to start a Container.

**Preformatted**

On-screen computer output in your command-line sessions; source code in XML, C++, or other programming languages.

Saved parameters for Container 101

**Monospace Bold**

What you type, as contrasted with on-screen computer output.

# rpm –V virtuozzo-release

**Key+Key**

Key combinations for which the user must press and hold down one key and then press another.

Ctrl+P, Alt+F4

Besides the formatting conventions, you should also know about the document organization convention applied to Parallels documents: chapters in all guides are divided into sections, which, in their turn, are subdivided into subsections. For example, *About This Guide* is a section, and *Documentation Conventions* is a subsection.
Getting Help

Parallels Desktop provides several ways to access the necessary information:

- **Search Field.** You can use this field available from the Parallels Desktop Help menu to perform a keyword search in both Parallels Desktop Help and the Knowledge Base. In this field, type a keyword and click **Show All Help Topics** - the related topics will be displayed.

- **Parallels Desktop Help.** Contains extensive information about the product and its uses. To open Parallels Desktop Help, choose **Help > Parallels Desktop Help** from the menu.

- **Help Buttons.** In most windows, you will find a help button (?) opening the corresponding help page.

- **Online Documentation.** PDF documentation for Parallels Desktop and Parallels Transporter. To open the online documentation page, choose **Online Documentation** from the Help menu.

- **Parallels Command Line Reference Guide.** This guide contains information on how to use the `prlctl` command line utility designed to manage Parallels Desktop and its virtual machines from Terminal. To access the guide, go to the Online Documentation page on our website.

- **Parallels API References and the SDK Programmer’s Guide.** These guides are written primarily for IT-professionals and can be found on the Online Documentation page on our website.

- **Parallels website** (http://www.parallels.com). Explore the Support web page that includes product help files and the FAQ section.

- **Parallels Knowledge Base** (http://kb.parallels.com/). This online resource provides troubleshooting for common problems and includes helpful articles about using Parallels Desktop and other Parallels products.

Feedback

If you spot a typo in this guide, or if you have an opinion about how to make this guide more helpful, you can share your comments and suggestions with us by completing the Documentation Feedback form on our website (http://www.parallels.com/en/support/usersdoc/).
This chapter provides a brief description of Parallels virtual machines, their specifications, and the underlying technologies.

In This Chapter

Virtual Machine Technology Overview................................................................. 13
Parallels Virtual Machine...................................................................................... 14

Virtual Machine Technology Overview

The Parallels Desktop software is based on the virtual machine technology that allows you to share the hardware resources of the physical computer between the primary operating system (the operating system installed on this physical computer) and multiple virtual machines running on this computer.

The virtual machine technology can be successfully used on computers that support the Intel virtualization technology (Intel VT-x). This technology allows Parallels Desktop to emulate virtual processors inside virtual machines.

Intel VT-x implemented in the architecture of the new Intel processors is specially developed for platforms running multiple operating systems. VT-x processors allow more precise emulation of virtual processors. To learn more about Intel virtualization technology, visit the Intel website.
Parallels Virtual Machine

Taking the best from the virtual machine and Intel virtualization technologies, Parallels Desktop enables you to create virtual machines with a variety of virtual hardware devices.

A Parallels virtual machine works like a stand-alone computer with the following hardware:

<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Up to 8-core Intel Celeron CPU</td>
</tr>
<tr>
<td>Motherboard</td>
<td>Intel i965 chipset based motherboard</td>
</tr>
<tr>
<td>RAM</td>
<td>Up to 8 GB of RAM</td>
</tr>
<tr>
<td>Video Adapter</td>
<td>VGA and SVGA with VESA 3.0 compatible Video Adapter</td>
</tr>
<tr>
<td>Video RAM</td>
<td>Up to 256 MB of Video RAM</td>
</tr>
<tr>
<td>Floppy Disk Drive</td>
<td>1.44 MB Floppy Disk Drive mapped to an image file or to a physical floppy drive.</td>
</tr>
<tr>
<td>IDE Devices</td>
<td>Up to 4 IDE devices</td>
</tr>
<tr>
<td>- Hard Disk</td>
<td>Hard Disk Drive mapped to an image file (up to 2 TB each)</td>
</tr>
<tr>
<td>- CD/DVD-ROM Drive</td>
<td>CD/DVD-ROM drive mapped to a physical drive or to an image file</td>
</tr>
<tr>
<td>SCSI Devices</td>
<td>Up to 15 SCSI devices</td>
</tr>
<tr>
<td>- Hard Disk</td>
<td>Hard Disk Drive mapped to an image file (up to 2 TB each)</td>
</tr>
<tr>
<td>- Generic Device</td>
<td>Generic SCSI device</td>
</tr>
<tr>
<td>Network Interfaces</td>
<td>Up to 16 Network interfaces: including Ethernet virtual network card compatible with RTL8029</td>
</tr>
<tr>
<td>Serial (COM) Ports</td>
<td>Up to 4 Serial (COM) ports, mapped to a socket or to an output file</td>
</tr>
<tr>
<td>Printer (LPT) Ports</td>
<td>Up to 3 Parallel (LPT) ports, mapped to output file, to a real port, or to a printer</td>
</tr>
<tr>
<td>Sound Card</td>
<td>AC97-compatible Sound Card, sound recording support</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Generic PC keyboard</td>
</tr>
<tr>
<td>Mouse</td>
<td>Wheel mouse</td>
</tr>
</tbody>
</table>

Each virtual machine is stored in Mac OS X as a bundle of files (.pvm) that contains the virtual machine configuration file (.pvs), the virtual hard disk file (.hdd), and other files of the virtual machine.

A virtual machine may have the following files:

<table>
<thead>
<tr>
<th>Extension</th>
<th>File Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.pvm</td>
<td>A bundle that contains the virtual machine files.</td>
</tr>
<tr>
<td>.pvs</td>
<td>A virtual machine configuration file. It defines hardware and resources configuration of a virtual machine. The configuration file is generated when the virtual machine is created.</td>
</tr>
<tr>
<td>File Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>.sav</td>
<td>A file created when the virtual machine is suspended. It contains the state of the virtual machine and its applications for the moment the suspend was invoked.</td>
</tr>
<tr>
<td>.mem</td>
<td>A file containing memory dump for the suspended virtual machine. For a running virtual machine, it is a temporary virtual memory file.</td>
</tr>
<tr>
<td>.hdd</td>
<td>A bundle of files that represents a virtual hard disk of a Parallels virtual machine. When you create a virtual machine, you can create it with a new virtual hard disk or use an existing one.</td>
</tr>
<tr>
<td>.iso/.dmg</td>
<td>Image files of CD or DVD discs. Virtual machines treat ISO and DMG images as real CD/DVD discs.</td>
</tr>
<tr>
<td>.fdd</td>
<td>A floppy disk image file. Virtual machines treat FDD images as real diskettes. If you install a Windows guest OS in the Express Windows installation mode, Parallels Desktop creates the unattended.fdd floppy disk image file and places it to the virtual machine folder. The file is required for Windows Server 2003, Windows XP, and Windows Vista installation.</td>
</tr>
<tr>
<td>.txt</td>
<td>Output files for serial and parallel ports. The output .txt files are generated when a serial or parallel port connected to an output file is added to the virtual machine configuration.</td>
</tr>
</tbody>
</table>

For a virtual machine that has any Windows OS installed (starting from Windows 2000), the following subfolders are created automatically in the virtual machine folder:

- The **Windows Applications** folder. This folder contains aliases for the Windows applications installed in the virtual machine. Aliases are used for supporting the file extensions' transparency.
- The **Windows Disks** folder. This folder contains aliases for the Windows disks available in the virtual machine.
This chapter provides the information on how to:

- Install Parallels Desktop on your Mac (p. 18);
- Activate and register (p. 24) Parallels Desktop;
- Update Parallels Desktop (p. 25);
- Upgrade to Parallels Desktop 6 (p. 21) from the previous versions of Parallels Desktop; and
- Remove Parallels Desktop (p. 28).

**In This Chapter**

System Requirements ............................................................................................................ 17
Installing Parallels Desktop .................................................................................................. 18
Upgrading to Parallels Desktop 6 ........................................................................................ 21
Activating Parallels Desktop .............................................................................................. 22
Registering Parallels Desktop ............................................................................................. 24
Updating Parallels Desktop ............................................................................................... 25
Removing Parallels Desktop ............................................................................................... 28
System Requirements

Hardware Requirements
- Any Macintosh computer with an Intel processor (1.66 GHz or greater). To run 64-bit operating systems in virtual machines, an Intel Core 2 or later processor is required.
- Minimum 1 GB of memory, 2 GB of memory is recommended.

  Note: Your Mac must have enough memory to run Mac OS X and your Mac applications, plus the memory required for the virtual machine guest operating system and the applications installed in it.

- At least 500 MB of disk space on the boot volume (Macintosh HD) for Parallels Desktop installation.
- About 15 GB of disk space for each virtual machine.

Software Requirements
- Mac OS X Snow Leopard 10.6.3 or later
- Mac OS X Leopard 10.5.8 Leopard or later

  Note: Mac OS X Tiger v10.4.x is not supported in this version of Parallels Desktop.

To get information about your Mac OS X version, type of processor, and amount of memory, choose About This Mac from the Apple menu.
Installing Parallels Desktop

Before installing Parallels Desktop make sure that your computer meets the hardware and software requirements (p. 17).

If you purchased Parallels Desktop from the Parallels online store, download the latest build from Parallels Download Center (http://www.parallels.com/download/). When the download is complete, open the Parallels Desktop DMG package file. To start the installation, double-click Install.

If you purchased a boxed copy of Parallels Desktop, insert the Parallels Desktop installation disk into the optical drive of your Mac. Open the Parallels Desktop DMG package and double-click Install.

1 Parallels Desktop will connect to the Parallels update server and check for available updates. If there is a newer version of Parallels Desktop available, you will be given the option to install the most recent version of Parallels Desktop. If you do not want to install the most recent version, you can choose to install the version from the installation media.
If you click **install current**, Parallels Desktop will be installed from the installation media.

If you click **Download and install new version**, the latest version of Parallels Desktop will be downloaded and installed on your Mac.

If there is no update available or your Mac is not connected to the internet, Parallels Desktop will be installed from the current installation source.

2 In the Welcome window, click **Continue**.

3 In the Important Information window, read the product Read Me file. Click **Print** to print the document or **Save** to save it for future reading. When finished, click **Continue**.

**Note:** You can return to the previous steps by clicking the **Go Back** button.

4 In the Software License Agreement window, carefully read the license agreement. We recommend to print the license agreement for your records using the **Print** button or to save it for future reading using the **Save** button. When you are ready, click **Continue**.
In the pop-up dialog, click **Agree** if you agree with the terms and conditions of the license agreement.

5 In the **Customer Experience Program** window, read about the Parallels Customer Experience Program and click **Continue**.

In the pop-up dialog, click **Yes** if you want to participate in the program. If you don't want to participate, click **No**.

*Note:* If you choose not to participate, you may join the program later using the **Advanced** pane (p. 53) of Parallels Desktop **Preferences**.

6 In the **Select a Destination** window, select the hard disk you would like to install Parallels Desktop. You can install Parallels Desktop only on the boot volume, that is the hard disk where Mac OS X is installed. Other disks, if any, will be unavailable for selection. Click **Continue**.

*Note:* If you have only one volume on your Mac, this step is omitted.

7 Click **Install** to start the Parallels Desktop installation.

8 Enter your password when prompted and click **OK**.

9 The installation progress is shown in the **Installing Parallels Desktop** window.

10 The Installer informs you that the installation was successful. To complete the installation, click **Close**.

After the installation, you can launch Parallels Desktop from the **Applications** folder on your Mac.
Upgrading to Parallels Desktop 6

To upgrade Parallels Desktop 3, 4 or 5 to version 6, you will need to purchase an upgrade from the Parallels Online Store (http://www.parallels.com/buyonline). The upgrade activation key will be sent immediately to the e-mail address you provided.

**Note:** Parallels Desktop 2 cannot be upgraded to Parallels Desktop 6.

You can upgrade Parallels Desktop 3, 4 or 5 to any language version of Parallels Desktop 6. This means, if you have an English version of Parallels Desktop 4 and want to upgrade it to a German version of Parallels Desktop 6, you can simply purchase the German upgrade, install it on your Mac, and activate it with the upgrade activation key.

Before the upgrade, you must shut down any virtual machines running on your Mac and quit Parallels Desktop.

The upgrade takes three steps: 1) installing Parallels Desktop 6, 2) activating it using the upgrade key, 3) and upgrading your virtual machines.

**Installing Parallels Desktop 6**

Generally, the upgrading procedure for Parallels Desktop is the same as for its installation. See **Installing Parallels Desktop** (p. 18).

You don't have to remove the previous version of Parallels Desktop before installing the upgrade: it will be removed automatically during the installation.

**Using an Upgrade Activation Key**

When you open Parallels Desktop 6 for the first time, you will be prompted to activate your copy.

If your previous version was activated using a full key, not a trial one, you will need to provide the upgrade key only. Otherwise you may be prompted to confirm that you have a valid full key for the previous version:

- If you activated Parallels Desktop with a trial activation key, you will be prompted to enter two keys: the upgrade activation key for Parallels Desktop 6 and a full or upgrade key for the previous version.
- If you purchased the previous version of Parallels Desktop but haven't installed it on your Mac, you will need two keys to activate Parallels Desktop 6: the upgrade activation key for Parallels Desktop 6 and a full or upgrade key for the previous version.

**Upgrading the Virtual Machine Configuration and Updating Parallels Tools**

When you start a virtual machine created in the previous version, the upgrading procedure starts and runs automatically. During the upgrade, the virtual machine configuration and Parallels Tools are processed. The virtual machine can be used in Parallels Desktop 6 only after it is upgraded.
Installing Parallels Desktop

**Note:** In Linux virtual machines, X Server may fail to start after the upgrade, which means that you may need to upgrade Parallels Tools manually in text mode (p. 230).

If you encounter any problems during the upgrade, visit the upgrade troubleshooting page or use the online Troubleshooting guide available through Help > Troubleshooting Guide.

---

## Activating Parallels Desktop

To fully run Parallels Desktop, you should activate it with an activation key. If you purchased a boxed version of the program, you can find the activation key printed on the installation CD sleeve. If you purchased the program online, the activation key was sent to you by email. If you downloaded a copy of Parallels Desktop to evaluate it before buying, you can get a trial activation key valid for a certain period of time.

After you activate your copy of Parallels Desktop, you can run virtual machines, install operating systems and various applications in them.

If you upgraded Parallels Desktop to version 6 from the previous version, you need an upgrade activation key to activate Parallels Desktop 6. For detailed information, see the Upgrading to Parallels Desktop 6 (p. 21) section of Parallels Desktop User's Guide.

### Activating Your Copy of Parallels Desktop

To activate Parallels Desktop:

1. Choose **Activate Product** from the Parallels Desktop menu.

2. In the activation dialog, type your product activation key into the **Activation Key** field and click **Activate** to activate your copy.

Now that your copy of Parallels Desktop is active, you need to register it (p. 24).
Trial Activation

To get a trial activation key for Parallels Desktop:

1. Choose Activate Product from the Parallels Desktop menu.
2. In the activation dialog (p. 22), click Get Trial.
3. Specify your name and e-mail address.
4. Click the Get Trial button to send this information to Parallels.

A free trial activation key will be sent to the e-mail address you provided.

When your free trial activation key expires, you will need to get a permanent activation key.

Getting a Permanent Activation Key

To purchase an activation key:

1. Choose Activate Product from the Parallels Desktop menu.
2. In the activation dialog (p. 22), click Buy Now to open Parallels Online Store (http://www.parallels.com/buyonline) where you can purchase an activation key.
Registering Parallels Desktop

After you have activated your copy of Parallels Desktop with a permanent activation key, you will be asked to register it.

We strongly recommend you to register your copy of Parallels Desktop. With registration, you will be able to:

- Download and install the latest Parallels Desktop updates.
- Create a backup copy of the product key on the Parallels web server and restore it at any time.
- Easily contact the Parallels support team, using the support code.
- Stay informed about Parallels news and announcements.

All these services, including the product key backup, are free of charge for the registered users of Parallels Desktop.

The registration procedure

1. To register Parallels Desktop after its activation, enter your email and password and click Log In. If you have no account, click Create New Account.
NOTE: If you didn't register Parallels Desktop after its activation, you can register it later by choosing Register Product from the Parallels Desktop menu.

2 If you already have the account, in this step you can change your personal information.

If you have no account, in this step enter your name, email, and password in the corresponding fields, specify your personal information and where you are going to use Parallels Desktop. If you choose At work or At school from the For use list, you will be asked to specify some additional information. Parallels needs this information in order to provide our customers with the best software and service.

When ready, click Register to register Parallels Desktop.

Updating Parallels Desktop

Parallels Desktop includes an updating feature that helps you keep your Parallels Desktop installation up-to-date. You can use the update feature only if your computer is connected to the Internet.

Update checks can be performed either automatically or manually.

- We recommend that you turn on automatic updating to be notified when an update is available. Parallels Desktop will regularly check for available updates and inform you about them.
- In addition to automatic updating, you can start the updating manually at any time.

NOTE: Before updating, you will be asked to quit Parallels Desktop. If you have any virtual machines running or paused, suspend or shut them down. When you start or resume your virtual machines after the update, reinstall Parallels Tools.
Automatic Updating

To use the automatic updating feature, your Mac computer should have a stable Internet connection.

Parallels Desktop enables you to set up an automatic check for updates and determine the frequency for this checking.

**Note:** To set up an automatic check for updates, you must register your copy of Parallels Desktop (p. 24) first.

To set up automatic update checking:

1. Launch Parallels Desktop.
2. In the **Parallels Desktop** menu, select **Preferences** and go to the **General** pane.
3. In the **General** pane, you can define the necessary settings. To set up automatic searches for new versions, define the search frequency in the **Check for updates** list. The system can search for new updates once a day, once a week, or once a month. With these options set, Parallels Desktop will access the Parallels update server and notify you when an update is available. If you do not want automatic search for updates, select **Never** in the **Check for updates** list.

   Select **Download updates automatically** if you want all new available updates to be downloaded at once without showing you the **Download** dialog.

   In the **General** pane, you can also perform a manual instant search for updates. To do that, click **Check Now**. The updates available for your version of Parallels Desktop will be displayed in the **Download** dialog. Choose the update(s) you want to install and click the **Download** button. If your version of Parallels Desktop is up to date, you will see the corresponding message.
Manual Updating

Parallels Desktop also enables you to check for updates manually whenever you want.

**Note:** To check for updates, you must register your copy of Parallels Desktop (p. 24) first.

To check for updates manually:

1. Launch Parallels Desktop.

2. From the **Parallels Desktop** menu, choose **Check for Updates**. The program will immediately start the search for updates.

   While the updater accesses the Parallels update server and compares the available updates with the installed version, you can hide this window by selecting **Check in background**.

3. If there is one or more updates available, they will be listed in the **Parallels Update** window. Select the update to install and click **Install**.

   You can also download the update by clicking the **Download** button. To change the download folder, type the path into the **Download folder** field or use the **Choose** button to locate the folder.

**Note:** You can install the downloaded update later by locating it in Finder and launching the installer.
4 Specify your user name and password to start the installation and click OK.

5 Follow the instructions of the Parallels Desktop installer to install the update.

**Note:** If the installer displays a list of conflicting applications, quit these applications to be able to proceed with the installation.

6 When the update is installed, click Close to quit the installer.

---

## Removing Parallels Desktop

To remove Parallels Desktop:

1 Locate and open the DMG installation image file that you used to install Parallels Desktop and double-click Uninstall.

2 In the Welcome dialog, click Continue.

3 In the Select components to uninstall window, select the components you want to remove and click Uninstall. Selecting the Application Settings option removes the Parallels Desktop settings, network settings, and the list of registered virtual machines from your computer.

**Note:** The operation of removing Parallels Desktop doesn't remove the virtual machines and their files from your Mac.

Confirm your choice of the components to be removed by clicking Uninstall.

4 Enter your password when prompted and click OK.

5 The uninstaller removes Parallels Desktop from your Mac.

6 When the removal is complete, click Close to quit the uninstaller.
Removing Parallels Desktop Without Installation Disc

Parallels Desktop can be removed without the installation disc using the Terminal.

To remove Parallels Desktop using the Terminal:

1. Open the Terminal (it is usually available in the /Applications/Utilities folder) and enter the following command:
   
   ```sh
   sudo sh /Library/Parallels/Uninstaller/Parallels\ Hypervisor/uninstaller.sh
   ```

   **Note:** If the `Password:` line appears, you will need to enter an administrator's password.

2. When Parallels Desktop is removed the following message appears:

   ```
   [UN_PERCENT]:100[UN_OP]:Uninstall successfull[UN_MSG]:Removed successfully
   ```

   **Note:** The operation of removing Parallels Desktop doesn't remove virtual machines and their files from your Mac.
CHAPTER 4

Starting Parallels Desktop

To start Parallels Desktop, open the Applications folder in Finder and double-click Parallels Desktop.

In This Chapter

The Welcome Window ................................................................. 31
Parallels Virtual Machines List ................................................. 33
Virtual Machine Window .......................................................... 36
Menus .................................................................................. 38
Status Bar ............................................................................. 39
Customizing Toolbar ................................................................. 41
Hiding and Showing Parallels Desktop ........................................ 41
Starting Parallels Desktop

The Welcome Window

When you start Parallels Desktop for the first time, you will see the Welcome window that will help you start working in Parallels Desktop. The Welcome window provides you with fast access to the most common Parallels Desktop dialogs and assistants.

If you want to start working with the virtual machines already registered in Parallels Desktop, close the Welcome window and the Parallels Virtual Machines list (p. 33) will open.

Note: Later on, if you do not want to see the Welcome window again, just deselect the Show at startup option at the left bottom corner of the window.
From the Welcome window, you can navigate between the following options:

- **New Windows installation.** This option allows you to launch New Virtual Machine Assistant to create a virtual machine with a Windows, Linux, Mac OS X, or any other supported guest operating system (p. 61).

- **Migrate Windows from PC.** This option allows you to transfer an entire physical Windows computer to a Parallels virtual machine running on your Mac. The source computer data will be transferred using Parallels Transporter. To learn more about this utility, refer to Parallels Transporter User’s Guide.

- **Use your Virtual Machines.** If you have any virtual machines registered in Parallels Desktop, this option opens the Parallels Virtual Machines list (p. 33) with these virtual machines. If you have no virtual machines registered in Parallels Desktop, this option launches New Virtual Machine Assistant.

You can open and view the Parallels Desktop brief tutorials on the Parallels website by clicking the Watch video tutorials button.

You can open virtual machines that are not registered in Parallels Desktop by clicking the Open button. If you open a Parallels virtual machine, it will be registered in Parallels Desktop and added to the Parallels Virtual Machines list (p. 33). You can also open third party (VMware, Microsoft Virtual PC, VirtualBox) virtual machines. If you open a third party virtual machine, it will be converted into the Parallels Desktop format and added to the Parallels Virtual Machines list (p. 33).
Parallels Virtual Machines List

The Parallels Virtual Machines list shows the virtual machines and virtual machines templates currently registered in Parallels Desktop.

Note: If you have no virtual machines and no virtual machines templates registered in Parallels Desktop, the Parallels Virtual Machines list will not open.

To open the Parallels Virtual Machines list do one of the following:

- Choose Virtual Machines List from the Window menu.
- Right-click the Parallels Desktop icon in the Dock and choose Virtual Machines List from the shortcut menu.
- Start Parallels Desktop and close the Welcome window (p. 31). If you have at least one registered virtual machine or virtual machine template, the Parallels Virtual Machines list will appear.
- Start Parallels Desktop with the Welcome window disabled. Provided that you have at least one registered virtual machine or virtual machine template the Parallels Virtual Machines list will appear.

Note: To disable the Welcome window (p. 31), deselect the Show at startup option in this window.
The **Parallels Virtual Machines** list allows you to manage the registered Parallels virtual machines as follows:

- **Open virtual machines**: Click the virtual machine name in the list to open the virtual machine window (p. 36).

- **Start virtual machines**: Click the **Start** button or right-click a virtual machine and choose **Start** from the shortcut menu.

- **Edit the virtual machine configuration (p. 170)**: Right-click a virtual machine and select **Configure** from the shortcut menu.

- **Locate the virtual machine files on your Mac**: Right-click a virtual machine and choose **Show in Finder** from the shortcut menu.

- **Rearrange the virtual machines**: Drag a virtual machine to the desired position.

- **Remove any virtual machine** (p. 142): Drag a virtual machine from the list or right-click it and select **Remove** from the context menu. You can add it back to the list later.

- **Assign colors to your virtual machines**: Right-click a virtual machine and select the desired color from the shortcut menu. In Finder, the virtual machine `.pvm` bundle will be marked with the same color.

If the virtual machine files are stored on a remote USB device or network server, you will see the corresponding icon to the right of the virtual machine name.

If you right-click a virtual machine template (p. 130), the set of commands will differ slightly.

The **Start** button is not available because you cannot start a template, but you can choose the **Convert to Virtual Machine** (p. 133) or **Deploy to Virtual Machine** (p. 133) options.

### Third-party Virtual Machines

When you start Parallels Desktop, it finds all third-party virtual machines (VMware, Microsoft Virtual PC, Virtual Box) stored on your Mac using the Spotlight search and adds them to the **Parallels Virtual Machine** list. Before using these machines, you need to covert them into the Parallels Desktop format. Open a third-party virtual machine and conversion will begin.

If you do not want to convert a third-party virtual machine into the Parallels Desktop format, simply remove it from the **Parallels Virtual Machines** list (p. 142). Parallels Desktop will not add it to the list any more.

### The Menu

This menu is situated in the lower left corner of the **Parallels Virtual Machines** list:
With the help of this menu, you can:

- **Create a new virtual machine:** Click the button to start New Virtual Machine Assistant. You can also click the button and select **New** from the menu.

- **Add an existing virtual machine to the list:** Click the button and select **Open** from the menu to add an existing virtual machine stored on your Mac, on an external USB storage, or on the network.

- **Import a physical computer or virtual machine:** Click the button and select **Import** from the menu to migrate a physical or virtual computer (VMware, Microsoft Virtual PC, or VirtualBox) to a Parallels virtual machine on your Mac with the help of Parallels Transporter.

- **Download a virtual appliance:** Click the button and select **Download from website** from the menu. The Parallels Virtual Appliances Directory (http://ptn.parallels.com/en/ptn/dir) page will open. Choose a virtual appliance and download it.

- **Download the Google Chrome virtual appliance:** Click the button and select **Download Chrome OS** from the menu. Parallels Desktop will download the Google Chrome operating system from the Internet and add a virtual machine with installed Chrome OS to the Parallels Virtual Machines list. To log in to Chrome OS your computer should be connected to the Internet and you should provide your Google account name and password.
Virtual Machine Window

When you choose a virtual machine from the Parallels Virtual Machines list (p. 33), the virtual machine window appears. If you start this virtual machine, the virtual machine window changes to the guest OS window that acts as the virtual machine's display. You can resize the virtual machine window by dragging its right corner. Its resolution changes automatically in Windows (starting from Windows 2000) and in most Linux operating systems if Parallels Tools are installed (p. 74).
The virtual machine window consists of three parts:

- **Status bar** - contains items for managing the virtual machine's devices and changing the view mode and state. For more information, see [Status Bar](p. 39).
- **Screen** - acts as the virtual machine's screen.
- **Toolbar** - comprises buttons that can be used to manage the virtual machine and its appearance.

When a guest operating system is running, you can switch between several display modes of the guest OS window. For detailed information on the view modes, see [Changing the View Mode](p. 93).

### Status Bar

The status bar is the primary tool for managing virtual machines. To start, shut down, suspend, pause, resume, and stop the virtual machine, use the virtual machine state menu. To change the virtual machine view mode, use the view mode menu. To open the **Virtual Machine Configuration** dialog, click the **Configure** button.

The status bar also displays the icons of the virtual machine devices. You can easily connect or disconnect the devices using these icons: right-click the device icon and choose the necessary option from the shortcut menu.

For more information on the status bar functions, refer to the [Status Bar](p. 39) section.

### Toolbar

You can also manage your virtual machine using the Parallels Desktop toolbar. The toolbar is hidden by default - to show it, click the button in the upper right corner of the virtual machine window.

If the toolbar does not contain the necessary buttons, you can easily add them to the toolbar - right-click the toolbar, choose **Customize Toolbar** (p. 41) from the shortcut menu, and drag the items you need to the toolbar.
The Parallels Desktop menus contain all of the controls available for Parallels Desktop and its virtual machines. The menus are displayed on the Mac OS X menu bar.

The menus are:

- The **Parallels Desktop** menu displays the **About Parallels Desktop** dialog, lets you activate and register the product, check for updates, set the Parallels Desktop Preferences (p. 42), as well as quit Parallels Desktop.

- The **File** menu allows you to create a new virtual machine or remove one of the already existing virtual machines (p. 142).
  - The **Open** command allows you to open virtual machines that are not registered in Parallels Desktop. If you open a Parallels virtual machine, it will be registered in Parallels Desktop and added to the **Parallels Virtual Machines** list (p. 33). You can also open third party (VMware, Microsoft Virtual PC, VirtualBox) virtual machines. If you open a third party virtual machine, it will be converted into the Parallels Desktop format and added to the **Parallels Virtual Machines** list (p. 33).

- The **Import** command allows you to migrate a physical computer to a Parallels virtual machine on your Mac with the help of Parallels Transporter.

- The **Download from Website** command allows you to download virtual appliances (p. 73) from the Internet.

- The **Download Chrome OS** command allows you to download the Google Chrome operating system from the Internet and add a virtual machine with installed Chrome OS to the **Parallels Virtual Machines** list (p. 33).

- The **Empty Windows Recycle Bin** command allows you to empty the Windows guest OS recycle bin. You can also clone the virtual machine or convert it to a template (p. 130).

- The **View** menu includes commands for switching between different view modes: the Full Screen, Coherence, Modality, or Window mode. You can also show and hide the Windows guest OS toolbar and desktop, display the Windows guest OS recycle bin and Start menu, enable the MacLook theme (p. 152), and make clips and screen shots of the virtual machine screen.

- The **Virtual Machine** menu allows you to manage the virtual machine, edit the virtual machine configuration, create and manage snapshots, install Parallels Tools and Parallels Internet Security in the virtual machine, and compress the virtual machine's hard disk.

- The **Devices** menu is available only when the virtual machine is running. It allows you to configure certain devices and sharing settings at runtime. Using the **Sharing** menu, you can share folders (p. 154) between Mac OS X and your guest operating system. Using the **Keyboard** menu, you can emulate keyboard shortcuts in the guest operating system.

- The **Window** menu allows you to open the **Parallels Virtual Machines** list (p. 33) and navigate between the running virtual machines.

- The **Help** menu lets you access Parallels Desktop Help, Welcome window, the troubleshooting guide, Parallels Support, and the problem report form.

You are also welcome to send us feedback about using Parallels Desktop. Choose **Send Feedback** from the Help menu and provide it in the displayed window. We will use your feedback to make the product better fit your needs.
Dock icon shortcut menu

Parallels Desktop Dock icon has a shortcut menu with a number of useful commands. Just right-click the Parallels Desktop icon to open this menu.

---

Status Bar

The status bar consists of three parts:

- The virtual machine state menu
- The view mode menu; and
- The virtual machine devices.

The Virtual Machine State Menu

You can start, shut down, pause, suspend, resume, and stop the virtual machine using the Virtual Machine State menu on the status bar. Click the Virtual Machine State button and select the desired command from the menu.

The View Mode Menu

To change the virtual machine view mode, use the View Mode menu on the status bar. This menu is available only when the virtual machine is running. To switch to the Coherence mode, click the Coherence button. To switch to any other view mode, click the down arrow button near the Coherence button and select the desired view mode from the menu. For detailed information on the view modes, see Changing the View Mode (p. 93).

The Virtual Machine Devices

In the virtual machine status bar, you can find the list of devices connected to the virtual machine. This list is available only when the virtual machine is running. By default, the virtual machine devices list is hidden. To see the list, click the left arrow button near the Configure button.
The icons for the following devices are displayed on the status bar:

- keyboard
- floppy disk drive
- CD/DVD drive
- hard disk
- network adapter
- sound card
- USB controller
- shared folders
- serial port
- printer port

If you see the icon in the status bar, it means that Parallels Tools are outdated and need to be reinstalled.

If a device can be connected or disconnected at runtime (actually, most of the devices can be), this can be done using the device's shortcut menu. Click the device icon to display its shortcut menu and select the command. The picture below shows the shortcut menu for the CD/DVD drive.

![Shortcut Menu Example](image)

You can also connect CD/DVD discs or images of discs to the virtual machine's CD/DVD drive or connect a floppy image to its floppy drive in the following way: drag the required image file over the CD/DVD drive icon on the Parallels Desktop status bar. For more information, please refer to the Changing Configuration at Runtime section (p. 102).

To add devices to the virtual machine configuration or remove them from the configuration, follow the instructions described in Adding and Removing Devices (p. 215).
Customizing Toolbar

To change the appearance of the toolbar items, right-click the toolbar and use the shortcut menu commands:

- **Icon & Text**. Use this command if you want the toolbar to display both the icon buttons and names.
- **Icon Only**. Use this command if you want the toolbar to display only the icon buttons.
- **Text Only**. Use this command if you want the toolbar to display only the name buttons.
- **Use Small Size**. Use this command if you want the toolbar buttons to appear in a smaller size.
- **Remove Item**. Point to a toolbar item and use this command if you want to remove this item from the toolbar.
- **Customize Toolbar**. This command opens the toolbar settings pane. See the description below.

To customize the set of toolbar buttons and its appearance, right-click the toolbar and choose **Customize Toolbar** from the shortcut menu. The toolbar settings pane will open. You can use this pane to:

- add new buttons to the toolbar by dragging them from the settings pane to the toolbar
- remove buttons from the toolbar by dragging them from the toolbar to the settings pane
- add separators to the toolbar by dragging them from the settings pane to the toolbar
- add spaces to the toolbar by dragging them from the settings pane to the toolbar
- change the current toolbar buttons set to the default one by dragging it to the toolbar
- select the toolbar buttons view mode in the **Show** list

To apply the changes you have made to the toolbar settings pane, click **Done**.

Hiding and Showing Parallels Desktop

When you are working with Parallels Desktop, you can hide and show it and all its windows by pressing the F6 shortcut.

If Parallels Desktop is visible but running in the background, pressing F6 will bring Parallels Desktop and all its windows to focus.

**Note 1:** To be able to use the F6 shortcut, make sure the **Enable Mac OS X system shortcuts** option is enabled in the **Keyboard** pane (p. 45) of Parallels Desktop Preferences.

**Note 2:** F6 is the default shortcut for hiding/showing Parallels Desktop. You can set another shortcut for these actions in the **Keyboard** pane (p. 45) of Parallels Desktop Preferences.
This section provides the information on how to configure the Parallels Desktop settings using the Preferences dialog. To open this dialog, choose Preferences from the Parallels Desktop menu.

In This Chapter

General Preferences ............................................................................................................ .. 42
Keyboard Preferences ........................................................................................................... 45
USB Preferences ................................................................................................................... 49
Mobile Preferences............................................................................................................. ... 51
Advanced Preferences........................................................................................................... 53

General Preferences

In the General pane of Parallels Desktop Preferences, you can:

- change the default location for storing the folders with the virtual machine files
- choose the appearance of the Parallels Desktop icon
- select whether you want to use animations for some actions in Parallels Desktop
- set preferences for the frequency of the update checks

Note: The settings available in this pane can be configured individually for each user of your Mac.
Changing the Default Folder for Virtual Machines

The **Virtual Machines Folder** field displays the default location where Parallels Desktop stores the files and folders of all virtual machines you create on your Mac. You can change the default location. To do this, click the **Virtual Machines Folder** field and either choose a new folder from the list of available folders or click **Choose a folder** and navigate to the necessary folder. After changing the default location, all newly created virtual machines will be saved in the folder specified in the **Virtual Machines Folder** field. However, this does not affect the files of virtual machines that already exist: their files will remain in the original default folder.

Dock Icon

This option defines what type of icon will appear in the Dock when Parallels Desktop is open. The following types of icons are available:

- **Parallels Desktop**. The standard Parallels Desktop icon appears in the Dock.
- **Live Screenshot**. If you choose this type, the Dock icon will appear as a live screenshot of the virtual machine window.

**Note 1**: No matter what type of the Dock icon you choose, if you click this icon when you virtual machine is working in the Coherence (p. 144) mode, the Windows **Start** menu will open.

**Note 2**: If the **Do not show Parallels icon in Dock** option is selected in the **Coherence** pane (p. 188) of the **Virtual Machine Configuration** dialog, the Parallels icon will not be shown in the Dock when the virtual machine is working in the Coherence (p. 144) view mode.

If you select the **Use Start button icon in Coherence** option, Parallels Desktop will display the Start button icon in the Dock when the virtual machine is working in the Coherence (p. 144) view mode. If you click this icon, the Windows **Start** menu will open.
Using Animations

If you select the **Use animations** option, the virtual machine window will become animated when the virtual machine is paused, suspended, or shut down.

Check for Updates

The **Check for updates** section defines the policy for updating the Parallels Desktop software. By default, Parallels Desktop is set to automatically check for available updates once a day, provided that Parallels Desktop is launched and your Mac is connected to the Internet. You can specify another interval for checking for updates by selecting the necessary value in the **Check for updates** list. The following options are available:

- **Once a day.** Select this option if you want Parallels Desktop to perform the update check every day.
- **Once a week.** Select this option if you want Parallels Desktop to perform the update check every week.
- **Once a month.** Select this option if you want Parallels Desktop to perform the update check every month.

Select the **Download updates automatically** option if you want all new available updates to be downloaded at once without showing you the **Download** dialog.

You can also check for available updates manually at any time you want by clicking the **Check Now** button:

- If any updates are available for your version of Parallels Desktop, you will see them in the **Download** dialog. Choose the updates you want to install and click the **Download** button.
- If your version of Parallels Desktop is up to date, you will see the corresponding message.

Locking Parallels Desktop Preferences

If you want to prevent Parallels Desktop Preferences from further unauthorized changes, click the Lock icon at the bottom of the window. The next time anybody wants to change the settings in any pane of Parallels Desktop Preferences, an administrator's password will be required.
Keyboard Preferences

In the Keyboard pane of Parallels Desktop Preferences, you can set keyboard shortcuts for certain commands.

**Note:** The keyboard shortcuts can be configured individually for each user of your Mac.
Configuring Keyboard Shortcuts

To configure the shortcuts used to perform certain actions, use the **Double-click a shortcut to edit** list. Using this list, you can remap the Mac OS X shortcuts to Windows shortcuts that perform similar actions in Parallels Desktop virtual machines.

The shortcuts are divided into two groups: shortcuts for managing the Parallels Desktop software and shortcuts for working in virtual machines. Shortcuts for Parallels Desktop cannot be added or removed, while the shortcuts for virtual machines can be added using the **Add** button and removed using the **Remove** button.

To add a shortcut, click the **Add** button and specify the rule for translating the key combination.

- In the **From** field, use the buttons to add modifier keys to the Mac keyboard shortcut and enter the required key into the empty field.
- In the **To** field, specify the PC keyboard shortcut you would like to translate the Mac shortcut to. You can use the buttons for modifier keys and type the key into the empty field or select the necessary PC keyboard key using the arrow button.
To configure a shortcut remapping rule, double-click it and edit by entering the new key combination.

**Important:** There are Mac shortcuts that do not have similar shortcuts in Windows, for example, you can use the F11 key or Fn+F11 combination to see your Mac OS desktop with Expose, but in Windows there are no keys or key combinations that enable you to perform the same action, because there is no Expose in Windows.

The **Enable Mac OS X system shortcuts** checkbox, which is selected by default, allows you to use the default (F9/F10/F11/F12) and custom shortcuts for Mac OS X during your work with virtual machines in Parallels Desktop.

**Using profiles**

By default, Parallels Desktop contains four profiles that represent sets of key combinations typical for the following OSs:

- Windows
- Linux
- Mac OS X
- Generic (for other guest OSs)

When you create or register a virtual machine, one of these profiles, depending on the guest operating system, will be assigned to the machine by default.

You can create your own profile and assign it to your virtual machines. To create your custom keyboard profile or edit the existing profiles, click the **Edit profiles** button. The dialog for editing profiles will appear.
To add a new profile, click the **Add** button. In the **Choose base profile** window, specify the new profile name and select the base profile from the list. After the profile is created, you can submit the changes by clicking **OK**, then return to the **Keyboard** pane of Parallels Desktop Preferences, select this new profile in the **Profile** list, and configure its shortcuts.

To remove one of the existing custom profiles, select this profile and click the **Remove** button.

To duplicate or rename one of the existing profiles, select this profile, click the button, and select the corresponding action from the menu.

---

**Note:** You can rename or remove your custom profiles only.

In this window, you can also assign profiles to your virtual machines.

To change a profile assigned to a virtual machine:

1. In the **Assign profiles to your virtual machines** table, select the virtual machine.
2. In the **Profile** column, click the corresponding profile field to open the list of available profiles and choose the profile you want to assign to this virtual machine.
3. Click **OK** to submit the changes.

---

**Restoring Default Settings**

The **Restore Defaults** button enables you to restore the default settings for all options available in this pane.

---

**Locking Parallels Desktop Preferences**

If you want to prevent Parallels Desktop Preferences from further unauthorized changes, click the Lock icon at the bottom of the window. The next time anybody wants to change the settings in any pane of Parallels Desktop Preferences, an administrator's password will be required.
USB Preferences

In the **USB** pane of Parallels Desktop Preferences, you can specify how to handle USB devices that are plugged into your Mac.
General Behavior

You can choose a general action to perform when a new USB device is plugged into your Mac by choosing one of these options:

- **Connect it to my Mac.** If you select this option, the USB device plugged into your Mac will be connected to your Mac.
- **Connect it to the active virtual machine.** If you select this option, the USB device plugged into your Mac will be automatically connected to the virtual machine that is currently running on your Mac. When no virtual machine is running, the USB device will be connected to the primary OS.
- **Ask me what to do.** If you select this option, you will be prompted to choose how to connect the USB device each time a new USB device is plugged into your Mac.

Permanent Assignments

You can also set permanent assignments for certain USB devices. These assignments are displayed in the Permanent assignments list.

To add a new assignment:

1. Click the Add button below the Permanent assignments list.
2. Click the device field in the USB Device column to choose a USB device from the list.
3. In the Connect To column, double-click the destination field to open the list of available destinations and choose the virtual machine you want to connect this device to. If you want to connect this USB device to your Mac, choose Computer.

**Note 1:** To be able to use the USB device in a virtual machine, you may need to install the necessary drivers in its guest OS. By default, such drivers can be obtained from the manufacturers of this device.

**Note 2:** You can connect up to eight USB 2.0 devices and up to five USB 1.1 devices to each virtual machine.

You can change an assignment by editing the device and destination in the USB Device and Connect To fields.

To remove an existing assignment, select it in the Permanent assignments list and click the Remove button.

For more information about using USB devices in a virtual machine, refer to Connecting USB Devices to a Virtual Machine (p. 114).

Locking Parallels Desktop Preferences

If you want to prevent Parallels Desktop Preferences from further unauthorized changes, click the Lock icon at the bottom of the window. The next time anybody wants to change the settings in any pane of Parallels Desktop Preferences, an administrator's password will be required.
Mobile Preferences

In the Mobile pane of Parallels Desktop Preferences, you can set up external connections to Parallels Desktop and its virtual machines from Parallels Mobile application installed on your iPad, iPhone, or iPod touch.

Parallels Mobile lets you:

- access any virtual machine running in Parallels Desktop 6 for Mac
- use any Windows application in your virtual machine, from Internet Explorer to Outlook
- remotely start, stop and reset virtual machines
- stay connected via WiFi or 3G networks
- access your Windows applications from anywhere over the Internet
- optimize for either speed or graphics performance.

You can download Parallels Mobile for free from the App Store.
There are two ways to connect Parallels Mobile to your Mac and virtual machines:
- through the Internet, using Parallels Mobile server, or
- directly, when your Mac and your iPad, iPhone, or iPod touch are within the same network

It is recommended to use the first mode, as it enables you to access your Mac from almost anywhere through the Internet or 3G networks.

**Connecting through the Internet**

To connect to your virtual machines from iPad, iPhone, or iPod touch through the Internet, do the following:

1. Make sure you have a Parallels account. You create this account when registering Parallels Desktop (p. 24).
2. On your Mac, open Parallels Desktop > Preferences > Mobile and log in to your Parallels account using the email and password you used to register your copy of Parallels Desktop.
3. Install Parallels Mobile on your iPad, iPhone, or iPod touch.
4. On your iPad, iPhone, or iPod touch, open Parallels Mobile and also log in to your Parallels account. You will see your Mac registered and will be able to connect to your virtual machines.

**Direct connection**

To connect to your virtual machines directly (if your Apple mobile device and your Mac are within the same network), do the following:

1. Install Parallels Mobile on your iPad, iPhone, or iPod touch.
2. Open the general Preferences of your iPad, iPhone, or iPod touch, and enable direct connections for Parallels Mobile.
3. On your Mac, open Parallels Desktop > Preferences > Mobile and select Connect Parallels Mobile directly to my Mac.
4. Use the user name and IP address, specified under this option, to connect to your virtual machines from Parallels Mobile.

For more information about Parallels Mobile and using iPhone to manage your virtual machines, see Managing Virtual Machines from Parallels Mobile (p. 141).

**Locking Parallels Desktop Preferences**

If you want to prevent Parallels Desktop Preferences from further unauthorized changes, click the Lock icon at the bottom of the window. The next time anybody wants to change the settings in any pane of Parallels Desktop Preferences, an administrator's password will be required.
Advanced Preferences

In the **Advanced** pane of Parallels Desktop Preferences, you can configure some additional settings.
Configuring Network Preferences

In the Advanced pane of Parallels Desktop Preferences, you can configure a number of network-related settings for Parallels Desktop and your virtual machines. Click Change settings and the window with network settings will appear. You can configure the range of IP addresses to be assigned to your virtual machines when they are operating in the host-only (p. 112) and shared (p. 109) networking modes.

For details on configuring the host-only networking settings, refer to Host-Only Networking (p. 59).

For details on configuring the shared networking settings, refer to Shared Networking (p. 56).

Requiring Password

In the Require password to section of the Advanced pane, you can set restrictions on the following operations for non-administrator users:

- Create a new virtual machine. You will have to provide your administrator password to create a new virtual machine.
- Add an existing virtual machine. You will have to provide your administrator password to add an existing virtual machine to the Parallels Virtual Machines list (p. 70).
- Remove a virtual machine. You will have to provide your administrator password to remove your virtual machines from the Parallels Virtual Machines list (p. 142).
- Clone or convert a virtual machine or template. You will have to provide your administrator password to clone a virtual machine (p. 129), to create a template, to convert a template into a virtual machine, and to deploy a template into a new virtual machine (p. 130).

Speech

Parallels Desktop allows you to operate your virtual machine by using the speech commands. If you want to do that, select Enable spoken commands and make sure that:

- the virtual machine window is active, and
- the speech settings are properly tuned on the corresponding tab of Mac OS X System Preferences

If the speech settings are not tuned, you will see the 'To enable this option, you should turn on speakable items in System Preferences' warning message. To tune the speech settings, click Open System Preferences.

To view the list of all spoken commands available to manage your virtual machines, please refer to Managing Virtual Machines Using Spoken Commands (p. 140).

Feedback

To participate in the Customer Experience Program, select the corresponding option. If you join this program, Parallels will collect information about your Mac and virtual machines configuration. The collected information will help us to make the product better fit your needs.

If you join, only the following types of data will be collected:

- hardware configuration of your Mac
- software configuration of your Mac and virtual machines (the names and versions of the operating systems and software installed in them)
- configuration files of virtual machines

Any types of private information like your name, e-mail, address, phone number, and keyboard input will not be collected.

For more details, visit the Customer Experience Program page at the Parallels website (follow the link in the pane).

Troubleshooting

While functioning, Parallels Desktop automatically creates a log file that can be used by the Parallels support team for solving problems and improving the product. If you select the Use detailed log messages option, Parallels Desktop will start creating a more detailed log file. It can be helpful for the Parallels support team, but uses more hard disk space and may slightly lower the system performance.

Resetting Hidden Messages

Some Parallels Desktop dialogs and assistant windows are provided with the Do not show this message again option. If you select this option, the corresponding dialog will not appear next time you perform the same operation. Using the Reset button, you can reset all dialogs and assistant windows with this option selected so that they would be displayed again each time you initiate the corresponding operation.

Locking Parallels Desktop Preferences

If you want to prevent Parallels Desktop Preferences from further unauthorized changes, click the Lock icon at the bottom of the window. The next time anybody wants to change the settings in any pane of Parallels Desktop Preferences, an administrator's password will be required.
Shared Networking Settings

To make changes the shared networking settings, click **Network: Change settings** in the **Advanced** pane of Parallels Desktop Preferences and select the **Shared** tab. You will see the following window:
In this window, you can make the necessary changes to the settings of the Parallels DHCP servers for IPv4 and IPv6. These servers, enabled by default, automatically assign IP addresses to your virtual machines operating in the shared networking mode.

For more information about configuring shared networking, refer to Shared Networking (p. 109).

**Port Forwarding**

Normally, virtual machines set to operate in the shared networking mode cannot be accessed from external computers. The port forwarding functionality allows computers on your local network and on the Internet to transfer data to any of your virtual machines that use the shared networking mode. The data sent to a specific port on your Mac will be redirected to a specific port of your virtual machine according to the port-forwarding rule.

To add a port forwarding rule:

1. Click the Add button below the Port forwarding rules list.
2. In the displayed window, do the following:
   - In the Port Type field, specify the port type you want to use for establishing network connections. You can choose between the TCP or UDP port types.
   - In the Incoming Port field, type the number of the incoming port on your Mac.
   - In the IP Address field, indicate the IP address of the virtual machine you want to connect.
   - In the Destination Port field, type the port on the virtual machine to which the data will be transferred.
3 Click **OK** to add the rule.

When the rule is added, use the following IP address combination for external connections to your virtual machine: `<you Mac’s IP address>:<Incoming port>`.

To edit a rule, select it in the **Port forwarding rules** list, click the **Edit** button, modify the necessary settings, and click **OK** to apply them.

To remove a port forwarding rule, select it in the **Port forwarding rules** list and click the **Remove** button.

Click **OK** to save the changes, otherwise, click **Cancel**. To restore the default settings, click **Restore Defaults**.
Host-Only Networking Settings

To make changes to the host-only networking settings, click **Network: Change settings** in the **Advanced** pane of Parallels Desktop Preferences. The following window will appear:

![Host-Only Networking Settings Window]

In this window, you can make the necessary changes to the settings of the Parallels DHCP servers for IPv4 and IPv6. These servers, enabled by default, automatically assign IP addresses to the virtual machines operating in the host-only networking mode.

Click **OK** to save the changes, otherwise, click **Cancel**. To restore the default settings, click **Restore Defaults**.

For more information on configuring the host-only networking settings, refer to **Host-Only Networking** (p. 112).
CHAPTER 6

Setting Up a Virtual Machine

Generally, the process of creating a virtual machine includes two steps:

1. **Creating a virtual machine configuration and installing an operating system in it.** This step is performed with the help of New Virtual Machine Assistant that creates the virtual machine hardware configuration and installs an operating system on it. The operating system can be installed automatically from a CD/DVD disc or an image of such a disc.

2. **Installing Parallels Tools in the virtual machine.** When you installed the operating system, it is recommended to install Parallels Tools that will help you work simultaneously in Mac OS and your virtual machine. Parallels Tools are available for most of the popular Windows and Linux operating systems, as well as Mac OS X Server, and can be easily installed on your virtual machine.

Once your have completed these steps, your virtual machine is ready for work.

In This Chapter

- Supported Guest Operating Systems................................................................. 61
- Creating a New Virtual Machine ................................................................. 63
- Opening an Existing Virtual Machine............................................................... 70
- Using Boot Camp Partition in Virtual Machine.................................................. 71
- Moving Data from PC to a Virtual Machine......................................................... 72
- Downloading Virtual Appliances................................................................. 73
- Installing Parallels Tools............................................................................. 74
## Supported Guest Operating Systems

Any of the following guest operating systems can be installed in Parallels Desktop virtual machines.

<table>
<thead>
<tr>
<th></th>
<th>32-bit</th>
<th>64-bit</th>
<th>Express Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 7</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2008 SP0, SP1, SP2, R2</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows Vista® Home, Business, Ultimate, Enterprise SP0, SP1, SP2</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows Server® 2003 SP0, SP1, SP2, R2</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows XP Home SP0, SP1, SP2, SP3</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows XP Professional SP0, SP1, SP2, SP3</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows XP Professional SP2</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows 2000 Professional SP4</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows 2000 Server SP4</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows NT 4.0 Server SP6, Workstation SP6</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows ME</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows 98 SE</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows 95</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Windows 3.11</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>MS-DOS 6.22</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td><strong>Linux</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ubuntu® Linux 8.10, 9.04, 9.10, 10.04</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Red Hat® Enterprise Linux 5.x</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4.x</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>CentOS Linux 5.x</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>CentOS Linux 4.x</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Fedora™ Linux 12, 13</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>SUSE® Linux Enterprise Server 11, 10 SP2, Desktop 11</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>OpenSUSE Linux 11.x</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Mandriva™ Linux 2009, 2010</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Operating System</td>
<td>Compatibility</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Debian® Linux 5.0</td>
<td>✅ ✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X Snow Leopard Server 10.6.x</td>
<td>✅ ✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X Leopard Server 10.5.x</td>
<td>✅ ✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chrome</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chrome OS</td>
<td>✅ ✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Solaris</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Solaris 2009.06</td>
<td>✅ ✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Solaris® 10</td>
<td>✅ ✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BSD</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FreeBSD® 7.x, 8.x</td>
<td>✅ ✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS/2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS/2® Warp 4.5, 4</td>
<td>✅ ✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>eComStation™ 1.2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Please note that Parallels Desktop does not include operating system installation discs or their images. You should purchase them separately.
Creating a New Virtual Machine

If you have no virtual machines, you can start your work in Parallels Desktop by creating a new virtual machine using New Virtual Machine Assistant.

To create a new virtual machine:

1. Open Parallels Desktop and click New Windows Installation in the Welcome window (p. 31) or the Add button in the Parallels Virtual Machines list (p. 33), or choose New from the File menu.

2. Insert the operating system installation disc or connect the installation source to your Mac. In the Create New Virtual Machine window specify the source of the installation files and click Continue.

You can create a virtual machine using

- an operating system installation CD or DVD disc
- an image of such an installation disc
- or a Boot Camp partition

If you want to specify the installation source later choose Continue without disc.
3 Your operating system will either be detected automatically, or you will be asked to select it manually from the list.

4 If you are going to create a Windows or Linux virtual machine, you may be offered to use **Express Installation**, which is available for most of the popular Windows and Linux operating systems.

In the Express Mode, the operating system and Parallels Tools are installed automatically, with no interaction needed.

To use Express Installation, you will need to provide:

- **for Windows**: the Windows product key, a user name and password.
- **for Linux**: a user name and password.

5 If you are installing one of the recent Windows systems (starting from Windows 2000), you will need to choose the level of integration between your Windows and Mac OS applications and files. You can choose one of the following ways of working with your Windows applications:

- **Like a Mac**: You will be able to work in both Windows and Mac applications on the single Mac OS Desktop, and your Mac desktop, as well as the documents, pictures, music, videos and downloads folders will be shared with Windows.

- **Like a PC**: your Windows will run in a separate window and your Mac files will not be shared with Windows, but you will be able to drag and drop files between the systems, as well as copy text.
6 Before your start, review your virtual machine name and location.

If you want other users of your Mac to access your virtual machine, choose Share with other users of this Mac - and your virtual machine will be saved in the /Users/Shared folder that is accessible to all users.

If you want to edit your virtual machine hardware configuration before proceeding to operating system installation, select Customize settings before installation.

7 When finished, click Create.

8 The assistant will create a virtual machine based on your settings and install the operating system and Parallels Tools in it or if you chose to customize the settings before installation, the assistant will open the virtual machine configuration dialog.

Note: Parallels Tools are installed automatically in most of the popular Windows and Linux operating systems. In other operating systems they should be installed manually (p. 74).

The newly created virtual machine will be accessible through the Parallels Virtual Machines list (p. 33) that allows you to easily manage your virtual machines.

When creating a Windows virtual machine, Parallels Desktop creates an administrator account with a blank password. When the guest OS installation is complete, it is recommended that you change this password.
Default Configurations

A typical virtual machine has the following basic virtual hardware: CPU, memory, hard disk drive, floppy disk drive, sound device (except FreeBSD and MS-DOS virtual machines), CD/DVD drive, network adapter, USB controller, serial port, parallel port connected to the printer set as the default in Mac OS.

**Note:** Apart from the basic hardware, you can add new devices to your virtual machine using the Virtual Machine Configuration dialog (p. 170).

The amount of memory and the size of hard disks vary for different guest OSs. Refer to the table below to learn the memory and hard disk values that are allocated to a virtual machine depending on the guest operating system that will be installed in it. Virtual hard disks for typical virtual machines are always created in the expanding format (p. 217).

<table>
<thead>
<tr>
<th>Guest Operating systems</th>
<th>Memory, MB</th>
<th>Video Memory, MB</th>
<th>Hard Disk, MB</th>
<th>Floppy Drive</th>
<th>CD/DVD Drive</th>
<th>Network Adapter</th>
<th>Sound Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X</td>
<td>1024</td>
<td>16</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 7</td>
<td>512</td>
<td>16</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Server 2008</td>
<td>512</td>
<td>16</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Vista</td>
<td>512</td>
<td>16</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows XP</td>
<td>512</td>
<td>16</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 2003</td>
<td>512</td>
<td>16</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 2000</td>
<td>256</td>
<td>16</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Windows</td>
<td>256</td>
<td>16</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Linux</td>
<td>512</td>
<td>3</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUSE Linux</td>
<td>512</td>
<td>3</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Debian GNU/Linux</td>
<td>512</td>
<td>3</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ubuntu Linux</td>
<td>512</td>
<td>3</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Linux</td>
<td>512</td>
<td>3</td>
<td>64,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FreeBSD 6.x</td>
<td>256</td>
<td>16</td>
<td>32,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FreeBSD 7.x</td>
<td>256</td>
<td>16</td>
<td>32,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other FreeBSD</td>
<td>256</td>
<td>16</td>
<td>32,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Guest OSs</td>
<td>256</td>
<td>16</td>
<td>8,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Installing a Guest Operating System

You can install a guest operating system in a virtual machine from a CD or DVD disc, or from an image file of such a disc. Some operating systems are available on CD/DVD disc images only.

In some cases, the installation cannot be performed from a real CD/DVD disc because of reading problems. In such cases, it is recommended that you try to install the operating system from a CD/DVD disc image of this disc. ISO images of CD/DVD discs can be created using a third party imaging utility.

**Note:** MacBook Air users can install guest operating systems from CD/DVD disc images only.

Additionally, you can also install a guest operating system using a PXE server via network.

If you need to install an operating system from floppy disks, you can use images of installation diskettes or real diskettes inserted into an external USB floppy disk drive. Floppy disk images can be created using third-party applications.

**Installing from a CD/DVD disc or its image**

1. Open Parallels Desktop and select the virtual machine in the Parallels Virtual Machines list.
2. To connect the installation medium, open Virtual Machine Configuration by:
   - right-clicking the machine and choosing Configure from the shortcut menu, or
   - choosing Configure from the Virtual Machine menu.
3. Open the CD/DVD-ROM settings and configure the virtual CD/DVD-ROM drive settings.
   - If you are installing from a real CD/DVD:
     - Select the Real Device option and specify the real drive to connect in the CD/DVD-ROM list.
     - Insert the CD/DVD disc with the operating system files into the appropriate drive of the computer.
   - If you are installing from an image file:
     - Select the Image file option and specify the path to the image file in the File field.

**Note:** You can use ISO and DMG images for installing the guest operating system. CUE and CCD images may be also supported.

4. Click OK in Virtual Machine Configuration to save the changes.
5. Start your virtual machine by clicking Start.

The installation will launch soon after the virtual machine is started.
Note: When installing a Windows guest OS, you may need to press F8 or other function keys in a virtual machine. If you use MacBook or MacBook Pro keyboard, click inside the virtual machine window to capture the keyboard and mouse input and press Fn+F8 combination instead. You can configure Parallels Desktop to use any other key for performing the same action as F8 does. To release the keyboard and mouse input back to Mac OS X, press Ctrl+Alt. For more information, refer to Keyboard Preferences (p. 45) and Capturing Keyboard and Mouse (p. 98).

Installing from the network

1. Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration.

2. Click the Add button in the bottom part of the Virtual Machine Configuration dialog to launch Add Hardware Assistant.

   Note: The Add button is disabled when the virtual machine is running. You need to shut down the virtual machine before you can use this button.

3. Add a network adapter to your virtual machine configuration.

4. Open the Boot Order pane in Virtual Machine Configuration and change the boot sequence to make the virtual network adapter the first device in the sequence. To this effect, select Network Adapter in the list and use the arrow buttons to move it to the top of the list.

5. Click OK to apply the changes.

6. Start the virtual machine by clicking Start.

Soon after your virtual machine is started, a list of available PXE servers appears.

During the installation, when the guest OS reboots for the first time or after the installation, return the boot sequence to booting from the hard disk.

Installing from a floppy disk image

1. Select the virtual machine and make sure that it is stopped.

2. To connect the installation medium, open Virtual Machine Configuration by:
   - right-clicking the machine and choosing Configure from the shortcut menu, or
   - choosing Configure from the Virtual Machine menu.

3. Open the Floppy Disk pane and specify the path to the floppy image disk file in the Image File field.

4. Click OK to apply the changes.

5. Start the virtual machine by clicking Start.

The installation will launch soon after the virtual machine is started.

Reinstalling the guest OS

The procedure for reinstalling the guest OS is the same as the procedure of installing the guest OS: provide the installation media or its image, connect it to the virtual machine, and start the virtual machine. The reinstallation will launch soon after the virtual machine is started.
Note: You can reinstall the guest OS of the same type only. However, you are free to choose the guest OS version.

Keep in mind that in some cases, it is easier just to create a new virtual machine, install the guest OS, and delete the old machine after moving all the necessary data to the new one.

Like a Mac or like a PC?

When you create a new Windows virtual machine (starting from Windows 2000), you are offered to choose the level of integration between the Windows guest operating system and Mac OS X.

You can choose one of the following integration levels:

- **Like a Mac**: If you choose this integration level, Shared Profile (p. 181) will be enabled and your Mac OS X desktop, documents, pictures, music, videos, and downloads folders shared with the Windows guest operating system.
  
  Besides, the virtual machine will be configured to work in the Coherence view mode (p. 144). In this mode, the virtual machine window will be hidden and you will see only the windows of the guest OS applications that are running.

- **Like a PC**: If you choose this integration level, the virtual machine will be configured to work in the Window view mode (p. 93). In this mode, it will be displayed in a separate window.
  
  Your Mac OS X files will not be shared with Windows, however, you will be able to drag and drop files between the host and guest operating systems, as well as copy text.

Note: You can change the integration level between Windows and Mac OS X after the virtual machine creation in the Virtual Machine Configuration dialog (p. 170).
Opening an Existing Virtual Machine

If you already have a virtual machine, but it doesn't appear on the Parallels Virtual Machines list (p. 33), you can easily add it by opening its file in Parallels Desktop.

Parallels Desktop supports virtual machines created in Parallels Desktop, VMware Fusion, Microsoft Virtual PC, and VirtualBox.

To add an existing virtual machine, drag its file onto the virtual machines list, or:

1. Choose Open from the File menu or click the arrow button in the virtual machines list and choose Open.

2. Locate the virtual machine file, select it, and click Open.
   - Parallels Desktop virtual machine file has the .pvm extension.
   - Parallels Desktop 3 and earlier virtual machine file has the .pvs extension.
   - VMware virtual machine file has the .vmx extension.
   - Virtual PC virtual machine file has the .vmc extension.
   - VirtualBox virtual machine file has the .xml extension.

**Note:** Virtual machines created in early versions of Parallels Desktop and VMware Fusion may appear as folders, with the configuration file stored inside the virtual machine folder.

If you opened a virtual machine created in Parallels Desktop 4, 5 or 6, you will be offered to update Parallels Tools in it.

Otherwise, your virtual machine will be converted to the current Parallels Desktop format first, and then you will be offered to install Parallels Tools. Please note that conversion may take some time.
Using Boot Camp Partition in Virtual Machine

If you have a Boot Camp partition, you can create a virtual machine that will use Boot Camp partition as its hard disk or import Windows from this Boot Camp partition to a new virtual machine or use this partition as a data disk in virtual machines.

Creating a Boot Camp Virtual Machine

To create a new virtual machine for using the Boot Camp Windows partition, do the following:

Boot into Mac OS X.


2. In the Create New Virtual Machine window, choose Boot Camp partition from the Install from menu, click Continue and follow the instructions.

   Note: If your Boot Camp is divided into several partitions, only the bootable partition will be added to the virtual machine configuration. If you want to add the other partitions, you should add them as separate virtual hard disks (p. 215) in the Virtual Machine Configuration.

3. Your Boot Camp virtual machine will be accessible through the Parallels Virtual Machine list (p. 33) that allows you to easily manage your virtual machines. When you boot into Boot Camp Windows through Parallels Desktop for the first time, Parallels Desktop will install Parallels Tools (p. 74, p. 16).

After that, you will be able to boot into your Boot Camp partition from Parallels virtual machine or use it as usual by booting into the Windows partition.

   Note: This version of Parallels Desktop allows you to suspend your Boot Camp virtual machines. If a Boot Camp virtual machine is suspended, it is highly recommended that you do not use the Boot Camp partition. Otherwise when you resume the virtual machine, it will store all the changes you made to the Boot Camp partition when the virtual machine was suspended.

Limitations

There is a number of limitations for a Parallels virtual machine that uses the Boot Camp Windows partition either as a bootable volume or as a data disk:

- it cannot be paused
- it cannot have snapshots and run in Safe Mode (p. 128)
- it cannot be compressed

   Note: There are no limitations on types of users who can access the Boot Camp Windows partition from a virtual machine. You can log into Windows even if you don't have administrator rights.
Importing Data from Boot Camp to a New Virtual Machine

Parallels Desktop allows you to import the Boot Camp data to Parallels virtual machines. In such virtual machines, the Boot Camp data becomes available on .hdd images. As a result, such a virtual machine is in no way connected to the Boot Camp partition and it can be paused, compressed, and have snapshots.

To create such a virtual machine, follow these steps:

1. Select a Boot Camp-based virtual machine and choose **Import Boot Camp** from the **File** menu. Or you can right-click this virtual machine in the **Parallels Virtual Machines** list (p. 33) and choose **Import Boot Camp** from the context menu.

   **Note:** This virtual machine must be shut down.

2. Click **Import**.

3. In the next step, locate where you want to store your new virtual machine and click **Choose**.

4. Wait while the Boot Camp data is being imported to the virtual machine. After that, you will be able to use the newly created virtual machine in Parallels Desktop.

   **Note:** You will be able to work with the original Boot Camp virtual machine as well.

Using Boot Camp as Data Disk

To use the Boot Camp Windows partition as a data disk, add it as a hard disk to an existing Windows XP, Windows Vista, or Windows 7 virtual machine. The Windows operating system will automatically recognize it as a new disk. For detailed information on adding hard disks to Virtual Machine Configuration, see **Adding and Removing Devices** (p. 215).

Moving Data from PC to a Virtual Machine

With the help of Parallels Transporter that is included in the Parallels Desktop software, you can transfer the whole of your PC to a Parallels virtual machine on your Mac using a network connection, an external storage device, or a Parallels USB cable.

To transfer your PC to a virtual machine:

1. Install Parallels Transporter Agent on your source PC. The installation files for Parallels Transporter Agent can be found on the Parallels Desktop disc or at the Parallels website.

2. Open Parallels Transporter Agent on the source PC.

3. Go to your Mac and open Parallels Transporter by choosing **Import** from the **File** menu or from the menu that appears when you click the arrow button in the virtual machines list.

4. Follow the assistant that will help you choose the most convenient migration scenario and will guide you through the migration process.

For detailed instructions, please refer to Parallels Transporter Help.
Setting Up a Virtual Machine

Downloading Virtual Appliances

If you don't have enough time to create a new virtual machine with the required configuration, you can download a ready-to-use virtual machine with a predefined configuration. Besides the basic configuration, prebuilt virtual machines may have a set of applications installed, so that you can do without spending time on installing and setting up the required software.

Downloading Parallels Virtual Appliances

Parallels Virtual Appliances are prebuilt Linux virtual machines with preinstalled services and applications that were created either by Parallels or by Parallels partners and are available for free on the Parallels Technology Network website.

To download such an appliance from Parallels Desktop:

1. Choose Download from website from the File menu.
2. Find the necessary appliance on the Parallels Technology Network page and click its title to view the configuration details and the administrative credentials.
3. To download the selected appliance, click GET APP and choose DMG as the download format.
4. When the download is complete, double-click the downloaded .dmg file to start the installation.

Downloading Google Chrome Virtual Appliance

To download the Google Chrome virtual appliance, select Download Chrome OS from the File menu. Parallels Desktop will download the Google Chrome operating system from the Internet and add a Google Chrome virtual machine to the Parallels Virtual Machines list. To log in to Chrome OS, you will need an Internet connection, as well as your Google account name and password.
Installing Parallels Tools

Parallels Desktop includes a set of specially developed utilities that help you use your virtual machines in the most convenient and efficient way.

Parallels Tools are located on disc images that are installed together with Parallels Desktop. There is a separate Parallels Tools disc image for each type of the supported guest operating systems.

- prl-tools-win.iso - disc image with Parallels Tools for Windows guest operating systems.
- prl-tools-lin.iso - disc image with Parallels Tools for Linux guest operating systems.
- prl-tools-mac.iso - disc image with Parallels Tools for Mac OS X Server Leopard.

These disc images can be found in the following location on your Mac: /Library/Parallels/Tools/.
Parallels Tools Overview

Parallels Tools are a suite of special utilities that help you use your virtual machines in the most comfortable and efficient way. With Parallels Tools, you can move the mouse seamlessly between the virtual machine and your Mac, change the virtual machine's screen resolution by simply resizing its window, synchronize your virtual machine's time and date settings with the time settings of the host computer, share your Mac's disks and folders with its virtual machines, copy text and drag and drop objects from Mac OS to a virtual machine and vice versa.

Parallels Tools are available for the most popular Windows, Linux, and Mac OS X operating systems, and include the utilities listed below. All utilities supported by your guest OS are installed in your virtual machine as a single package when you install Parallels Tools.

<table>
<thead>
<tr>
<th>Utility</th>
<th>Available for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse Synchronization Tool</td>
<td>Windows, Linux, Mac OS X, OS/2</td>
<td>Mouse Synchronization Tool captures the mouse input in the virtual machine each time the pointer moves over its window and automatically releases the input when the pointer moves outside the window.</td>
</tr>
</tbody>
</table>
| Time Synchronization Tool    | Windows, Linux, Mac OS X | Time Synchronization Tool enables you to customize your virtual machine time settings. You can:  
  - Automatically synchronize the time settings of your virtual machine with your Mac time settings.  
  - Set up and maintain the time difference between your Mac and your virtual machine. |
| Drag-and-Drop Tool           | Windows       | Drag-and-Drop Tool allows dragging and dropping files between your virtual machines and Mac OS. |
| Clipboard Synchronization Tool | Windows, Linux, OS/2 | Clipboard Synchronization Tool enables you to easily exchange texts between:  
  - the virtual machine and your Mac.  
  - different virtual machines irrespective of the guest operating systems installed in them.  
To copy and paste text, you should use the standard procedure for the current operating system. For example, to copy some text in the Windows guest OS, select the text, and press Ctrl+C. To paste this text in Mac OS X, press Cmd+V, or select Paste from the shortcut menu. |
<p>| Dynamic Resolution Tool      | Windows, Linux, Mac OS X | Dynamic Resolution Tool enables you to work with dynamic resolution. When you resize the guest OS window by dragging its lower right corner, the guest OS window resolution changes automatically. |
| Shared Folders Tool          | Windows, Linux, Mac OS X | Shared Folders Tool enables you to share Mac folders with the virtual machine. With this tool, you can access your Mac folders from the virtual machine. |</p>
<table>
<thead>
<tr>
<th>Tool</th>
<th>Support OS</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coherence Tool</td>
<td>Windows</td>
<td>The Coherence tool allows you to work with your Windows applications like if they were Mac applications. It hides your Windows virtual machine's window leaving only Windows and Mac applications visible.</td>
</tr>
<tr>
<td>Shared Profile Tool</td>
<td>Windows</td>
<td>Shared Profile Tool enables you to share your Mac desktop, pictures, documents, downloads, music and videos with your virtual machine, which allows you to access them right from Windows.</td>
</tr>
<tr>
<td>Shared Applications Tool</td>
<td>Windows</td>
<td>Shared Applications Tool enables you to specify default applications for certain types of files, so that you can open some types of files in Windows applications by default, and others - in Mac OS.</td>
</tr>
<tr>
<td>Shared Internet Applications Tool</td>
<td>Windows</td>
<td>Shared Internet Applications Tool enables you to specify default Internet browsers, including those installed in the virtual machine, for different types of Internet pages. For example, you may set the Internet pages to open in your default Mac OS X Internet browser, and FTP pages to open in your virtual machine Internet browser.</td>
</tr>
<tr>
<td>SmartMount</td>
<td>Windows, Linux, Mac OS X</td>
<td>SmartMount automatically detects volumes connected to your Mac and makes them available to the virtual machine as well.</td>
</tr>
</tbody>
</table>
Parallels Tools for Windows

Parallels Tools can be installed in the following Windows guest operating systems:

- Windows 7
- Windows Server 2008
- Windows Vista
- Windows XP
- Windows Server 2003
- Windows 2000

Note: If Parallels Tools are not installed in these Windows guest operating systems, the virtual machines will not get connected to the network.

Installing Parallels Tools

If you created your virtual machine using express installation, Parallels Tools were installed automatically after the installation of Windows.

Otherwise, do the following to install Parallels Tools in it:

1. Start the virtual machine and log in to Windows.
2. When Windows boots up, connect the Parallels Tools ISO image by choosing Install Parallels Tools from the Virtual Machine menu.

   Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be installed in your guest operating system. To see the list of guest OSs supported by Parallels Tools, refer to Parallels Tools Overview in Parallels Desktop Help available through the Help menu.

3. In the Welcome window, click Install. The wizard will start the automatic installation.
4. When the installation is complete, click Reboot to exit the wizard and restart the virtual machine.

You can also install Parallels Tools manually:

1. Start the virtual machine and log in to the guest OS.
2. Connect the Parallels Tools ISO image by right-clicking the CD/DVD drive icon in the virtual machine's window status bar and choosing Connect Image.
3. In the Finder window, go to the hard disk folder (normally named "Macintosh HD"), select the /Library/Parallels/Tools/ folder, select the prl-tools-win.iso file, and click Open to connect it to the virtual machine.

   Note: If you cannot find the /Library/Parallels/Tools/ folder, make sure that you selected the Library folder at the highest level of Macintosh HD, not in your user home folder.

4. In the virtual machine, open My Computer and double-click the Parallels Tools disc icon to start the installation. If the installation wizard does not launch automatically, right-click the disc, choose Open from the shortcut menu, and double-click Setup.exe to launch the installer.
5 Follow the wizard's instructions to complete the installation.

To edit the settings of Parallels Tools installed in your virtual machine, use the Options tab in the Virtual Machine Configuration dialog.

Reinstalling Parallels Tools

To reinstall Parallels Tools, start your virtual machine, and select Reinstall Parallels Tools from the Virtual Machine menu. This option is available only if Parallels Tools are up-to-date. If Parallels Tools are outdated, you will see the Update Parallels Tools option instead.

How to check if Parallels Tools have been installed

You can easily confirm whether Parallels Tools were installed. Start your virtual machine and look at the status bar of its window. If the tip "Press Ctrl + Alt to release the mouse and keyboard" appears in the status bar of the virtual machine's window, this means that Parallels Tools were not installed. When Parallels Tools are installed, you do not need to press any key to release the mouse and keyboard - they are released automatically.
Parallels Tools for Linux

Parallels Tools can be installed in Linux guest operating systems that comply with the following requirements:

- glibc 2.3.4 and later
- libstdc++ 3.4.6 and later (libstdc++.so.6)
- gcc 3.4.6 and later (including C++ support)
- make 3.80
- X Window System X11R6.7, X11R6.8, X11R6.8.99, X11R7.0, X11R7.1, X11R7.2 (1.3), X11R7.3 (1.4)
- kernel sources or development package

**Note:** Some of Parallels Tools, like Shared Folders Tool and Time Synchronization Tool, may also work in the Linux operating systems that do not comply with the requirements listed above.

Preparing for installation

Before installing Parallels Tools in a Linux virtual machine, perform the following actions:

- Close all applications running on the virtual machine.
- If you use a 3D accelerated window manager, disable it.
- Make sure that you have the gcc package and kernel sources installed. If these packages are not installed, the Parallels Tools installer will inform you about this. The kernel sources package name depends on the type of Linux operating system you use: it can be `kernel-devel`, or `kernel-headers`, or something else. For more information about the kernel sources, refer to [Installing the GCC package and Kernel Sources in Linux](p. 231).

**Note:** To install Parallels Tools in your virtual machine, you must have the `root` privileges.

Installing Parallels Tools in the most recent versions of Linux systems

If you have one of the most recent versions of Linux OSs (Ubuntu, Fedora) in your virtual machine, the `prl-tools-lin.iso` image file will be mounted automatically after you connect it to the CD/DVD drive. To install Parallels Tools, do the following:

1. Start the virtual machine.
2. When the operating system boots up, click Virtual Machine and choose Install Parallels Tools.

**Note:** If the Install Parallels Tools option is grayed out, make sure that your operating system complies with the requirements listed above.

The `prl-tools-lin.iso` image file will be mounted to the virtual machine's CD/DVD drive.

You can connect and mount the Parallels Tools ISO image file manually. Right-click the CD/DVD drive icon in the virtual machine's window status bar and choose Connect Image. In the Finder window, go to the hard disk folder (normally named "Macintosh HD"), select the `/Library/Parallels/Tools/` folder, select the `prl-tools-lin.iso` file, and click Open to connect it to the virtual machine.
3 Start a terminal in your Linux guest OS. Type the following command to gain the root privileges:

```
su
```

4 Change the directory to the CD/DVD drive directory using

```
cd /media/cdrom/
```

**Note:** In some of the Linux operating systems, the mount point for the virtual CD/DVD drive may appear as `/media/Parallels\ Tools/`.

5 In the CD/DVD drive directory, enter the following command to launch Parallels Tools installation:

```
./install
```

6 Follow the Parallels Tools Installer instructions to complete the installation.

7 When the installation of Parallels Tools is complete, restart your virtual machine.

### Installing Parallels Tools in other versions of Linux guest OSs

To install Parallels Tools in the older versions of Linux OSs, you have to mount the `prl-tools-lin.iso` image file manually. Do the following:

1 Start the virtual machine.

2 When the guest OS boots up, choose **Install Parallels Tools** from the **Virtual Machine** menu.

**Note:** If the **Install Parallels Tools** option is grayed out, make sure that your operating system complies with the requirements for Parallels Tools installation.

The `prl-tools-lin.iso` image file will be connected to the virtual machine's CD/DVD drive.

3 Start a terminal in your Linux guest OS. Type the following command to gain the root privileges:

```
su
```

4 Check if the Parallels Tools CD image is mounted by entering

```
mount | grep iso9660
```

If this command does not return anything, proceed to the next step.

If this command returns anything like

```
/dev/cdrom on /media/cdrom type iso9660 (ro,exec,nosuid,nodev,uid=0),
```

skip the next step and proceed to the following one.

If this command returns anything like

```
/dev/cdrom on /media/cdrom type iso9660 (ro,noexec,nosuid,nodev,uid=0)
```

with the noexec option present in parentheses, you need to unmount the disc using the following command and then proceed to the next step:

```
umount /dev/cdrom
```

5 To mount the Parallels Tools installation disc image, enter the following:

```
mount -o exec /dev/cdrom /media/cdrom
```

**Note:** `/dev/cdrom` is the virtual machine's CD/DVD drive and `/media/cdrom` is the mount point for this device. In some of the Linux operating systems the virtual CD/DVD drive may appear as `/dev/hdb` and the mount point `/mnt/cdrom`. Some Linux OSs do not have the CD/DVD drive mount point. In this case, you should create the mount point directory manually.
6 When the installation disc image is mounted, change the directory to the CD/DVD drive directory using
\texttt{cd /media/cdrom/}

7 In the CD/DVD drive directory, enter the following to launch Parallels Tools installation:
\texttt{./install}

\textbf{Note:} You must have the \texttt{root} privileges to run this command.

8 Follow the Parallels Tools Installer instructions to complete the installation.

9 When the installation of Parallels Tools is complete, restart your virtual machine.

\textbf{Note:} If X Server fails to start in your virtual machine, you can install Parallels Tools manually in text mode (p. 230).

To edit the settings of Parallels Tools installed in your virtual machine, use the \textbf{Options} tab in the \textit{Virtual Machine Configuration} dialog.

\textbf{Reinstalling Parallels Tools}

To reinstall Parallels Tools, remove them (p. 88) first, and then install them again.

\textbf{How to check if Parallels Tools have been installed}

You can easily confirm whether Parallels Tools were installed. Start your virtual machine and look at the status bar of its window. If the tip "Press Ctrl + Alt to release the mouse and keyboard" appears in the status bar of the virtual machine's window, this means that Parallels Tools were not installed. When Parallels Tools are installed, you do not need to press any key to release the mouse and keyboard - they are released automatically.

\textbf{Troubleshooting}

Parallels Tools installer can be blocked by SELinux. To solve this problem:

1 Start a terminal and determine your version of kernel by entering

\texttt{uname -r}

2.6.18-8.el5 is the version of your kernel.

2 Open the /boot/grub/grub.conf file or /boot/grub/menu.lst (depends on the version of your Linux operating system) and find the entry that corresponds to your version of kernel.

\begin{verbatim}
title Red Hat Enterprise Linux Server (2.6.18-8.el5)  
root (hd0,0)  
kernel /vmlinuz-2.6.18-8.el5 ro root=/dev/VolGroup00/LogVol00 rhgb quiet  
initrd /initrd-2.6.18-8.el5.img
\end{verbatim}

3 Type the following text at the end of the entry:

\texttt{selinux=0}

and the whole entry will be:

\begin{verbatim}
title Red Hat Enterprise Linux Server (2.6.18-8.el5)  
root (hd0,0)  
kern...  
initrd /initrd-2.6.18-8.el5.img
\end{verbatim}

4 Save the file and restart the virtual machine.

After the restart, mount the Parallels Tools disc image and try to install Parallels Tools.
Parallels Tools for Mac

Parallels Tools can be installed in the following Mac OS X guest operating systems:

- Mac OS X Server v10.5 Leopard
- Mac OS X Server v10.6 Snow Leopard

To install Parallels Tools in Mac OS X Server:

1. Start the virtual machine, and log in to the guest OS.
2. When the guest OS boots up, connect the Parallels Tools ISO image file by choosing Install Parallels Tools from the Virtual Machine menu.

   **Note:** If the Install Parallels Tools option is grayed out, make sure that your guest operating system complies with the requirements listed above.

Alternatively, you can connect the Parallels Tools ISO image file manually: right-click the CD/DVD-ROM icon in the virtual machine's window status bar and choose Connect Image. In the Finder window, go to the hard disk folder (normally named "Macintosh HD"), select the /Library/Parallels/Tools/ folder, select the prl-tools-mac.iso file, and click Open to connect it to the virtual machine.

3. In the virtual machine, open the Parallels Tools disc and double-click the Install to start the installation.
4. In the Welcome window, click Continue, and follow the assistant's instructions.
5. When the installation is complete, click Restart to exit the assistant and restart you virtual machine.

To edit the settings of Parallels Tools installed in your virtual machine, use the Options tab in the Virtual Machine Configuration dialog.

Reinstalling Parallels Tools

To reinstall Parallels Tools, remove them (p. 88) first, and then install them again using the above procedure.

How to check if Parallels Tools have been installed

You can easily confirm whether Parallels Tools were installed. Start your virtual machine and look at the status bar of its window. If the tip "Press Ctrl + Alt to release the mouse and keyboard" appears in the status bar of the virtual machine's window, this means that Parallels Tools were not installed. When Parallels Tools are installed, you do not need to press any key to release the mouse and keyboard - they are released automatically.
Parallels Tools for OS/2 and eComStation Guest OSs

All of the OS/2 and eComStation tools can be installed from the prl-tools-other.iso CD image. Network drivers can also be installed from the prl-tools-os2.fdd floppy disk image file during the operating system installation. The latter is easier in most cases.

Before starting the installation you should connect the CD image with Parallels Tools to your virtual machine’s CD/DVD drive. Choose Install Parallels Tools from the Virtual Machine menu.

Mouse Synchronization Tool Installation

Mouse Synchronization Tool consists of the mouse driver and video filter.

Note: To install Mouse Synchronization Tool, you should have a VESA video driver installed (e.g. SDD or GENGRADD). For instructions on how to install this video driver, refer to the OS/2 documentation.

To install Mouse Synchronization Tool:

1. Click the Drives icon on the system panel. Select the CD/DVD drive and locate the <CD-ROM drive>\Drivers\Mouse\OS2 directory.

   Note: When installing the driver on eComStation 1.2, go to the <CD-ROM drive>\Drivers\Mouse\ECS12 directory.

2. Launch the INSTALL.CMD batch file. INSTALL.CMD copies files and makes necessary modifications to the CONFIG.SYS file.

3. Restart the guest OS/2 operating system.

Clipboard Synchronization Tool Installation

In OS/2 and eComStation you have to launch Clipboard Synchronization Tool manually. This tool is an ordinary application and should be treated as such. If you want Clipboard Synchronization Tool to start automatically when your guest operating system is started, copy the PrlClip.exe tool file to the virtual machine’s hard disk and include it into the autostart group (startup.cmd file or another file used in the guest operating system for similar purposes).

Clipboard Synchronization Tool is located in the <CD-ROM drive>\ClipBrd\OS2 directory on the CD image containing Parallels Tools.

Sound Driver Installation

Before installing Sound Driver, make sure you have the multimedia support installed in the OS/2 guest OS.

To install Sound Driver:

1. Click the System Setup icon on the system panel.

2. Select Install/Remove line and then select Multimedia Application Install.
3 In the **IBM Multimedia Presentation Manager/2 - Installation** window choose the CD/DVD drive, then the `<CD-ROM drive>`\Drivers\Sound\OS2 directory. Select the **ALC Codec** feature and click the **Install** button.

4 Restart the OS/2 guest operating system.

**Network Driver Installation**

To install Realtek RTL8029 driver inside the OS/2 Warp version 4.5:

1 Click the **System Setup** icon on the system panel.

2 Click the **MPTS Network Adapters and Protocol Services** icon to open the **Multi-Protocol Transport Services** window.

3 Click **Configure**.

4 In the window that appears, click **Configure** again.

5 In the **Adapter and Protocol Configuration** window, click the **Other adapters** button below the **Network Adapters** section.

6 In the **Copy Additional Network Adapter Drivers** window specify the path to the Parallels driver on the CD disc image. The path will be like the one below:

   `<CD-ROM drive>`\Drivers\Network\RTL8029\NDIS2OS2

7 Click **OK**. The Parallels network adapter driver will be copied. After this you can see the name **RTL8029 PCI Ethernet Adapter** included in the **Network Adapters** list. Select this name.

8 Click **Change** in the **Network Adapters** section of the window to replace the current network adapter by the selected one.

9 Click **OK** when the message "Are you sure you want to change this network adapter?" is displayed. After you click **OK**, the **RTL8029 PCI Ethernet Adapter** appears in the appropriate field of the **Current Configuration** section of the window. Now if you click **Edit** in the **Current Configuration** section of the window, you will see that you do not need to configure any properties for this driver, because it is self-configurable.

10 Click **OK** when finished.

11 Close both the **Configure** and **Multi-Protocol Transport Services** windows.

12 Click **Exit** in the **Update CONFIG.SYS** window.

13 Exit the configuration program and restart the guest OS.
Parallels Tools for Windows 98

A video driver for Windows 98 guest OS should be installed manually.

Before proceeding to installation, choose Virtual Machine > Install Parallels Tools to connect the drivers installation disc (/Library/Parallels/Tools/prl-tools-other.iso) to your virtual machine.

When the installation disc is connected, you can proceed to installation.

Video Driver Installation

Start the virtual machine and perform the following steps:

1. From the Start menu, choose Settings > Control Panel > Display.
2. In the Display Properties dialog, go to the Settings tab, and click the Advanced button.
3. On the Adapter tab, click Change. A wizard will open.
4. In the wizard, click Next.
5. Select Search for a better driver than the one your device is using now, and click Next.
6. Select Specify a location option. Click Browse. Locate the following folder on the prl-tools-other.iso connected to the CD-ROM drive and click OK: \Drivers\Video\Win9x
7. Click Next in the Update Device Driver Wizard and then, when the driver is found, click Next again.
8. Click Finish and then Close to close the Update Device Driver Wizard.
9. Click Close to exit the Display Properties dialog box.
10. When you are prompted to restart the guest OS in the System Settings Change dialog box, click Yes.

The new settings will be applied after the virtual machine is restarted.
Updating Parallels Tools

The procedure of updating Parallels Tools depends on the guest operating system where they have been installed.

**In Windows**

Parallels Desktop automatically checks for new Parallels Tools updates when you start your virtual machine.

If a newer version of Parallels Tools is available, you will see the corresponding message offering you to download and update the tools. Click **Yes** to download Parallels Tools from the Parallels Update server and install them into your virtual machine. Updating will start right after the download finishes and will prompt you to restart the virtual machine when it is complete.

If you do not want to update Parallels Tools or want to do it later, click **No**. You will be able to update them later by using the **Update Parallels Tools** option from the **Virtual Machine** menu.

*Note:* If you revert to a snapshot that was made when you had an earlier version of Parallels Tools in your virtual machine, you will also be offered to update them.

If Parallels Tools are up-to-date but you want to reinstall them, select the **Reinstall Parallels Tools** option from the **Virtual Machine** menu.

**In Linux**

Before updating Parallels Tools, you should perform the following actions:

- Close all applications in the guest operating system.
- Disable the 3D accelerated window manager if you have any.

In Linux guest operating systems, you should check for Parallels Tools updates manually from time to time.

To update Parallels Tools:

1. Start the virtual machine.
2. Choose **Update Parallels Tools** from the **Virtual Machine** menu and follow the instructions.
3. When the update is complete, restart your virtual machine.

**In Mac OS X Server**

In Mac OS X guest operating systems, you should check for Parallels Tools updates manually from time to time.

To install Parallels Tools:

1. Start the virtual machine.
2. When the guest OS boots up, choose **Install Parallels Tools** from the **Virtual Machine** menu of Parallels Desktop.
3 This will connect the prl-tools-mac.iso image to your virtual machine's CD/DVD-ROM.

4 Open the Parallels Tools CD-ROM mounted on the virtual machine's desktop and double-click the Install icon.

5 In the Welcome window, click Continue, and follow the instructions.

6 When the updating is complete, click Restart to quit the installer and restart your virtual machine.
Removing Parallels Tools

Parallels Tools can be removed through a general procedure of removing applications from the operating system installed in your virtual machine.

Removing from a Windows guest OS

1. Start the virtual machine and log in to the guest OS.
2. From the Windows Start menu, choose Control Panel > Add or Remove Programs. In Windows Vista, choose Control Panel > Programs and Features.
3. Select Parallels Tools in the list and click Remove.
4. When Parallels Tools are removed, restart the guest operating system.

Removing from a Linux guest OS

Perform the following actions before removing Parallels Tools:

- Close all applications in the guest operating system.
- Disable the 3D accelerated window manager if you use any.

To remove Parallels Tools:

1. Start the virtual machine.
2. To remove Parallels Tools, you should connect and mount the prl-tools-lin.iso image and launch Parallels Tools Installer. For detailed instructions, see Installing Parallels Tools in a Linux Guest OS (p. 79).
3. Follow the Parallels Tools Installer instructions. When prompted to choose the action to perform, select Remove and press Enter.
4. When Parallels Tools are successfully removed, press Enter to close the window.

Removing from Mac OS X Server Leopard

1. Start the virtual machine, and log in to the guest OS.
2. To remove Parallels Tools, you should connect and mount the prl-tools-mac.iso image and launch Parallels Tools Installer. For detailed instructions, see Installing Parallels Tools in Mac OS X (p. 82).
3. Open the mounted image of the disc and double-click the Uninstall Parallels Tools icon to start the deinstallation.
4. In the Welcome window, click Uninstall. Enter the password when prompted.
5. In the Uninstallation window, you can see the process of Parallels Tools being removed from the virtual machine.
6. In the Uninstallation Completed window, click Restart to finish the deinstallation and quit the assistant.
This chapter provides the information on how to work with your virtual machines.

In This Chapter

Basic Operations ................................................................. 90
Working With Virtual Machine's Applications......................... 104
Configuring Network in Virtual Machines ............................. 109
Connecting USB Devices to a Virtual Machine........................ 114
Setting Up a Printer in a Virtual Machine ............................... 117
Managing Virtual Machines ............................................... 125
Basic Operations

Starting a Virtual Machine and Shutting it Down

Starting a Virtual Machine

To start a virtual machine, do one of the following:

- Click the Start button near the virtual machine name in the Parallels Virtual Machines list (p. 33).
- Click the virtual machine state menu in the status bar (p. 39) and choose Start.
- Click the virtual machine in the Parallels Virtual Machines list (p. 33) and choose Start from the Virtual Machine menu.

You can start virtual machines only if your copy of Parallels Desktop is activated. See the Activating Parallels Desktop section (p. 23) for details.

Tip: To access the virtual machine's files without starting it, use Parallels Mounter.

Shutting Down a Virtual Machine

To power off the virtual machine, use the standard shutdown procedure of the guest operating system installed in it, or click the virtual machine state menu in the status bar (p. 39) and choose Shut Down.

If the guest operating system cannot be shut down for some reason, you can forcibly stop the virtual machine by doing one of the following:

- Click the virtual machine state menu in the status bar (p. 39) and choose Stop; or
- Choose Stop from the Virtual Machine menu.

Warning: If you forcibly stop a virtual machine, all unsaved data will be lost.
Working With Virtual Machines

Suspending and Pausing a Virtual Machine

Starting and shutting down virtual machines may take a considerable amount of time. Instead of performing these operations, you can suspend or pause a virtual machine for the required time and quickly resume it later.

Note: Close the Virtual Machine Configuration (p. 170) dialog before changing the virtual machine state.

Suspending a Virtual Machine

Suspending a virtual machine is similar to putting a real computer into the sleep mode. When you suspend a virtual machine, you save its current state (including the state of all applications and processes running in the virtual machine) to a special file on your Mac. When the suspended virtual machine is resumed, it continues operating at the same point the virtual machine was at the time of its suspension.

Suspending your virtual machine may prove efficient if you need to restart your Mac, but do not want to:

- quit the applications running in the virtual machine
- spend much time on shutting the guest operating system down and then starting it again

To suspend a virtual machine, do one of the following:

- Click the virtual machine state menu in the status bar (p. 39) and choose Suspend; or
- Choose Suspend from the Virtual Machine menu.

You can see the progress of saving the virtual machine state.

Note: You can only view the configuration of a suspended virtual machine. If you want to edit it, you will have to stop the virtual machine.

To resume a suspended virtual machine, click the virtual machine state menu in the status bar (p. 39) and choose Resume or choose Resume from the Virtual Machine menu.

Pausing a Virtual Machine

Pausing a virtual machine releases the resources, such as RAM and CPU, currently used by this virtual machine. The released resources can then be used by the host computer and its applications or by other virtual machines running on the host computer.

To pause a virtual machine, do one of the following:

- Click the virtual machine state menu in the status bar (p. 39) and choose Pause; or
- Choose Pause from the Virtual Machine menu.

When a virtual machine is paused, its window is grayed out. To continue running the virtual machine, click the virtual machine state menu in the status bar (p. 39) and choose Resume or choose Resume from the Virtual Machine menu.
Parallels Desktop is designed to operate like an ordinary computer application. This means that you do not have to change the virtual machine state from running to paused, suspended, or stopped before putting your Mac to sleep. In sleep mode, the applications running on your Mac (including Parallels Desktop and all virtual machines) do not consume any resources and quit automatically. As you start your Mac, all the applications are automatically up and running again.

**Setting a Restriction on Changing the Virtual Machine State**

If you select the *Change virtual machine state* option in the *Security* pane (p. 179) of the *Virtual Machine Configuration* dialog, you will have to provide your administrator password each time you want to start, stop, suspend, or otherwise change the virtual machine state.

To edit the security settings of your virtual machine:

1. Select *Configure* from the *Virtual Machine* menu to open the *Virtual Machine Configuration* dialog.

2. Select the *Options* tab of the *Virtual Machine Configuration* dialog and go to the *Security* pane.
Changing the View Mode

Switching to the Full Screen Mode

You can run a guest operating system in the Full Screen mode (p. 95) when the guest operating system window occupies the whole screen and all Mac OS X and Parallels Desktop controls are hidden. To see the Mac OS X Dock and the Parallels Desktop menus while working in the Full Screen mode, press Ctrl+Alt.

To switch to the Full Screen mode, do one of the following:

- Click the Full Screen button in the Parallels Desktop toolbar;
- Choose Full Screen from the View menu;
- Use the appropriate hot key combination (Alt+Cmd+Return by default); or

Note: The default hot key combinations can be configured in the Keyboard pane (p. 45) of the Preferences dialog.

- Click the down arrow button near the Coherence button in the virtual machine status bar and choose Full Screen from the menu.

To switch the virtual machine from Full Screen to another view mode:

- Press the appropriate hot key combination (Alt+Cmd+Return by default);
- Press Ctrl+Alt to display the Parallels Desktop menus, click the View menu, and choose the view mode to which you want to switch your virtual machine; or
- Press Ctrl+Alt to display the Dock, right-click the Parallels Desktop icon in the Dock, point to the View item, and choose the view mode to which you want to switch your virtual machine.

Switching to the Coherence Mode

The Coherence mode (p. 95) provides high level of integration between Mac OS X and your Windows guest operating system. In this mode, you can have the Mac OS X Dock, Windows taskbar, and any applications running under these operating systems on one desktop. For more information on the Coherence mode, see Working in the Coherence Mode (p. 144).

To switch a running virtual machine to the Coherence view mode, do one of the following:

- Click the Coherence button in the Parallels Desktop toolbar;
- Choose Coherence from the View menu;
- Use the appropriate hot key combination (Ctrl+Cmd+Return by default); or

Note: The default hot key combinations can be configured in the Keyboard pane (p. 45) of the Preferences dialog.

- Click the Coherence button in the virtual machine status bar.

To switch the virtual machine from Coherence to another view mode:
Click the **View** menu and choose the view mode to which you want to switch your virtual machine;

- Use the appropriate hot key combination (Ctrl+Cmd+Return by default); or
- Right-click the Parallels Desktop icon in the Dock, point to the **View** item, and choose the view mode to which you want to switch your virtual machine.

### Switching to the Modality Mode

When you switch your virtual machine to the Modality view mode (p. 95), you can resize the virtual machine window and place it side by side with your Mac applications. The virtual machine window can be scaled to any size and its contents will still be active. This allows you to monitor the tasks running inside the virtual machine while you are working on the Mac side.

In the Modality mode, you can:

- Simply resize the virtual machine window by dragging its right corner.
- Resize the virtual machine window and change the ratio of its sides by pressing and holding `Alt` and dragging the window right corner.
- Resize the virtual machine window and dynamically adjust the screen resolution by pressing and holding `Shift` and dragging the window right corner.

To switch a running virtual machine to the Modality mode, do one of the following:

- Click the **Modality** button in the Parallels Desktop toolbar;
- Choose **Modality** from the **View** menu;
- Use the appropriate hot key combination (Ctrl+Alt+Cmd+Return by default).

**Note:** The default hot key combinations can be configured in the **Keyboard** pane (p. 45) of the **Preferences** dialog.

- Click the down arrow button near the **Coherence** button in the virtual machine status bar and choose **Modality** from the menu.

To switch the virtual machine from Modality to another view mode:

- Click the **View** menu and choose the view mode to which you want to switch your virtual machine;
- Use the appropriate hot key combination (Ctrl+Alt+Cmd+Return by default); or
- Right-click the Parallels Desktop icon in the Dock, point to the **View** item, and choose the view mode to which you want to switch your virtual machine.

When you switch back from Modality to the Window view mode, the toolbar is hidden. If you want to add it back to the virtual machine window, choose **Show Toolbar** from the **View** menu.

To customize the Modality settings, refer to the **Modality** pane (p. 192) of Virtual Machine Configuration.
Virtual Machine View Modes

Parallels Desktop provides a number of view modes to make your work with virtual machines more comfortable and efficient:

- **Window mode.** In this mode, the virtual machine screen is displayed as a separate window. This is the default view mode.
- **Full Screen mode.** In this mode, the virtual machine screen is expanded to occupy the whole of your physical computer screen.

  The Full Screen-related settings can be configured in the **Full Screen** pane (p. 190) of the **Virtual Machine Configuration** dialog.

- **Coherence mode.** In this mode, the virtual machine desktop is invisible. You can see only the windows of running guest OS applications and work with them side by side with your Mac OS X applications.

  **Note:** The Coherence view mode is available only for Windows virtual machines with Parallels Tools installed (p. 74).
In the picture above, you can see a virtual machine running in the Coherence view mode. The virtual machine itself is hidden however, if you launch any guest OS application, for example, Internet Explorer, its window will be visible. You will be able to work with Internet Explorer side by side with your Mac OS X applications (for example, with Chess).

The Coherence-related settings can be configured in the Coherence pane (p. 188) of the Virtual Machine Configuration dialog.

- **Modality mode.** In this mode you can view the virtual machine and the programs running inside it in a transparent scaled window while working in Mac OS X. By default, this window appears on top of all opened windows, so you can supervise your virtual machine during your work in Mac OS X.

You may find this view mode useful when your virtual machine is performing a time-consuming task that does not require your interaction. For example, if you start copying some files from an external storage to your virtual machine, you can switch it to Modality. The virtual machine window will become transparent and scalable and you will be able to view the file copy progress in it. In the meantime, you can start or continue working with Mac OS X.

The Modality-related settings can be configured in the Modality pane (p. 192) of the Virtual Machine Configuration dialog.

For switching between these modes, you can use the View menu commands or toolbar buttons.

**Note:** You can change the virtual machine view mode only when the virtual machine is running.
Capturing Keyboard and Mouse

To start working in a virtual machine, you need first to capture the keyboard and mouse input in the virtual machine. To do this:

1. Move the mouse pointer over the virtual machine window.
2. Click in the window.

When the keyboard and mouse input is captured in the virtual machine, you cannot move the pointer out of the virtual machine window and all keystrokes and button clicks go to the virtual machine. To release the keyboard and mouse back, press the hot key combination (Ctrl+Alt by default). The keyboard and mouse will be released immediately.

**Note:** The default hot key combinations can be configured in the Keyboard pane (p. 45) of the Preferences dialog.

If you want to automatically capture and release the keyboard and mouse input, you should install Parallels Tools (p. 74) in your virtual machine. After the Parallels Tools installation, you can capture and release the mouse and keyboard input more easily:

- Click anywhere in the virtual machine window to capture the input; and
- Click anywhere outside the virtual machine window to release the input.

Using SmartMouse

If you install Parallels Tools (p. 74) in your virtual machine, you will also be able to use the SmartMouse feature to capture and release the keyboard and mouse input. This feature can be configured or disabled in the Advanced pane (p. 193) of the Virtual Machine Configuration dialog:

- If you select On, the mouse input will be automatically captured in the virtual machine window when the mouse pointer hovers over it and then released when it moves back to Mac OS. This will make the mouse move seamlessly between your Mac and the virtual machine.
- If you select Off, you will need to click inside the virtual machine window to capture the mouse input, and press the hot key combination (Ctrl+Alt by default) to release it back to your Mac. It may be convenient if you want the mouse pointer to always stay inside the virtual machine window in the Window and Modality view modes (p. 93).

**Note:** You can define another hot key combination for releasing the mouse in the Keyboard pane (p. 45) of the Preferences dialog.

- If you select Auto, the option will automatically become disabled (Off) each time you use a game, graphic application, or any other program that uses its own mouse pointer instead of using the operating system pointer. The option will be automatically enabled (On) after you quit the application.

Mouse Wheel Horizontal Scrolling

You can use the mouse wheel horizontal scrolling when working with windows of virtual machine applications. This feature is available only if Parallels Tools (p. 74, p. 16) are installed in the virtual machine.
Using Keyboard Shortcuts in a Virtual Machine

If you want to send a key combination to a running virtual machine, do one of the following:

- Press the key combination that you want to send to your virtual machine when the keyboard input is captured inside the virtual machine window (p. 98);
- Click the keyboard icon in the virtual machine status bar and click the key combination that you want to send to your virtual machine; or
- Click the Devices menu, point to the Keyboard item, and click the key combination that you want to send to your virtual machine.

Using Keyboard shortcuts in MacBook and MacBook Pro

- To use the F1-F12 keys in your virtual machine, press the Fn+(F1-F12) key combination instead.

For additional information, see also Keyboard Preferences (p. 45).

Installing Applications in a Virtual Machine

You can install software inside your virtual machine in the same way as you would do on any other real computer:

- using a CD/DVD disc or image file containing the application installation files
- using a USB drive containing the application installation files
- downloading the necessary application from the network.

If you want to install an application from a real CD/DVD drive on your Mac, connect it first to the virtual machine, and then insert the disc into this drive. For detailed information on how to connect CD/DVD drives to your virtual machine, refer to CD/DVD Settings (p. 200).

If you want to install an application from an existing CD or DVD image file, specify the path to the image file in the CD/DVD pane (p. 200) of the Virtual Machine Configuration dialog. For detailed information on connecting image files to your virtual machine, refer to CD/DVD Settings (p. 200).

If you want to install an application from a USB device, you should first add a USB controller to the virtual machine using the Virtual Machine Configuration dialog. For detailed information on how you can do it, refer to Adding and Removing Devices (p. 215). Then connect the USB device to your virtual machine (p. 114).

If you want to install an application through the network, first make sure that your virtual machine is connected to it. By default, all virtual machines are set to operate in the Shared Networking mode. In this mode, your virtual machine can access the Internet while being invisible to other computers on the network, except your Macintosh computer and other virtual machines running on it. For more information on connecting virtual machines to the network and available network modes, refer to Networking in a Virtual Machine (p. 109).

The application will be installed on the virtual machine hard disk.
Placing an Image on Top of the Virtual Machine Window

Parallels Desktop allows you to create images (also called clips) of the whole Mac OS X desktop or any of its parts. When taken, these images are automatically placed over your opened virtual machine window and remain visible irrespective of what applications you run or what window you open in your virtual machine. For example, you can create a clip containing some important information and always have this information right before your eyes when working in the virtual machine. You can also take a clip of some part of an application running on your Mac and have it displayed when working with another application in your virtual machine without need to switch between these applications. Using clips may prove especially efficient if you are running your virtual machine in the Full Screen view mode.

To make a clip:

1. Open the virtual machine.
2. Choose Make Clip from the View menu.
3. Using the left mouse button, select the area you want to capture.
4. When you release the mouse button, the resulting clip will appear on top of all open windows. It will remain visible even if you switch your virtual machine to Full Screen.
After the clip has been successfully created, you can manage it as follows:

- Save the clip on your Mac OS X desktop by right-clicking it and choosing **Save on Desktop**.
- Close the clip by clicking the close button in the clip window. If the clip was not saved before, it will be completely removed from your Mac.
- Copy the clip to the clipboard by right-clicking it and choosing **Copy to Clipboard**.
- Change the clip size by dragging the lower right corner of the clip window.
- Allow the clip to be overlaid by applications and windows that you open in your Mac by right-clicking this clip and disabling the **Always on Top** option.

### Making Screenshots

If you want to make a screenshot of the guest operating system running in your virtual machine, choose **Make Screenshot** from the **View** menu. The first screenshot file will be named **Parallels Picture.png** and placed on the Mac OS X desktop. The next screenshots will have the same name with an appropriate number added.
Changing the Configuration at Runtime

Parallels Desktop allows you to connect or disconnect certain devices at runtime or switch some of them for using other media.

Generally, the following virtual devices can be connected or disconnected at runtime:

- Floppy disk drive
- CD/DVD-ROM drives
- Network adapter
- Sound device
- USB device
- Shared folders

If printer and serial ports are present in the virtual machine configuration, you can also manage them at runtime.

You can configure any of these devices in one of the following ways:

- Use the necessary command from the Devices menu in the menu bar. This menu is available only when the virtual machine is running.
- Click a device icon on the status bar (p. 39) and choose the command from a device shortcut menu.
  The status bar displays the devices information when the virtual machine is running.
- Drag an image file (*.iso or *.fdd) or a shared folder on the appropriate device icon in the status bar. This option is available only for CD/DVD-ROM drives, floppy drives and shared folders.

Connecting a CD/DVD-ROM or a Floppy Drive

If you have several CD/DVD-ROM drives connected to your virtual machine, in the Devices menu they are listed in the same order as they were connected. The first CD/DVD-ROM drive will be CD/DVD-ROM 1, the second will be CD/DVD-ROM 2, and so on.

Connecting a Network Adapter

You can set up any of the three network modes: Shared Networking, Bridged Networking, or Host-Only Networking.

Connecting a Sound Device

To connect or disconnect a sound device, choose the Activate or Mute options respectively. You can also choose the type of output and input devices.

Connecting a USB Device

Parallels Desktop automatically detects all USB devices plugged into your Mac computer. The devices that are currently connected to the virtual machine appear in the list from the Device menu. You cannot use a USB device in Mac OS X while it is being used by the virtual machine.
Connecting a Shared Folder

The Shared Folders options available at runtime are similar to the settings in the Virtual Machine Configuration dialog.

You can

- share all Mac disks or Home Folder only with the virtual machine
- share Windows guest operating system disks with Mac OS X
- add a new shared folder

Connecting a Serial Port

To connect or disconnect a serial port, do the following:

- Click the Devices menu, select the corresponding serial port, and choose the appropriate command in the displayed menu.
- Right-click the serial port icon in the status bar (p. 39) to display the shortcut menu and choose the appropriate command.

Connecting a Printer Port

To connect or disconnect a printer port or to connect a printer or an output file to a printer port, do the following:

- Click the Devices menu, select the corresponding printer port, and choose the appropriate command in the displayed menu.
- Right-click the printer port icon in the status bar (p. 39) to display the shortcut menu and choose the appropriate command.
Working With Virtual Machine's Applications

Setting Up Virus Protection

Parallels Desktop allows you to install the antivirus software powered by Kaspersky on your Mac and in Windows XP, Windows Vista, and Windows 7 virtual machines with Parallels Tools installed (p. 74). This antivirus software is provided with a free activation key for 90 days. When the trial period expires, you can purchase a permanent activation key.

*Note:* You need the Internet connection to download the antivirus software from the Parallels website.

You can install any other antivirus software you like in your virtual machine. Use the standard installation procedure for this software.

**Installing Antivirus Software on Your Mac**

To install the antivirus software powered by Kaspersky on your Mac, follow these steps:

1. Choose **Install Kaspersky for Mac** from the **File** menu.
2. When prompted, enter your administrator credentials.
3. Wait until the installation is complete.
4. Activate the trial version of the antivirus software powered by Kaspersky. You will be able to use it for free for 90 days. When the trial period expires, you will need to purchase a permanent activation key or uninstall the antivirus software.

To uninstall the antivirus software, choose **Uninstall Kaspersky for Mac** from the **File** menu, enter your administrator credentials, and wait until uninstall is complete.

**Installing Antivirus Software in a Virtual Machine**

After Parallels Tools installation, you will be asked if you want to install the antivirus software powered by Kaspersky. To install it, click **Install** and follow the wizard instructions.

To install the antivirus software manually, follow these steps:

1. Launch Parallels Desktop and start your Windows XP, Windows Vista, or Windows 7 virtual machine from the **Parallels Virtual Machines** list (p. 33).
   When the virtual machine boots up, make sure that Parallels Tools (p. 74) are installed. If they are not installed, install Parallels Tools (p. 74) in your virtual machine.
2. If Parallels Tools are installed in your virtual machine or if you have just installed them, choose **Install Kaspersky Internet Security** from the **Virtual Machine** menu. Kaspersky Internet Security Installer will launch. The installation is performed in the unattended mode and the software is activated automatically. You can view the operation progress in the progress bar.
3 When the installation is complete, click **Reboot** in the **Install Succeed** window to close the wizard and restart the virtual machine.

Now you have a 90-day antivirus protection in your virtual machine. The free trial period starts from the moment of the first installation and won't be restarted if you reinstall Kaspersky Internet Security later. When the trial period expires, you will need to purchase a permanent activation key or remove Kaspersky Internet Security.

To remove Kaspersky Internet Security, remove it like any other Windows application.

**Getting Acronis Applications**

As an additional benefit, Parallels provides you for free with two more products allowing you to keep your guest operating systems safe and to have full control over your virtual disk drives:

- Acronis True Image 11 Home. This application allows you to easily back up and recover your guest operating systems, applications, settings, and personal files.
- Acronis Disk Director Suite 10.0. This application allows you to perform all the necessary operations on your virtual disks using the easiest and most convenient partition manager and hard disk toolkit.

To download these applications, follow this link: [http://www.parallels.com/download/desktop/](http://www.parallels.com/download/desktop/)
Using 3D Graphics Applications

Parallels Desktop allows you to run games and applications that require video cards with DirectX or OpenGL support in your virtual machines.

The DirectX9.0 and OpenGL2.1 support can be enabled for Windows-based virtual machines with Parallels Tools installed. The OpenGL2.1 support can be enabled for Linux-based virtual machines with Parallels Tools installed.

Note: In Linux-based virtual machines, Xorg should be of version 7.1 or later.

Enabling DirectX and OpenGL support in a virtual machine

If your virtual machine does not have Parallels Tools installed:

1. Start the virtual machine and install Parallels Tools in it. For details, refer to Installing Parallels Tools (p. 74).
2. When Parallels Tools are installed, shut down the virtual machine.

To enable DirectX and OpenGL support in the virtual machine configuration:

1. Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration dialog.
2. In the Video pane (the Hardware group of settings), select the Enable 3D acceleration option.
3. Click OK to apply the changes.

Note: If the virtual machine is running, the new settings will come into effect after you restart the virtual machine.

Optimizing 3D Graphics Performance in MacBook Pro

Some new MacBook Pro computers have two video adapters. By default, the slower video adapter that saves energy is used. If you want to use the faster video adapter for better 3D graphics performance, select System Preferences > Energy Saver > Graphics > Higher performance in the Mac OS X menu.
Using Touchpad Gestures and Apple Remote

You can use the touchpad gestures and Apple Remote to control some Windows applications.

Touchpad gestures are supported by default, while the support for Apple Remote needs to be enabled in the virtual machine configuration. To enable Apple Remote, open the virtual machine configuration by choosing Virtual Machine > Configure, click Options > Advanced, and select Enable next to Apple Remote.

**Note:** This feature is available for the following guest operating systems: Windows XP, Windows 2000, Windows Server 2003, Windows Vista, Windows 7, and Windows Server 2008.

The following table provides commands to control some of the popular Windows applications.

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard and Mouse Combination</th>
<th>Apple Remote</th>
<th>Touchpad Gesture</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Microsoft Power Point</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start slide show</td>
<td>F5</td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>End slide show</td>
<td>Esc</td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>Perform the next animation or advance to the next slide</td>
<td>N, Enter, Page Down, Right Arrow, Down Arrow, Space (or click the mouse)</td>
<td></td>
<td>Swipe right</td>
</tr>
<tr>
<td>Perform the previous animation or return to the previous slide</td>
<td>P, Page Up, Left Arrow, Up Arrow, Backspace</td>
<td></td>
<td>Swipe left</td>
</tr>
<tr>
<td>Zoom in/zoom out</td>
<td>Ctrl+wheel up /Ctrl+wheel down</td>
<td></td>
<td>Pinch open/pinch close</td>
</tr>
<tr>
<td><strong>Microsoft Word/Excel</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom in/zoom out</td>
<td>Ctrl+wheel up /Ctrl+wheel down</td>
<td></td>
<td>Pinch open/pinch close</td>
</tr>
<tr>
<td><strong>Windows Media Player</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start/pause playback</td>
<td>Space</td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>Skip to the next song</td>
<td>Ctrl+F</td>
<td></td>
<td>Swipe right</td>
</tr>
<tr>
<td>Play the previous song</td>
<td>Ctrl+B</td>
<td></td>
<td>Swipe left</td>
</tr>
<tr>
<td>Volume up</td>
<td>F8, Up Arrow, wheel up</td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>Volume down</td>
<td>F9, Down Arrow, wheel down</td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td><strong>Media Player Classic (k-lite)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start playback/pause</td>
<td>Space</td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>Volume up</td>
<td>F8, Up Arrow, wheel up</td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>Volume down</td>
<td>F9, Down Arrow, wheel down</td>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>Application</td>
<td>Feature</td>
<td>Control</td>
<td>Windows 10/11 Control</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------</td>
<td>-----------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td><strong>Winamp</strong></td>
<td>Start playback/pause</td>
<td>X to start, C to pause</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Volume up</td>
<td>Up Arrow, wheel up</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Volume down</td>
<td>Down Arrow, wheel down</td>
<td>n/a</td>
</tr>
<tr>
<td><strong>Microsoft Internet Explorer</strong></td>
<td>Page back</td>
<td>Backspace, Alt+Left Arrow</td>
<td>n/a or Swipe right</td>
</tr>
<tr>
<td></td>
<td>Page forward</td>
<td>Alt+Right Arrow</td>
<td>n/a or Swipe left</td>
</tr>
<tr>
<td></td>
<td>Zoom in/zoom out</td>
<td>Ctrl+wheel up/Ctrl+wheel down</td>
<td>n/a Pinch open/pinch close</td>
</tr>
<tr>
<td><strong>Mozilla Firefox</strong></td>
<td>Page back</td>
<td>Backspace, Alt+Left Arrow</td>
<td>n/a or Swipe right</td>
</tr>
<tr>
<td></td>
<td>Page forward</td>
<td>Alt+Right Arrow</td>
<td>n/a or Swipe left</td>
</tr>
<tr>
<td></td>
<td>Zoom in/zoom out</td>
<td>Ctrl+wheel up/Ctrl+wheel down or Ctrl+&quot;+&quot;/Ctrl+&quot;-&quot;</td>
<td>n/a Pinch open/pinch close</td>
</tr>
<tr>
<td><strong>Windows Picture and Fax Viewer</strong></td>
<td>Next image</td>
<td>Right Arrow</td>
<td>Swipe right</td>
</tr>
<tr>
<td></td>
<td>Previous image</td>
<td>Left Arrow</td>
<td>Swipe left</td>
</tr>
<tr>
<td></td>
<td>Zoom in/zoom out</td>
<td>&quot;+&quot;/&quot;-&quot;</td>
<td>or Pinch open/pinch close</td>
</tr>
<tr>
<td></td>
<td>Rotate clockwise</td>
<td>Ctrl+K</td>
<td>n/a Rotate right</td>
</tr>
<tr>
<td></td>
<td>Rotate counterclockwise</td>
<td>Ctrl+L</td>
<td>n/a Rotate left</td>
</tr>
</tbody>
</table>
Configuring Network in Virtual Machines

Parallels Desktop allows you to use three types of networking in your virtual machines:

- **Shared Networking** *(p. 109)*. This type of networking allows the virtual machine to use the current network connections of the physical computer.

- **Bridged Ethernet** *(p. 111)*. This type of networking allows the virtual machine to use one of the physical computer network adapters. This makes it appear as a separate computer on the network to which the physical computer belongs.

- **Host-only networking** *(p. 112)*. This type of networking allows the virtual machine to access only the physical computer and other virtual machines residing on it.

By default, the virtual machine uses Shared Networking because configuring it requires minimal effort from the users. The Bridged Ethernet networking mode is more complex and you may need to contact your system administrator to set it up properly.

Detailed information on these types of networking and the way to configure them is provided in the following subsections.

**Shared Networking**

By default, all newly created virtual machines are set to work in the Shared Networking mode. In this mode, your virtual machine can access other computers on your local network and the Internet by using the IP address of the physical computer. The virtual machine itself does not have its own IP address on the network. This mode allows you to specify port forwarding rules *(p. 56)* for the virtual machines running on your Mac, which can be especially useful when running HTTP, FTP, or other types of servers in virtual machines.
The Shared Networking mode does not require any additional configuration. With this mode enabled, your virtual machine will share whatever network connection your physical computer uses at the moment.

You may wish to use the Shared Network mode in the following cases:

- Your computer accesses the Internet via a modem or another non-Ethernet device.
- You need to access the Internet from inside your virtual machine but are concerned about security.
- You have problems with working in the Bridged Ethernet mode.

To configure your virtual machine to use Shared Networking:

1. Choose **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog.
2. Click **Hardware** and select **Network Adapter** in the list.
3. In the **Network Adapter** pane, select **Shared Networking** from the **Type** list and make sure the **Connected** option is enabled.

   **Note:** In the **MAC address** field, you can change the MAC address currently assigned to the virtual machine. MAC addresses are automatically generated during the virtual machine creation. However, you can modify the default MAC address by typing another value in the **MAC address** field or clicking the **Generate** button. When entering a new MAC address, make sure that it is unique within your network.

4. Click **OK**.

For the information about troubleshooting networking problems, refer to the Parallels knowledge base http://kb.parallels.com/ available at the Parallels website.
Bridged Ethernet Networking

When operating in the Bridged Ethernet mode, your virtual machine appears on the network as a stand-alone computer with its own IP address and network name.

**Note:** The Bridged Ethernet networking mode is more complex than the Shared Networking mode (p. 109) and you may need to contact your system administrator to configure it properly.

To configure your virtual machine to work in the Bridged Ethernet mode:

1. Choose **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog.
2. Click **Hardware** and select **Network Adapter** in the list.
3. In the **Network Adapter** pane, select the adapter you want to use from the **Type** list and make sure the **Connected** option is enabled.

**Note:** In the **MAC address** field, you can change the MAC address currently assigned to the virtual machine. MAC addresses are automatically generated during the virtual machine creation. However, you can modify the default MAC address by typing another value in the **MAC address** field or clicking the **Generate** button. When entering a new MAC address, make sure that it is unique within your network.

4. Click **OK**.

If you cannot configure your virtual machine to function in the Bridged Ethernet mode, you can consider using another networking mode: Shared Networking (p. 109) or Host-Only Networking (p. 112).

For the information about troubleshooting networking problems, refer to the Parallels knowledge base http://kb.parallels.com/ available at the Parallels website.
Host-Only Networking

Parallels Desktop provides a closed network that is accessible only to the primary operating system and virtual machines running on it. The primary operating system is connected to this network via the Parallels Host-Only Networking adapter automatically created on the physical computer during the Parallels Desktop installation. The addresses for the virtual machines connected to this network are provided by the Parallels DHCP server.

To configure your virtual machine to use Host-Only Networking:

1. Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration dialog.
2. Click Hardware and select Network Adapter on the list.
3. In the Network Adapter pane, select Host-Only Networking from the Type list and make sure the Connected option is enabled.

   Note: In the MAC address field, you can change the MAC address currently assigned to the virtual machine. MAC addresses are automatically generated during the virtual machine creation. However, you can modify the default MAC address by typing another value in the MAC address field or clicking the Generate button. When entering a new MAC address, make sure that it is unique within your network.

4. Click OK.

For the information about troubleshooting networking problems, refer to the Parallels knowledge base http://kb.parallels.com/ available at the Parallels website.
Using WiFi in a Virtual Machine

Parallels Desktop provides you with an opportunity to connect your virtual machine to a wireless network.

Using the Bridged Ethernet mode (p. 111), you can set up a WiFi connection and access the Internet wirelessly. When operating in this mode, your virtual machine appears on the network as a stand-alone computer with its own IP address and network name.

To configure your virtual machine to access the Internet via WiFi:

1. Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration dialog.
2. Select the Hardware tab and click Network Adapter.
3. Select Bridged Networking > AirPort from the Type list and make sure the Connected option is enabled.
4. Click OK.

After you perform these steps, your virtual machine will be able to connect to the Internet through the AirPort adapter of your Mac.

Note: If the WiFi bridging does not work in your virtual machine, try to enable the Send the host's MAC address to DHCP server option in the Network Adapter pane to ensure that the virtual machine gets a valid IP address from the WiFi access point for accessing the Internet.

If you cannot configure your virtual machine to function in the Bridged Ethernet mode, you can consider using another networking mode: Shared Networking (p. 109) or Host-Only Networking (p. 112).

For the information about troubleshooting networking problems, refer to the Parallels knowledge base http://kb.parallels.com/ available at the Parallels website.

Bridging a Virtual Machine to VLAN

If your Mac is a VLAN (virtual local area network) member, Parallels Desktop allows you to bridge the virtual machines running on the Mac to this VLAN.

To bridge a virtual machine to the VLAN, do the following:

1. Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration dialog.
2. Select the Hardware tab and click Network Adapter.
3. Select Bridged Networking > VLAN from the Type list and make sure the Connected option is enabled.
4. Click OK.

The virtual machine will be bridged to the selected VLAN.
Connecting USB Devices to a Virtual Machine

Parallels Desktop allows you to connect up to eight USB 2.0 and five USB 1.1 devices to a single virtual machine. This means that you can plug up to eight USB 2.0 devices and five USB 1.1 devices into your Mac and connect them to your virtual machine. To use this feature, you must add a USB controller (p. 215) to the virtual machine configuration. If the USB controller is already present, make sure it is connected (p. 214).

By default, when you plug a USB device into your Mac with one or more virtual machines running, the New USB device detected dialog appears:
In this dialog, you need to specify where the detected USB device will be connected:

- Point to Mac and click it if you want to use this USB device in Mac OS X.
- Point to the virtual machine and click it if you want to use this USB device in the virtual machine you are currently working with.

**Note:** If you select to connect the detected USB device to the virtual machine and then reboot this virtual machine, the **New USB Device** dialog will not appear again after the reboot. The USB device will still be connected to this virtual machine.

If you want Parallels Desktop to remember your choice, press the Alt button on the keyboard and keep holding it when choosing where to connect a USB device. The next time you plug this USB device into your Mac, it will be automatically connected to the destination you specified in this dialog. To change the destination, use **USB Preferences** in the **Preferences** dialog (p. 42).

If you do not want Parallels Desktop to display this dialog each time a USB device is plugged into your Mac, configure **USB Preferences** in the **Preferences** dialog (p. 42).

To be able to use the USB device in the virtual machine, you may need to install the necessary drivers in the guest OS. By default, such drivers can be obtained from the manufacturers of this device.

**Note:** If you plug a USB 1.1 device into the USB 2.0 port, the port will be identified as USB 1.1.

To disconnect a USB device from your virtual machine, do one of the following:

- Right-click the USB controller icon in the status bar (p. 39) and click this USB device listed in the context menu or
- Click the **Devices** menu (p. 38), point to the **USB** item, and click this USB device in the displayed submenu.

**Note 1:** If your virtual machine is working in Full Screen (p. 93), press Ctrl + Alt to access the **Devices** menu.

**Note 2:** If your virtual machine is working in Coherence (p. 144), right-click the Parallels Desktop icon (or Start button icon) in the Dock and you will find the **Devices** menu in the context menu.

### Connecting iSight camera to a Windows virtual machine

If you have a built-in iSight camera, you can use it in your Windows XP or later virtual machine. Before connecting the camera, you should install the iSight driver for Windows in your virtual machine. There are several ways to install the driver. For example, you can install the iSight driver together with the Boot Camp drivers in your virtual machine:

1. Insert the Mac OS X Leopard disc or "Mac OS X Install Disc 1" into your computer.
2. Start your Windows virtual machine.
3. Click the CD/DVD icon in the virtual machine status bar, select **Real CD/DVD**, and connect the Mac OS X installation disc.
4 The Boot Camp drivers installer starts. If the installer does not start automatically, browse the Mac OS X disc using Windows Explorer and double-click the `setup.exe` file in the Boot Camp folder.

5 Follow the installer instructions. When the installation is finished, restart your virtual machine.

**Note:** The iSight driver for Windows is suitable for built-in cameras only. External cameras are not supported.

To connect the iSight camera, click the USB controller icon in the virtual machine status bar and select the iSight camera in the list.

**Connecting a USB printer to a virtual machine**

You can connect a USB printer directly to your virtual machine. In this case, the printer will not be available to Mac OS X.

**Note:** If you want the USB printer to be available both to your Mac and the virtual machine, you should connect the printer to the virtual machine using a printer port. For detailed information, see *Sharing a Mac Printer* (p. 118).

To connect a USB printer directly to a virtual machine:

1 Launch Parallels Desktop and choose the virtual machine.

2 Choose **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog. Make sure the configuration includes a USB controller and it is connected. If necessary, add it. See the **Adding and Removing Devices** section (p. 215).

3 Start the virtual machine and install the native driver for the printer in the guest operating system. For detailed information on installing the printer driver, refer to the printer's manufacturer documentation.

Then do one of the following:

- If the USB printer is already connected to your Mac, click the USB controller icon in the virtual machine status bar and select this printer in the list.
- If the USB printer is not connected to your computer, connect it to your Mac. The **New USB device detected** dialog will appear. Choose to connect the printer to the virtual machine.

In the Windows guest operating system, follow the **Add New Hardware** wizard instructions. In the Linux guest operating system, follow the procedure for adding a USB printer specific for this Linux distribution.

**Connecting Common Access Card reader**

The Common Access Card (CAC) reader can work simultaneously in Mac OS X and in one virtual machine.

1 Connect the CAC reader to your Mac.

2 In the **New USB device detected** window, connect this reader to the virtual machine. Parallels Desktop will create a virtual copy of the CAC reader device in the virtual machine. This will make the CAC reader work in both Mac OS and the virtual machine.
Synchronizing a USB Palm OS Device With the Guest OS

The process of connecting a USB Palm device to a virtual machine is similar to the process of connecting other USB devices, but for some minor details.

1. When you plug a USB Palm OS device into your Mac, you should click the Synchronize button on the Palm device screen to make it visible to your Mac.

2. Your Mac will recognize the Palm device and display a message asking where you want to connect it - to Mac OS X or to the virtual machine. To be able to work with the Palm device in the virtual machine, click the virtual machine to which you want to connect it.

   If you want Parallels Desktop to remember your choice, press the Alt button on the keyboard and keep holding it when choosing where to connect the USB device. The next time you plug this USB device into your Mac, it will be automatically connected to the destination you specified in this dialog. To change the destination, use USB Preferences (p. 49) in the Preferences dialog available from the Parallels Desktop menu.

   Note: Before starting the connection, make sure you have the necessary synchronization software installed in your virtual machine.

3. The Palm device appears in the list of USB devices available for usage in the virtual machine and the data synchronization process starts.

   If you encounter problems when synchronizing the Palm OS device with your virtual machine, click Cancel on the screen of the Palm device to terminate the process and start the synchronization again.

   Note: It is not recommended to change the USB port for the Palm device or connect other USB devices to your Mac during the synchronization session.

Setting Up a Printer in a Virtual Machine

There are three basic ways to set up printing in a virtual machine. You can:

- Share any of the printers connected to your Mac computer via a printer port of your virtual machine.
- Set up a printer via Apple Bonjour Printer wizard.
  
  Note: Apple Bonjour printer is available for Windows guest OSs only.
- Use a network printer.

You can also connect a USB printer directly to your virtual machine. In this case, the printer will not be available to Mac OS X. For detailed information see Connecting USB Devices to a Virtual Machine (p. 114).
Sharing a Mac Printer

You can share any printer connected to your Mac with your Windows or Linux virtual machine. The printer will be available through the virtual machine printer port.

To share your Mac printer:

1. Launch Parallels Desktop and select a virtual machine.
2. Open the Virtual Machine Configuration dialog by choosing Configure from the Virtual Machine menu. Go to the Hardware tab and make sure the configuration includes a printer port. If necessary, add it. See Adding and Removing Devices (p. 215).
3. In the Printer Port pane, select Connected if you want the printer to be automatically connected on the virtual machine startup. Click the Source field and select the appropriate printer from the list. You can use the Default printer option if you want to use the default printer set in the primary OS.
4. Click OK to close the Virtual Machine Configuration dialog.
5. Start the virtual machine.
6. In a Windows guest OS, if you have Parallels Tools installed (p. 77), the HP Color LaserJet 8500 PS or Apple Color LW 12/660 PS printer is automatically connected to the virtual machine. You can use it at once. In a Linux guest OS, or if you do not have Parallels Tools installed in your Windows guest OS, no matter what type of printer you have, install either the HP Color LaserJet 8500 PS or Apple Color LW 12/660 PS printer driver. Then follow the procedure of adding a printer in a guest OS described below.

**Warning:** Do not install the driver from the installation CD (supplied with your printer) in the virtual machine.

Adding a printer in a Windows guest operating system

To add a printer in a Windows 7 or Windows Vista guest operating system:

1. Start the Windows virtual machine and log in as administrator.
2. Open the Windows Start menu and select Control Panel.
3. In the Control Panel window, select Hardware and Sound and click Add a printer in the Devices and Printers section (Printers in Windows Vista). The Add Printer wizard opens.
4. In the first wizard window, click Add a local printer.
5. In the Choose a printer port window, choose LPT1: (Printer Port) (or another port to which the printer is connected) from the Use an existing port menu. When ready, click Next.
6. In the Install the printer driver window, specify the printer manufacturer and model. No matter what printer you have, choose either HP Color LaserJet 8500 PS or Apple Color LW 12/660 PS. When ready, click Next.
7. Continue with the printer configuration procedure. When the printer is added to the guest operating system, you can use it to print documents from your Windows 7 or Windows Vista virtual machine.

To add a printer in a Windows XP guest operating system:
1 Start the Windows virtual machine and log in as administrator.

2 Open the Windows Start menu and select Control Panel.

3 In the Control Panel window, double-click the Printers and Faxes item.

4 Click the Add a printer link to open the Add Printer wizard.

5 In the Welcome to the Add Printer Wizard window, click Next.

6 In the Local or Network Printer window, select Local printer attached to this computer and clear the Automatically detect and install my Plug and Play printer option if it is also selected. When ready, click Next.

7 In the Select a Printer Port window, choose LPT1: (Recommended Printer Port) (or another port to which the printer is connected) from the Use the following port menu. When ready, click Next.

8 In the Install Printer Software window, specify the printer manufacturer and model. No matter what printer you have, choose either HP Color LaserJet 8500 PS or Apple Color LW 12/660 PS. When ready, click Next.

9 Continue with the printer configuration procedure. When the printer is added to the guest operating system, you can use it to print documents from your Windows XP virtual machine.

Adding a printer in a Linux guest operating system

The procedure of adding a printer in a Linux guest operating system depends on the Linux distribution. In this example, we describe how to add a printer to a virtual machine running RHEL 5.4 Server. However, you can use these guidelines as general instructions on how to add a printer to a Linux virtual machine:

1 Start the Linux virtual machine and log in when the guest operating system boots up.

   Note: You must log in as root or acquire root privileges after successful login. If you don't do that, you will be required to enter the root password when starting the system-config-printer administration tool in the next step.

2 Start the system-config-printer administration tool by doing one of the following:
   - Click System > Administration > Printing; or
   - Start the Terminal and enter the following command:

```
system-config-printer
```

3 In the displayed window, click New Printer.

4 In the next window, you must type a printer name. Under this name the printer will be displayed in your Linux guest operating system. You can also enter the printer description and location. When ready, click Forward.

5 Now you have to specify how your Mac printer will be shared with the virtual machine. As the printer is connected to the virtual machine printer port, select LPT #1 (or another port to which the printer is connected) and click Forward.

6 Then specify the printer manufacturer and model. No matter what printer you have, choose either HP Color LaserJet 8500 PS or Apple Color LW 12/660 PS. When ready, click Forward.

7 Click Apply to finish setting up the printer.

Now the printer is properly configured and you can use it to print documents from your Linux virtual machine.
Setting Up a Printer via Bonjour

You can use Apple Bonjour for Windows to share any printer connected to your Mac (or to any Mac available on the local network) with your Windows virtual machines.

Note: To see the list of all Windows operating systems supported by Bonjour, please refer to http://support.apple.com/kb/dl999.

Before sharing a Mac printer with a Windows virtual machine via Apple Bonjour, keep in mind that:

- This printer must be itself shared on your Mac. To share a printer, go to Mac OS X System Preferences > Print & Fax, select this printer, and enable the Share this printer option.
- The virtual machine must be configured to work in the Bridged networking mode (p. 111).

To set up a printer via Bonjour, follow these steps:

1. Launch Parallels Desktop and start the Windows virtual machine in which you want to set up the printer.
2. When the guest operating system boots up, download the Bonjour for Windows installation package.
   Note: You can download Apple Bonjour for Windows at http://support.apple.com/kb/dl999.
3. In your Windows guest operating system, start the Bonjour installation by launching the BonjourPSSetup.exe file from the folder to which it was downloaded.
4. In the Welcome to the Bonjour Print Services Installer window, click Next.
5. In the License Agreement window, carefully read the license agreement. If you agree with its terms, select I accept the terms in the license agreement and click Next.
6. In the next window, read the important information about Bonjour and click Next.
7. In the Installation Options window, choose where Bonjour will be installed, specify additional settings, and click Install.
8. When the installation is complete, click Finish.
9. Start the Bonjour Printer wizard either by double-clicking its icon on the desktop or by selecting Start -> All Programs -> Bonjour Print Services -> Bonjour Printer Wizard.
10. In the Browse for Bonjour Printers window, you will see all printers that you can set up in your virtual machine. Select the printer that you want to configure in the virtual machine and click Next.
11. If the next window you see is Completing the Bonjour Printer Wizard, it means that the driver required by this printer is available in the Windows driver library and the printer has been successfully configured. Click Finish and you can start using the newly added printer to print documents from your virtual machine.

However, if the next window you see is Install Bonjour Printer, you have to specify the printer manufacturer and model in the corresponding lists.
If the required printer model is not listed, you can do one of the following:

- Install the printer drivers in the guest operating system. Then click Have Disk button in the Install Bonjour Printer window and specify the path to the .inf file located in the folder where you installed the printer drivers.

- In the Install Bonjour Printer window, select Generic in the Manufacturer list and Generic/Postscript in the Model list.

Click Next.

12 In the Completing the Bonjour Printer Wizard window, click Finish. You can start using the newly added printer to print documents from your virtual machine.
Setting Up a Network Printer

You can install a network printer directly into a guest operating system.

Before installing a network printer in a guest operating system, make sure that:

- Your Mac can access the Internet.
- The virtual machine is configured to work in either the Shared networking mode (p. 109) or Bridged networking mode (p. 111) and can access the Internet too.
- The user account in the guest OS from which you are going to set up the printer has permission to access the network printer.
- You know the printer IP address.

After that, you can log in to your guest OS and install a network printer.

In a Windows Guest Operating System

Before adding a network printer in Windows, download and install an appropriate printer driver. For detailed information on installing the printer driver, refer to the printer manufacturer documentation.

To add a network printer in a Windows 7 or Windows Vista guest operating system:

1. Open the Windows Start menu and select Control Panel.
2. In the Control Panel window, select Hardware and Sound and click Add a printer in the Devices and Printers section (Printers in Windows Vista). The Add Printer wizard opens.
3. In the first window, click Add a network, wireless or Bluetooth printer.
4. In the next window, click The printer that I want isn’t listed.
5. In the Find a printer by name or TCP/IP address window, select Add a printer using a TCP/IP address or hostname and click Next.
6. In the Type a printer hostname or IP address window, do the following:
   1. Select TCP/IP Device from the Device type menu.
   2. Specify the printer IP address in the Hostname or IP address field.
   3. Clear the Query the printer and automatically select the driver to use option if it is selected.
   4. When ready, click Next.
If prompted to specify additional port information, choose **Standard**, select **Generic Network Card** from the list, and click **Next**.

In the **Install Printer Software** window, specify the manufacturer and model of the network printer.

If the required printer model is not listed, click **Have Disk** button and specify the path to the \*.inf file located in the folder where you installed the printer driver.

When ready, click **Next**.

Continue with the printer configuration procedure. When the printer is added to the guest operating system, you can use it to print documents from your Windows XP virtual machine.

To add a network printer in a Windows XP guest operating system:

1. Open the Windows **Start** menu and select **Control Panel**.
2. In the **Control Panel** window, double-click the **Printers and Faxes** item.
3. Click the **Add a printer** link to open the Add Printer wizard.
4. In the **Welcome to the Add Printer Wizard** window, click **Next**.
5. In the **Local or Network Printer** window, select **Local printer attached to this computer** and clear the **Automatically detect and install my Plug and Play printer** option if it is also selected. When ready, click **Next**.
6. In the **Select a Printer Port** window, select **Create a new port** and specify **Standard TCP/IP Port** as the port type. When ready, click **Next**.
7. In the **Welcome to the Add Standard TCP/IP Printer Port Wizard** window, click **Next**.
8. In the **Add Port** window, specify the network printer IP address and click **Next**.
9. If prompted to specify additional port information, choose **Standard**, select **Generic Network Card** from the list, and click **Next**.
10. In the **Completing the Add Standard TCP/IP Printer Port Wizard** window, click **Finish**.
11. In the **Install Printer Software** window, specify the manufacturer and model of the network printer.

If the required printer model is not listed, click **Have Disk** button and specify the path to the \*.inf file located in the folder where you installed the printer driver.

When ready, click **Next**.

Continue with the printer configuration procedure. When the printer is added to the guest operating system, you can use it to print documents from your Windows XP virtual machine.

**In a Linux or FreeBSD Guest Operating System**

The procedure of setting up a network printer in a Linux or FreeBSD guest operating system depends on the Linux or FreeBSD distribution and printer. In this example, we describe how to set up a network printer in a virtual machine running RHEL 5.4 Server. However, you can use these guidelines as general instructions on how to set up a network printer in a Linux or FreeBSD virtual machine.

**Note:** For more detailed information, refer to the CUPS documentation.

To set up a network printer:
1 Start the virtual machine.

2 Make sure the following components are installed in the guest operating system:
   - Common UNIX Printing System (CUPS). Installation instructions can be found at CUPS site;
   - Samba service. Installation instructions can be found at Samba site; and
   - A Web browser, since we consider controlling CUPS via web interface.

   **Note:** To set up a network printer, you should have root privileges.

3 Download and install an appropriate printer driver. For detailed information on installing the printer driver, refer to the printer manufacturer's documentation.

4 Start Common UNIX Printing System. In the Terminal, type the command:
   
   ```
   /etc/init.d/cups start
   ```

5 Start a web browser and type either the IP address of your virtual machine or http://127.0.0.1:631.

6 Click the Add Printer button.

7 In the Add New Printer window, specify a printer name. Under this name the printer will be displayed in the guest operating system. You can also enter the printer description and location. When ready, click Forward.

8 In the Device for <Printer Name> window, select AppSocket/HP JetDirect and click Continue.

9 In the Device URI for <Printer Name> window, specify the printer IP address in the following format:

   ```
   socket://<printer IP address>
   ```

   When ready, click Continue.

10 In the Make/Manufacturer for <Printer Name> window, select the manufacturer of your printer and click Continue.

11 In the Model/Driver for <Printer Name> window, select the model of your printer and click Add Printer.

12 Enter the root password when prompted.

CUPS performs the installation. If the installation is successful, the "Printer <name> has been configured successfully" message is displayed. Now you can use this printer to print documents from the virtual machine.
Managing Virtual Machines

Back up a Virtual Machine

Most people don't seriously consider regular backups as a necessity until they have experienced a significant data loss. You should create your own backup strategy to protect yourself from data loss. Virtual machines are as vulnerable to crashes as physical computers.

You can back up your virtual machine using one or several of the following methods:

- Configure the regular backup settings in the Backup pane (p. 186) of the Virtual Machine Configuration dialog.
- Use third-party backup utilities like Acronis True Image.
- Clone the virtual machine with the help of Clone Virtual Machine Assistant (p. 129). Give a descriptive name to the clone and save it in a location specially designated for backups.
- Copy the virtual machine files manually.

Configuring Regular Backups

In the Backup pane (p. 186) of the Virtual Machine Configuration dialog, you can choose how to back up your virtual machine regularly. You can configure how the virtual machine snapshots (p. 134) will be created or choose to back up the virtual machine with Time Machine.

If you choose to back up your virtual machine with Time Machine, your virtual machine's PVM file will be automatically backed up together with other files stored in Mac OS. As a consequence, files stored on your virtual machine's hard disk will be also backed up, since the virtual hard disk file (HDD) is stored inside the virtual machine bundle file (PVM).

Warning: Time Machine backups can guarantee safety only when your Parallels virtual machines were stopped or suspended during the backup.

If you want to restore some of your Windows files, do the following:

1. Locate the backup copy of your virtual machine's file (PVM).
2. Right-click the file, and choose Show Package Contents.

In the virtual machine contents window, right-click the virtual hard disk file (HDD) that is usually named <VirtualMachine'sName>.hdd and choose Open With > Parallels Mounter.

Using Parallels Mounter, browse the contents of your virtual machine's hard disk to find the files you need to restore.

For more information about Parallels Mounter, refer to Using Parallels Mounter.

Using Third-Party Backup Utilities
You can use any third-party backup utilities you like. Registered Parallels Desktop users can use Acronis True Image Home for free to back up their virtual machines. You can download this application from Parallels Download Center (http://www.parallels.com/download/).

**Cloning the Virtual Machine**

You can create a complete clone of the virtual machine using Clone Virtual Machine Assistant. For details, see [Cloning a Virtual Machine](p. 129).

**Copying the Virtual Machine Files**

You can locate your virtual machine in Finder and create a backup copy of the virtual machine file (PVM).

1. In the Parallels Virtual Machines list (p. 33), right-click the virtual machine name and select Show in Finder from the context menu. In Finder, go to the folder where your virtual machine is stored.

2. Locate the required virtual machine PVM file.

   **Note:** PVM file is a bundle that contains the virtual machine configuration file (PVS), virtual hard disk file (HDD), and other files. For more information about the virtual machine files, see [Parallels Virtual Machine](p. 14).

3. Copy the virtual machine's PVM file to a safe location.
Encrypting the Virtual Machine

Parallels Desktop allows you to protect your virtual machines from unauthorized use. If you store any important data in a virtual machine, you are highly recommended to encrypt the virtual machine and unauthorized users will have access neither to the virtual machine nor to its data.

Encrypting a Virtual Machine

To encrypt a virtual machine, follow these steps:

1. Make sure the virtual machine is shut down.
2. Choose **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog.
3. Go to the **Options** tab and click **Security**.
4. In the **Security** pane (p. 179), click **Turn On**, specify a password, and click **OK**.

**Warning!** The specified password is very important. You must record it. Without this password, you will not be able to launch the virtual machine.

After that, the virtual machine will be encrypted. To start the encrypted virtual machine, you will always have to enter the specified password.

Changing Password for an Encrypted Virtual Machine

To change password for an encrypted virtual machine, follow these steps:

1. Select the virtual machine (but do not start it!) and choose **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog.
2. Go to the **Options** tab and click **Security**.
3. In the **Security** pane (p. 179), click **Change Password**, specify a new password, and click **OK**.

Removing Encryption from a Virtual Machine

To remove encryption from a virtual machine, follow these steps:

1. Select the virtual machine (but do not start it!) and choose **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog.
2. Go to the **Options** tab and click **Security**.
3. In the **Security** pane (p. 179), click **Turn Off**.

Important Information

If you clone (p. 129) an encrypted virtual machine, the virtual machine clone will be also encrypted.

If you convert an encrypted virtual machine to a template (p. 130) and then deploy it to multiple virtual machines, the resulting virtual machines will be also encrypted.
If you have two virtual machines using the same virtual hard disk (.hdd file) and then you encrypt one of them, the other virtual machine will have no access to this hard disk.

If you encrypt a virtual machine with snapshots (p. 134) and then revert to any of its snapshots, the virtual machine will remain encrypted. To start this virtual machine, you will have to enter the password that you specified during the encryption procedure.

### Using Safe Mode

If you do not want a virtual machine to store the changes you make to it during the working session, you can start this virtual machine in Safe Mode. To be able to start the virtual machine in Safe Mode, you need to add the Safe Mode button to the Parallels Desktop toolbar first. To do this:

1. Right-click the toolbar in the virtual machine window and choose Customize Toolbar (p. 41).
2. Drag the Safe Mode button to the toolbar and click Done.

After you have added the Safe Mode button to the toolbar, you can use this button for starting the virtual machine in Safe Mode. If you shut down a virtual machine operating in Safe Mode, you will be asked whether you want to discard the changes made to the virtual machine hard disk or to apply them:

- If you choose to discard the changes, the virtual machine hard disk will be left intact and no changes made to it during your work in Safe Mode will be saved.
- If you choose to apply the changes, the virtual hard disk will keep all the changes made to it during your work in Safe Mode. After applying the changes, the virtual machine will not be able to return to the state it had before you started this virtual machine in Safe Mode.

If you want the virtual machine to permanently work in Safe Mode, you can enable the Undo Disks option in the Security pane (p. 179) of the Virtual Machine Configuration dialog:

1. Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration dialog.
2. Click the Options tab.
4. In this pane, select the Enable Undo Disk option and click OK.

**Usage Tip**

Running the virtual machine in Safe Mode can be useful when testing the behavior of some applications to make sure that they cannot damage your computer.
Cloning a Virtual Machine

An exact copy of a virtual machine can be created using Clone Virtual Machine Assistant. The clone is a separate virtual machine that includes as many virtual hard disks as were connected to the original machine. The assistant places the cloned virtual machine into a default folder, but you can specify a different folder.

In the virtual machine clone, the names of all the devices, drivers and virtual hard disk images remain the same as they were in the original machine. All connections between the devices in the cloned VM will be the same as in the original virtual machine.

If a device in the original machine was connected to an external resource, this device in the clone will be connected to the same resource. The only exception is serial/printer port log files. If such files are used by the original virtual machine, Parallels Desktop creates a new set of empty log files for the clone.

If the original virtual machine has a snapshot tree, the virtual machine clone will have the same structure of snapshots.

If a network adapter was enabled in the original configuration, Parallels Desktop generates a new Mac address for the clone.

You can also make a clone of a clone and give it a unique name. The resulting clone will have the same configuration and the same devices connected as the initial clone.

Unlike snapshots (p. 134), a virtual machine and its clones are used separately and there is no connection between them after the clones creation. If you need to delete the initial virtual machine, you can do it without any threat to its clones.

Before cloning a virtual machine, make sure that:

- The virtual machine is turned off. If the virtual machine is running, the Clone option in the File menu is disabled.
- The virtual machine has a guest OS. You cannot clone a virtual machine without a guest OS.

To make a clone of a virtual machine:

1. Open the virtual machine you want to clone.
2. From the File menu, select Clone. The Clone Virtual Machine Assistant window appears.
3. In the Name and Location window, specify the name and folder for the virtual machine clone. The name suggested by the assistant is made by adding "Copy of" to the original virtual machine name. You can specify another name but it should not be longer than 50 characters.

To specify the location for the virtual machine clone, click the More Options item and type the location in the Place virtual machine files to the folder field or use the Choose button to locate the virtual machine clone.
If you want to provide quick access to the virtual machine clone, select the **Create icon on Desktop** option located under the **Place virtual machine files to the folder** field.

To test the newly created virtual machine clone immediately after its creation, select the **Open copy in new window automatically** option.

Click **Clone** to start cloning the virtual machine.

4. The **Cloning Finished** window informs you that cloning has been completed successfully and that the new virtual machine is ready. Click **Done** to close the assistant.

**Working With Virtual Machine Templates**

Parallels Desktop makes your work with virtual machines even more convenient by enabling you to create templates of Parallels virtual machines.

A template, like a virtual machine, has hardware and can have operating system and software installed. The only difference is that it cannot be started. A template can be easily converted to an ordinary virtual machine and vice versa.

Using one template, you can create as many virtual machines as you need and the disk space of your Mac allows. These virtual machines will have the same hardware configuration, operating system, and software that the initial template has.

You can convert an existing virtual machine into a template or make a clone of the virtual machine that will be used as a template and continue using the original virtual machine.
Creating a Virtual Machine Template

If you need to create a number of virtual machines with the same configuration, you can create a virtual machine template and use it to create new virtual machines.

There are two ways of creating a virtual machine template:

- Convert an existing virtual machine into a virtual machine template.
- Clone an existing virtual machine to a virtual machine template.

If you choose to convert a virtual machine into a template, this virtual machine will change its operating system icon to a template icon in the list of virtual machines and it will be available as a template only. You will not be able to run it as a virtual machine.

If you do not want to convert a virtual machine into a template but need to make its copy with the same configuration, you can make a clone of this virtual machine that will be used as a template.

To convert an existing virtual machine into a template:

1. Launch Parallels Desktop.
2. Choose the virtual machine you want to convert into a template from the list of Parallels virtual machines (p. 33).
3. Choose Convert to Template from the File menu.
4. The virtual machine will become a template and will have a different icon indicating that it is a template.

To clone a virtual machine to a template:

1. Launch Parallels Desktop.
2. Choose the virtual machine you want to clone to a template from the list of Parallels virtual machines (p. 33).
3. Start Clone to Template Virtual Machine Assistant by choosing Clone to Template from the File menu.
4. In the Name and Location window, specify the name and location for the virtual machine template, and click Clone. You can use the Choose button to change the location.

By default, the virtual machine template files will be placed to the following folder on your Mac: /Users/UserName/Documents/Parallels/<Virtual Machine Template Name>/. 
5 In the **Creation Finished** window, click **Done** to quit the assistant.
Deploying a Virtual Machine Template

A virtual machine template cannot be run as a virtual machine. To be able to run it as a virtual machine, you should create a virtual machine that will have the same configuration as the template has.

There are two ways of creating a virtual machine from a template:

▪ Convert a template into a virtual machine.
▪ Deploy a template to a new virtual machine.

If you convert a virtual machine template into a virtual machine, its icon will be moved from the virtual machines list, and you will be able to use it as a virtual machine.

If you deploy a virtual machine template to a virtual machine, the Deploy Virtual Machine Template assistant will create a new virtual machine, but the template will not be removed from the Parallels Virtual Machines list (p. 33).

To convert a virtual machine template into a virtual machine:

1. Launch Parallels Desktop.
2. In the Parallels Virtual Machines list (p. 33), right-click the virtual machine template you want to convert into a virtual machine and choose Convert to Virtual Machine from the shortcut menu.
3. The virtual machine template will be processed into a virtual machine and will change its icon.

To deploy a virtual machine template to a new virtual machine:

1. Launch Parallels Desktop.
2. In the Parallels Virtual Machines list (p. 33), click the virtual machine template you want to be deployed to a virtual machine and click Create or right-click the template and choose Deploy to Virtual Machine from the shortcut menu. Deploy Virtual Machine Template Assistant will start.
3. In the Name and Location window, specify the name and location for the virtual machine and click Deploy. You can use the Choose button to change the location.
   
   By default, the virtual machine files will be placed to the following folder on your Mac: /Users/UserName/Documents/Parallels/<Virtual Machine Template Name>/. 

In the Deployment Finished window, click Done to close the assistant.

The resulting virtual machine will have the same configuration as the original template.

**Working With Snapshots**

A snapshot is a saved state of the virtual machine. Snapshots can be created manually or automatically when the virtual machine is running. After you make a snapshot, you can continue working with the virtual machine and revert to the created snapshot at any time of your work.

Snapshots are stored inside the virtual machine bundle (p. 14), in the Snapshots subfolder. Each snapshot has a number of files, including the .sav file that contains the virtual machine's state, the .mem file that contains the memory dump for the virtual machine, and other different files of the virtual hard disk.

**Note:** Snapshots are not backup copies or clones (p. 129) of your virtual machine. You cannot use them alone without your virtual machine or move them from the virtual machine bundle.

You may need to make snapshots in the following cases:

- If you are configuring software that requires a lot of settings, you may want to explore the settings functions before selecting them. For testing the settings, create snapshots at branching points.
- If you want to mark milestones in the development process. If something goes wrong, you can always revert to the previous state or create a branch of snapshots starting with the particular milestone snapshot.

**Note 1:** Snapshots cannot be created for virtual machines that use the Boot Camp partition.

**Note 2:** If a virtual machine has one or more snapshots, you can neither compress (p. 202) nor resize (p. 202) its virtual hard disk.
Making Snapshots

Snapshots can be created manually or automatically using SmartGuard (p. 186).

Note: You cannot create a snapshot manually or automatically or revert to a snapshot when your virtual machine is paused.

To make a snapshot manually:

1. Make sure that you completed all operations of installing, downloading, or writing to external devices before taking a snapshot.

   Note: You can create a snapshot at any time. But it is recommended to complete all operations of installing, downloading, or writing to external devices before taking a snapshot. You should also complete or cancel any transactions performed via the virtual machine in external data bases.

2. Choose Take Snapshot from the Virtual Machine menu or use the Take Snapshot button on the toolbar of your virtual machine's window. If the toolbar does not contain this button, you can add it to the toolbar. For more information, refer to the Customizing Toolbar section (p. 41).

   Note: To make a snapshot, you can also use Snapshot Manager. Just open the manager by choosing Manage Snapshots from the Virtual Machine menu and click the New button. A new snapshot will be created.

3. In the Snapshot Parameters window, you can provide a name and a short description for the snapshot. This information and the date of creation will be visible in Snapshot Manager when the pointer hovers over the snapshot icon.
4 Click OK to take a snapshot.

After the snapshot is created, you can continue working with your virtual machine's current state or use any of its snapshots.

To revert to a snapshot, open Snapshot Manager by choosing Manage Snapshots from the Virtual Machine menu or by clicking the Manage Snapshots button on the toolbar of the virtual machine window.

To create snapshots automatically, configure the SmartGuard settings (p. 186).
Managing Snapshots

You can use Snapshot Manager to revert to a specific snapshot, as well as to manage the snapshots. To open Snapshot Manager:

- Choose Manage Snapshots from the Virtual Machine menu; or
- Click the Manage Snapshots button on the toolbar of the virtual machine window.

**Note:** To add this button to the toolbar, you should customize it. To learn how to do that, refer to the Customizing Toolbar section (p. 41).

Using Snapshot Manager, you can:

- Create new snapshots and delete the unused ones;
- View the snapshot tree of a particular virtual machine; and
- Select a snapshot to which you want to revert.

**Note:** You cannot create a snapshot manually or automatically or revert to a snapshot when your virtual machine is paused.
The **Virtual Machine Snapshots** window consists of the following areas:

- The snapshots tree pane.
- The snapshots management pane.

### Snapshots Tree Pane

Snapshot icons appear as screen shots of the guest OS window if the virtual machine was running at the time you created a snapshot.

The left icon with a flag is the *root* of the snapshots tree - it is the initial state of the virtual machine used as the reference point. You cannot delete the root icon. The root icon is visible if at least one snapshot exists. If you want to delete a snapshot which is parental for some other snapshots, you can decide whether to delete only this snapshot or delete it with all the subsequent snapshots.

All snapshots in the snapshots tree are descendants of the *root* state of the virtual machine. The first snapshot contains "differences" with respect to the root state. The second successive snapshot contains differences with respect to the first snapshot. You may want to return to one of the previous snapshots and work with it. If you then create a new snapshot, a new snapshots branch will be created.

When the pointer is hovered over an item, you will see a tooltip message with a short description.

### Snapshots Management Pane

The snapshots management pane includes the buttons necessary for managing the snapshots.

- The **New** button. Click this button to create a new snapshot for the present state of your virtual machine.
- The **Go To** button. Select the snapshot you want to go to in the snapshots tree and click this button to move from the present state of your virtual machine to the state saved in this snapshot.

**Note:** Before you go to a specific snapshot, decide what you want to do with the current state of the virtual machine - by default, it will not be saved. To retain the changes made since the last snapshot, make a new snapshot.

- The **Delete** button. Select the snapshot you want to delete and click this button. If you delete an intermediate snapshot, the information it contains will be merged into the subsequent snapshot.

**Note:** You cannot delete the *root* icon. It disappears only when you delete all snapshots in the tree.

You can also manage snapshots by right-clicking them in the tree:

- If you right-click the icon that shows the present state of the virtual machine, you can create a new snapshot for this state.
- If you right-click any other intermediate snapshot, you can choose to go to it, to delete it alone or with all the subsequent snapshots, or to edit its name and description.

### Going to a Snapshot
1 Launch Parallels Desktop and open a virtual machine.

2 Open Snapshot Manager by:
   - Choosing Manage Snapshots from the Virtual Machine menu; or
   - Clicking the Manage Snapshots button in the toolbar of the virtual machine main window.

3 In the Virtual Machine Snapshots window, choose the snapshot and click the Go To button. You can also right-click the snapshot and choose Go to Snapshot from the shortcut menu or just double-click the snapshot.

   **Note:** If, after the Parallels Desktop update, you decided to revert to one of the snapshots made before the update, you will see the message that a new Parallels Tools update is available. We recommend you to install them to work effectively with the virtual machine.

4 If you revert to a snapshot from an unsaved state of the virtual machine, you will see the notification about that. Click Yes if you want to proceed without saving the state. Click No if you want to save the state and then go to the needed snapshot.

   If you want to revert to the previous snapshot made on the same branch of snapshots, use the Revert To Snapshot option from the Virtual Machine menu or from the virtual machine main window toolbar. If you want to know specifically to which snapshot you will revert, you can always see your snapshots tree in Snapshot Manager (p. 137).

   **Note:** If you revert to the previous snapshot from an unsaved state of the virtual machine, you will see the notification about that. Click Yes if you want to proceed without saving the state. Click No if you want to save the state and then revert to the snapshot.

After reverting to a snapshot, it is recommended to update Parallels Tools in the virtual machine.

### Deleting a Snapshot

1 Launch Parallels Desktop and choose a virtual machine.

2 Open Snapshot Manager by:
   - Choosing Manage Snapshots from the Virtual Machine menu; or
   - Clicking the Manage Snapshots button in the toolbar of the virtual machine window.

3 Select the snapshot you want to delete and click the Delete button if you want to delete only this snapshot. If you want to delete all the snapshots that come after it, right-click the snapshot and choose the Delete Snapshot with children option.

   If you delete an intermediate snapshot, the information it contains will be merged into the snapshot that follows it.

   **Note:** You cannot delete the root icon, but it gets automatically deleted after you delete all the other snapshots.

### Merging Snapshots

Merging is performed automatically when you delete any snapshot except the last one in the branch. When you delete an intermediate snapshot, the information it contains is merged into the next snapshot of the same branch.
If you delete the snapshot belonging to two branches, the information is merged into the next snapshot of each branch.

**Note:** If you delete the snapshot that comes after the root icon and that belongs to two branches, the branches will start directly from the initial state icon.

### Managing Virtual Machines Using Spoken Commands

Parallels Desktop allows you to use spoken commands for managing the virtual machine behavior. The following spoken commands are available:

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Starts a virtual machine.</td>
</tr>
<tr>
<td>Suspend</td>
<td>Suspends a virtual machine.</td>
</tr>
<tr>
<td>Shut Down</td>
<td>Shuts down a virtual machine.</td>
</tr>
<tr>
<td>Pause</td>
<td>Pauses a virtual machine.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops a virtual machine.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets a virtual machine.</td>
</tr>
<tr>
<td>Snapshot</td>
<td>Opens the <strong>Snapshot Manager</strong> window.</td>
</tr>
<tr>
<td>Make Screenshot</td>
<td>Makes a screenshot of the Guest OS window and stores it on the Mac OS X Desktop.</td>
</tr>
<tr>
<td>Make Clip</td>
<td>Makes a clip.</td>
</tr>
<tr>
<td>Switch to Coherence</td>
<td>Switches to the Coherence view mode.</td>
</tr>
<tr>
<td>Switch to Full Screen</td>
<td>Switches to the Full Screen view mode.</td>
</tr>
<tr>
<td>Switch to Window</td>
<td>Switches to the Window view mode.</td>
</tr>
<tr>
<td>Edit Configuration</td>
<td>Opens the <strong>Virtual Machine Configuration</strong> dialog.</td>
</tr>
<tr>
<td>New</td>
<td>Creates a new virtual machine.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens a virtual machine.</td>
</tr>
<tr>
<td>About Parallels Desktop</td>
<td>Opens the About Parallels Desktop menu.</td>
</tr>
<tr>
<td>Install Parallels Tools</td>
<td>Launches the installation of Parallels Tools in the running virtual machine.</td>
</tr>
<tr>
<td>Report a Problem</td>
<td>Opens the <strong>Parallels Problem Report</strong> window.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens an existing virtual machine and registers it in Parallels Desktop.</td>
</tr>
<tr>
<td>Open Directory</td>
<td>Opens the <strong>Parallels Virtual Machines</strong> window.</td>
</tr>
</tbody>
</table>

To enable the speech commands, select **Enable spoken commands** in the **Advanced** pane (p. 53) of Parallels Desktop Preferences and, if necessary, tune the speech settings on the corresponding tab of Mac OS X System Preferences.
Managing Virtual Machines from Parallels Mobile

Parallels Mobile allows you to remotely access your Parallels Desktop virtual machine and its applications from your iPad, iPhone or iPod touch.

Parallels Mobile lets you:
- access any virtual machine running in Parallels Desktop 6 for Mac
- use any Windows application in your virtual machine, from Internet Explorer to Outlook
- remotely start, stop and reset virtual machines
- stay connected via WiFi or 3G networks
- access your Windows applications from anywhere over the Internet
- optimize for either speed or graphics performance

Configuration instructions

Before installing Parallels Mobile, make sure your copy of Parallels Desktop is registered, and you have at least one virtual machine with an operating system and Parallels Tools installed.

1. In Parallels Desktop 6 for Mac, choose Parallels Desktop > Preferences, click Mobile, and log in to your Parallels account using the email you provided when registering Parallels Desktop.

2. Leave your Mac powered on to be able to connect to it from Parallels Mobile.

3. Download Parallels Mobile from the App Store and install it on your iPad, iPhone, or iPod touch.

4. Open Parallels Mobile and log in to your Parallels account using the email and password you used to register your copy of Parallels Desktop.

5. Your Mac will appear in the list of available Macs. Tap it to access your virtual machines.

Working with Your Virtual Machine

1. To begin a remote virtual machine session, select a Mac where the virtual machine is located and then tap the virtual machine name. This will open the virtual machine screen.

2. When you open the virtual machine for the first time, you will see the **Tips** screen that provides a basic information about gestures that can be used during the remote session. Tap the **Close** button to close the **Tips** screen and go to the virtual machine screen.

3. Depending on whether the virtual machine is running or stopped, you will see one of the following:
   - If the virtual machine is running on your Mac, its desktop will be shown in the virtual machine and you can start working with it immediately. The screen may stay black for a few seconds before the virtual machine desktop is displayed. This is needed to properly synchronize the virtual machine and the Parallels Mobile application.
   - If the virtual machine is not running, you will see a large icon in the middle that looks like the “play” pictogram.

Once you see the virtual machine desktop, all the changes that happen to it will be displayed on your mobile device screen in real time. You can control the virtual machine using the virtual keyboard and gestures.
For more information about using Parallels Mobile, please refer to the Parallels Mobile User's Guide, available on our website.

Removing a Virtual Machine

Removing a Virtual Machine from the List

If you do not need one of your virtual machines, you can remove it from the Parallels Virtual Machines list (p. 33). You will be able to add it back to the list (p. 70) later.

To remove a virtual machine from the list, stop it if it is running and do one of the following:

- Drag the virtual machine from the Parallels Virtual Machines list.
- Right-click the virtual machine name in the Parallels Virtual Machines list (p. 33) and choose Remove from the context menu. In the displayed window, click Keep File.

Deleting a Virtual Machine from Your Mac

To delete a virtual machine from your Mac permanently, stop it if it is running and do one of the following:

- Right-click the virtual machine name in the Parallels Virtual Machines list (p. 33) and choose Remove from the context menu. In the displayed window, click Move to Trash.
- Delete its files from the disk manually. The virtual machine files are stored in the /Users/<Username>/Documents/Parallels/ folder or in the /Users/Shared folder by default. Each virtual machine is represented by a single PVM file.

Warning! Before deleting the virtual machine, make sure that none of the virtual machine files (like virtual hard disk) are used by other virtual machines.
Parallels Desktop provides a number of features that ensure better integration between Mac OS X and your virtual machine.

The first step in integrating your virtual machine with Mac OS X is the installation of Parallels Tools (p. 74) in your virtual machine. Parallels Tools are a set of utilities that provide basic integration of Mac OS X and virtual machines. Parallels Tools are available for Windows, Linux, and Mac OS X guest operating systems.

For Windows virtual machines, Parallels Tools also provide a set of advanced integration features that make your work with Mac OS and Windows even more coherent. These features include Coherence, Shared Applications, and others.

In This Chapter

- Working in Coherence ................................................................. 144
- Working in Full Screen .............................................................. 151
- Using the MacLook Theme in Windows .......................................... 152
- Sharing Applications and Files ....................................................... 154
- Browsing Virtual Hard Disks in Finder ........................................... 167
- Copying and Pasting Between Mac and Windows ......................... 168
- Enabling Parental Control in a Virtual Machine ......................... 169
Working in Coherence

Coherence is a visual mode of working with Windows virtual machines. This mode provides the highest level of integration between Mac OS X and the guest operating systems.

You may find Coherence especially useful when you want to work with the virtual machine applications side by side with your Mac OS X applications. The point is that if you switch a virtual machine with one or more running applications to Coherence, the virtual machine will disappear and you will see only the windows of these applications on the background of your Mac OS X desktop. Now if you start one or more Mac OS X applications, you will be able to switch between the windows of Mac OS X applications and windows of the guest OS applications as if the later were also Mac OS X applications.
To switch a virtual machine to Coherence, do one of the following:

- Click the **Coherence** button in the Parallels Desktop toolbar;
- Choose **Coherence** from the **View** menu;
- Use the appropriate hot key combination (Ctrl+Cmd+Return by default); or

**Note:** The default hot key combinations can be configured in the **Keyboard** pane (p. 45) of the **Preferences** dialog.

- Click the **Coherence** button in the virtual machine status bar.

You can also configure your virtual machine to always start in Coherence by editing the **Startup and Shutdown** settings (p. 174) in the **Virtual Machine Configuration** dialog.

To switch the virtual machine from Coherence to another view mode:

- Click the **View** menu and choose the view mode to which you want to switch your virtual machine;
- Use the appropriate hot key combination (Ctrl+Cmd+Return by default); or
- Right-click the Parallels Desktop icon in the Dock, point to the **View** item, and choose the view mode to which you want to switch your virtual machine.

When you work in Coherence, you can use the following features to make your work more efficient:

- Use the Dock to open Windows guest OS applications;
- Leave the Windows taskbar visible on the Mac OS X desktop when the virtual machine window disappears;
- Use Mac OS X applications to open your Windows guest OS files and vice versa;
- Use the Windows applications folder available in the Dock to start the applications installed in the Windows guest OS;
- Use the Trash in Mac OS X to remove your Windows guest OS files;
- Use Mac OS X Application Switcher to switch between your running Mac OS X and Windows guest OS applications;
- Use Mac OS X Expose to navigate between the windows of the Mac OS X and Windows guest OS applications; and
- Move the windows of your Windows guest OS applications from one display to another (if you have more than one display).

### Using the Dock in Coherence

You can open Windows guest OS applications directly from the Dock by clicking their icons. As you start a Windows application, its icon appears in the Dock. When you close the application or shut down the virtual machine, the application icon disappears from the Dock.

To keep the icon in the Dock:

1. Right-click (Control-click) the Windows application icon in the Dock.
2. Choose **Keep in Dock** from the shortcut menu.

Clicking a Windows application icon in the Dock starts the virtual machine and the application in it. The virtual machine is automatically switched to Coherence.
Using the Windows Taskbar

By default, both Windows taskbar and Mac OS X Dock are visible. You can use any of the Windows taskbar elements right from Mac OS X Desktop. You can hide the Windows taskbar by choosing View > Hide Windows Taskbar. When the Windows taskbar is hidden, it is convenient to use the Start button icon in the Dock. If you click this icon, the Windows Start menu appears. To display this icon, select the Use Start button icon in Coherence option in the Parallels Desktop general preferences (p. 42).

Sharing your Windows and Mac applications

You can use Mac OS X applications to open the files in your Windows guest OS and vice versa. The list of Parallels Shared Applications is created during the Parallels Tools installation. This list includes your Mac OS X applications and is available when you choose All Programs > Parallels Shared Applications from the Windows Start menu. You can select any application from the list and start it.

Right-click a file in Mac OS X or Windows and choose any available Mac OS X or Windows application from the Open With list.

Note: To share your Mac OS X and Windows applications, you need to disable the Isolate Mac from Windows option in the Security pane (p. 179) of the Virtual Machine Configuration dialog.

Windows Applications Folder in the Dock

If you selected the Show Windows applications folder in Dock option in the Applications pane of the Virtual Machine Configuration dialog, the folder with all applications installed in your Windows virtual machine will be displayed in the Dock. You can use this folder to quickly access your Windows applications.
Using Mac OS X Trash

You can remove files and folders that you do not need any more by simply dragging them from your virtual machine to the Trash in Mac OS X. After a file or folder is removed, it is automatically placed to Windows Recycle Bin and can be viewed by choosing **Windows Recycle Bin** from the **View** menu. You can then restore the file/folder by right-clicking it and selecting **Restore**. If you wish to empty the Recycle Bin contents, choose **Empty Windows Recycle Bin** from the **File** menu.

Using Application Switcher

You can switch between any of the running Mac OS X and Windows applications by using Application Switcher.

1. While holding down the Command key on the keyboard, press Tab. You will see the Application Switcher bar across the desktop with all applications running in both Windows and Mac OS X.

2. Select the application by clicking its icon in the bar.

Using Expose With Your Windows Applications

When working in Coherence, you can use Expose to navigate between the windows of the Mac OS X and guest OS applications opened on your desktop. To activate Expose, press the F9 key (on portable Macintosh computers, use the Fn+F9 key combination instead).

If the F9 key does not activate Expose, refer to Mac Help for information about changing the Mac OS X shortcuts.

Sharing Windows System Tray Icons With Mac OS X

When you are working with a Windows virtual machine in the Coherence view mode or its variation - Crystal (p. 148) - you may need to manage the guest operating system or its applications using the icons from the Windows notification area. Parallels Desktop 6 allows you to display these icons in the Mac menu bar which makes it easier to access them. To make the icons available in the Windows notification area also available in the Mac menu bar, select **Show Windows notification area in menu bar** in the Coherence pane (p. 188). For Windows 7 virtual machines with this option enabled and working in Coherence, Windows notification area icons are available in the following menu:
To open this menu, click the down-pointing white triangle.

If you click Customize in the menu or click the white triangle when there are no notification area icons in the Windows 7 guest OS, you will be able to specify what icons you want to be displayed and how they will be displayed.

**Using Windows 7 Jump Lists in Coherence**

When you are working with a Windows 7 virtual machine in the Coherence view mode or its variation - Crystal (p. 148) - you can view the Jump List for an application that is currently running in Windows 7 by right-clicking this application's icon in the Dock and choosing Show Jump List. To open an item on the Jump List, click the specific item.

**Note:** If an application is running in the guest operating system but the application's icon does not appear in the Dock, make sure the Share Windows applications with Mac option is enabled in the Applications pane (p. 184) of the Virtual Machine Configuration dialog.

**Crystal Mode**

The Crystal view mode is a variation of the Coherence mode (p. 144). Crystal provides even higher level of integration between the host and the guest operating systems. In this mode, all Parallels Desktop controls, icons, and menus are hidden, except for the Parallels icon in the Mac menu bar.

**Parallels Menu Bar Icon**

This icon is used to control your virtual machine and Parallels Desktop while in the Crystal view mode.

- **Click** this icon to open a basic menu. It allows you to access the Windows Start menu, manage the virtual machine devices, return to the Window view mode by choosing Exit Coherence, quit Parallels Desktop, and to switch between the running virtual machines.

- **Right-click** this icon to open the Windows start menu.

- **Alt-click** (or Option-click) this icon to open an extended menu. The extended menu includes additional options, including Report a Problem, Configure, Preferences, and many others.
Switching to the Crystal Mode

Only a running Windows virtual machine with Parallels Tools (p. 74) installed can be switched to the Crystal view mode. To switch your virtual machine to the Crystal view mode, do one of the following:

- If your virtual machine is shut down, choose Use Crystal mode in the Coherence pane (p. 188) of the Virtual Machine Configuration dialog. Then start this virtual machine and when the guest operating system boots up, switch it to the Coherence view mode (p. 144). The virtual machine will be switched to the Crystal variation of the Coherence view mode.

- If your virtual machine is running, choose Use Crystal mode in the Coherence pane (p. 188) of the Virtual Machine Configuration dialog and click OK to save the changes. Then switch the virtual machine to the Coherence view mode (p. 144) and it will be switched to the Crystal variation of the Coherence view mode.

- If your virtual machine is already running in the Coherence view mode, choose Use Crystal mode in the Coherence pane (p. 188) of the Virtual Machine Configuration dialog and click OK to save the changes. The virtual machine will be switched to the Crystal variation of the Coherence view mode.

- If you want your virtual machine to always start in the Crystal variation of the Coherence view mode, open the Virtual Machine Configuration dialog (p. 170) and do the following:
  1. In the Coherence pane (p. 188), choose Use Crystal mode.
  2. In the Startup and Shutdown pane (p. 174), choose Coherence from the Startup view menu.
  3. Click OK to save the changes.
After that, the virtual machine will be started in the Crystal variation of the Coherence view mode every time you start this virtual machine.

To switch the virtual machine from Crystal to the Window mode, click the Parallels icon in the Mac menu bar and select the Exit Coherence option.

**Note:** You can switch from Crystal to the Window mode only. You can then switch from Window to any other view mode (p. 93).

### Using Mac OS X Shortcuts

When your virtual machine is switched to Crystal, you can use Mac OS X keyboard shortcuts when working with the guest OS applications:

<table>
<thead>
<tr>
<th>Actions</th>
<th>Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>To close the active window of the running application</td>
<td>Cmd + W</td>
</tr>
<tr>
<td>To close all windows of the active application</td>
<td>Cmd + Q</td>
</tr>
<tr>
<td>To switch between the windows of the active application</td>
<td>Cmd + `</td>
</tr>
<tr>
<td>To hide the window(s) of the active application</td>
<td>Cmd + H</td>
</tr>
<tr>
<td>To minimize the active window of the running application</td>
<td>Cmd + M</td>
</tr>
<tr>
<td>To hide all windows that doesn't belong to the active application</td>
<td>Cmd + Opt + H</td>
</tr>
</tbody>
</table>
## Working in Full Screen

In the Full Screen mode, the guest operating system window occupies the whole screen and all Mac OS X and Parallels Desktop controls are hidden.

**Note:** You can change the virtual machine view mode only when the virtual machine is running.

To switch to the Full Screen mode, do one of the following:

- Click the **Full Screen** button in the Parallels Desktop toolbar
- Choose **Full Screen** from the **View** menu
- Use the appropriate hot key combination (Alt+Cmd+Return by default) or

  **Note:** The default hot key combinations can be configured on the **Keyboard** pane (p. 45) of the **Preferences** dialog.

- Click the down arrow button near the **Coherence** button in the virtual machine status bar and choose **Full Screen** from the menu

If you want your virtual machine to use all available displays in the Full Screen mode, select **Use All Displays in Full Screen** from the **View** menu.

**Note:** All Mac OS X and Parallels Desktop controls are hidden when your virtual machine is working in the Full Screen view mode. If you want them to appear, press Ctrl+Alt.

To switch the virtual machine from Full Screen to another view mode:

- Press the appropriate hot key combination (Alt+Cmd+Return by default);
- Press Ctrl+Alt to display the Parallels Desktop menus, click the **View** menu, and choose the view mode to which you want to switch your virtual machine; or
- Press Ctrl+Alt to display the Dock, right-click the Parallels Desktop icon in the Dock, point to the **View** item, and choose the view mode to which you want to switch your virtual machine.

To set active screen corners or change other Full Screen options, go to the **Full Screen** pane (p. 190) of the **Virtual Machine Configuration** dialog.

### Setting a Restriction on Switching From Full Screen

In the **Security** pane (p. 179) of the **Virtual Machine Configuration** dialog, you can set a restriction on switching from the Full Screen mode. If you select the **Exit full screen mode** option in this pane, you will have to provide your administrator password each time you want to exit Full Screen.

To edit the security settings of your virtual machine:

1. Select **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog.

2. Select the **Options** tab and go to the **Security** pane.
Hiding Parallels Desktop and all its windows in Full Screen.

When you are working with a virtual machine in the Full Screen mode and any Mac OS X application simultaneously, the easiest way to switch between the guest and host operating systems is to use the F6 shortcut. Pressing F6 hides Parallels Desktop and all its windows. You can use the same shortcut to make them visible again.

**Note 1:** To be able to use the F6 shortcut, make sure the Enable Mac OS X system shortcuts option is enabled in the Keyboard pane (p. 45) of Parallels Desktop Preferences.

**Note 2:** F6 is the default shortcut for hiding/showing Parallels Desktop. You can set another shortcut for these actions in the Keyboard pane (p. 45) of Parallels Desktop Preferences.

Using the MacLook Theme in Windows

Parallels Desktop allows you to apply the MacLook theme to your Windows virtual machines. This theme is a predefined set of icons, fonts, colors, and other elements that makes the Windows guest OS look like Mac OS X.
You can apply MacLook to your virtual machine provided that:

- The virtual machine is running either the Windows XP (32-bit) or Windows Vista (32/64-bit) or Windows 7 (32/64-bit) guest operating system.
- You are logged in to the guest operating system as an administrator.
- Up-to-date Parallels Tools (p. 74) are installed in the virtual machine.
- Parallels Desktop is activated with a permanent activation key.

**Applying MacLook to a Virtual Machine**

If you did not use MacLook in your Windows virtual machine before, first you need to install it. To install MacLook in a virtual machine, do the following:

1. Choose **Use MacLook** from the **View** menu. The MacLook installation will start.

   **Note:** The virtual machine must be connected to the Internet.

2. In the first window, click **Next**.

3. In the **License Agreement** window, carefully read the license agreement. Select **I accept the terms of the license agreement** if you agree with its terms and conditions. When finished, click **Next**.

4. In the **Destination Folder** window, you can accept the default location or click **Change** and choose another folder where the files will be installed. When finished, click **Next**.

5. Once the installation is complete, select **Run Stardock MyColors now** and click **Finish**.

Now the MacLook theme is enabled and it will automatically be applied to all view modes (p. 93).

If you want to disable MacLook, click the **View** menu and clear the **Use MacLook** option. If you disable MacLook and then want to enable it again, choose **Use MacLook** from the **View** menu. Already installed, it will be easily applied to your virtual machine.
Sharing Applications and Files

Sharing Folders and Disks

A shared folder is a folder on your Mac that can be accessed from your virtual machine. Such folders can be used for exchanging files between the primary OS (Mac OS X) and the virtual machine or between several virtual machines. You can also share the Windows virtual machine disk volumes with Mac OS X - they will be mounted on the Mac OS X Desktop.

In the operating system, where a shared folder resides, it appears as a usual folder, while in the virtual machine, with which it is shared, it appears as a network shared folder.

A shared folder or volume resides on the computer (host computer or a virtual machine) from which it initially belonged. This means a shared folder or volume occupies space on the hard disk of the computer or virtual machine it originally belonged to.

Using shared folders is possible in the guest operating systems with Parallels Tools (p. 75) installed.

Setting up a shared folder requires three steps:

1. Make sure that Parallels Tools are installed in your guest OS. See Installing Parallels Tools (p. 74) for detailed descriptions on how to install Parallels Tools in a particular guest OS.

2. Make sure that the Isolate Mac from Windows (or Isolate Mac from Linux for Linux virtual machines) option is disabled in the Security pane (p. 179) of the Virtual Machine Configuration dialog.

3. Add a shared folder(s) to your virtual machine configuration.

Adding a Shared Folder

1. Start Parallels Desktop and open a virtual machine.

2. Open the Virtual Machine Configuration dialog by doing one of the following:
   - Choose Configure from the Virtual Machine menu; or
   - Click the Configure button on the toolbar of the virtual machine window.

3. In the Virtual Machine Configuration dialog, click the Options tab and select Sharing.

4. In the Sharing pane, click the Edit button. The User-defined Mac folders window will appear.

5. In this window, click the Add button, then choose the folder you want to share with the virtual machine and click Choose.

6. The selected folder will appear in the User-defined Mac folders window.
Integrating Mac OS and Virtual Machine
After you shared a Mac OS X folder with your virtual machine and this folder appeared in the **User-defined Mac folders** window, you can:

- Disable this folder sharing by clearing the **On** option.
- Change the folder name that will be displayed in your guest OS by double-clicking the folder name in the **Name** column and specifying another name.
- See what Mac OS X folder is shared with your virtual machine in the **Path** column.
- Restrict writing to this folder by clicking **Read & Write** in the **Permissions** folder and choosing **Read only**.

7 Click **OK** in the **User-defined Mac folders** window and then click **OK** in the **Virtual Machine Configuration** dialog to save the changes and quit.

8 Now you can start your virtual machine and view the shared folders in the guest OS.

### Viewing Shared Folders in Windows Guest OS

1 After you have shared a Mac OS X folder with your Windows virtual machine, start the virtual machine. When the guest OS boots up, you will see the Parallels Shared Folders shortcut on the Windows desktop.

2 Double-click this shortcut. The `\\.psf` directory will open where all your shared folders are stored.

**Note:** To be able to save files to a shared folder from inside the virtual machine, make sure this folder writing permissions are not set to **Read only**.

### Viewing Shared Folders in Linux Guest OS

1 After you have shared a Mac OS X folder with your Linux virtual machine, start the virtual machine.

2 Shared folders will be automatically mounted to the `/media/psf` or `/mnt/psf` directory upon the virtual machine start.

### Sharing Windows Disks to Mac OS

If you want to access your Windows virtual machine volumes from Mac OS X, you can enable inverse sharing. To do this:

1 Start Parallels Desktop and open your Windows virtual machine.

2 Open the **Virtual Machine Configuration** dialog by doing one of the following:

- Choose **Configure** from the **Virtual Machine** menu; or

- Click the **Configure** button on the toolbar of the virtual machine window.

3 In the **Virtual Machine Configuration** dialog, click the **Options** tab and select **Sharing**.

4 Select the **Access Windows folders from Mac** option to enable access to all virtual disks and partitions available in the virtual machine from your Mac. You will be able to find the virtual machine disks in the virtual machine PVM bundle. Locate the virtual machine bundle in Finder, right-click its name, select **Show Package Contents** from the context menu, and open the Windows Disks folder.
Note: By default, virtual machines' bundles are stored in the /Users/<Username>/Documents/Parallels/ folder or in the /Users/Shared folder. To locate the virtual machine bundle, right-click its name in the Parallels Virtual Machines list and select Show in Finder from the context menu.

5 You can also select Mount virtual disks to Mac desktop to mount the shared virtual hard disks to your Mac OS X desktop. After you enable this option, the virtual machine volumes will be accessible from the Mac OS X desktop where they will appear as connected volumes.

Windows network shares cannot be mounted.

Note: If the virtual machine's volumes are not mounted on Mac OS X desktop, go to Finder > Preferences > General and make sure that the Connected servers option is selected.

For more information about accessing the virtual machine disks from Mac OS, see Browsing Virtual Hard Disks In Finder (p. 167).

Working With Shared Files and Folders

Parallels Desktop allows you to open some files, located in the virtual machine shared folders, in Mac OS X applications. It may become useful if, for example, you cannot open a file in the virtual machine applications. Just right-click the file in the virtual machine and choose Open on Mac from the context menu. For example, if you right-click a .txt file and select this command, the file will be opened in the TextEdit application.

Parallels Desktop also allows you to show the files and folders, located in the virtual machine shared folders, in Finder. It may become useful if you want to perform various actions on the object, for example, to apply color to it. To display a file or folder in Finder, right-click it and choose Show in Finder from the context menu.
Using Shared Profile

Parallels Desktop provides close integration between your Mac OS and Windows guest OS. Now you can access certain Mac Home folders directly from Windows and vice versa. To use this functionality, you should have Parallels Tools (p. 74) installed in the virtual machine and the Isolate Mac from Windows option disabled in the Security pane (p. 179).

Note: To enable the Shared Profile functionality, you must share all Mac disks or at least your Mac Home folder. You can configure the necessary sharing settings in the Sharing pane (p. 181). If neither Mac disks nor Mac Home folder is shared with the virtual machine, select Redirect Windows user folders to Mac in the Sharing pane (p. 181), click OK and then Continue. Mac OS X Home folder will be automatically shared with the virtual machine and Shared Profile enabled.

If you activate the Shared Profile functionality by selecting Redirect Windows user folders to Mac in the Sharing pane (p. 181), you can click Configure below this option and specify the following options:

- Select Desktop to use the Mac desktop as the desktop in your Windows guest OS.
- Select Documents to use the Documents folder on your Mac as the My Documents folder in your Windows guest OS.
- Select Pictures to use the Pictures folder on your Mac as the My Pictures folder in your Windows guest OS.
- Select Music to use the Music folder on your Mac as the My Music folder in your Windows guest OS.
- Select Movies to use the Movies folder on your Mac as the My Videos folder in your Windows guest OS. (for Windows XP/Vista/7 only)
- Select Downloads to use the Downloads folder on your Mac as the Downloads folder in your Windows guest OS. (for Windows Vista/7 only)

Warning: If you delete any Mac OS X file from the Windows desktop when the Mac OS X desktop sharing is enabled, you will not be able to find this file in Mac OS X Trash or Windows Recycle Bin. The file will be deleted from your computer permanently.

When Shared Profile is enabled, the virtual machine desktop will display the icons present on Mac OS X Desktop, the My Documents folder will contain items stored in the Documents folder on your Mac. The other folders will behave in a similar way.

To enable and configure Shared Profile, use the Sharing pane of the Virtual Machine Configuration dialog.

Disabling Shared Profile

You can disable Shared Profile either by clearing the Redirect Windows user folders to Mac option in the Sharing pane (p. 181) or by disabling Mac folders sharing at runtime (p. 102) or in the Virtual Machine Configuration dialog.
Using Shared Applications

You can use Mac OS X applications to open the files in your Windows guest OS and vice versa.

**Note:** To share your Mac OS X and Windows applications, you need to disable the *Isolate Mac from Windows* option in the *Security* pane (p. 179) of the virtual machine configuration.

**Using Mac OS X Applications in Windows Guest OS**

The list of Parallels Shared Applications is created during the Parallels Tools installation. The list includes your Mac OS X applications and is available when you choose *All Programs > Parallels Shared Applications* from the Windows *Start* menu. You can select any application from the list and start it. To use this functionality, enable the *Share Mac applications with Windows* option in the *Applications* pane.

To open a Windows file with the Mac OS X application you prefer, right-click the file and choose the application from the *Open With* list.

**Using Windows Applications in Mac OS X**

You can create a list of Windows applications in Mac OS X and run them even when the virtual machine is stopped. If you start a Windows application when the virtual machine is stopped, the virtual machine will automatically start and switch to Coherence (p. 144).

To open a file with the application you prefer, disregarding which operating system this file or application belongs, right-click the file and choose the application from the *Open With* list. To open a Mac OS X file in a virtual machine application, you can drag this file to this application icon on the Windows desktop.

If you selected the *Show Windows applications folder in Dock* option in the *Applications* pane of the *Virtual Machine Configuration* dialog, the folder with all applications installed in your Windows virtual machine will be displayed in the Dock. You can use this folder to quickly access the needed Windows application.
You can also create aliases for your favorite Windows applications on Mac OS Desktop and add their icons to the Dock.

To create an alias for the application and add its icon to the Dock:

1. Start your Windows virtual machine.
2. Start any of your favorite Windows applications in the virtual machine. When the application is started, its icon will appear in the Dock.
3. To create an alias for your favorite Windows application, right-click the application icon in the Dock and select *Keep in Dock* from its shortcut menu.

The application alias appears on the Mac OS desktop. It will be available from the Dock even when the virtual machine is stopped. If you double-click this alias when the virtual machine is turned off, the virtual machine and the corresponding application in it will start automatically.

If you have several instances of one application opened in a Windows virtual machine that is running, only one icon of this application will be displayed in the Dock.

Clicking this icon will bring the application to focus. If you right-click this icon, the shortcut menu will open. You can use this menu to:

- Switch between the opened instances of this application;
- Specify the *SmartSelect* associations;
- Manage the application's options;
- Hide/show the application; and
- Quit it.

**Note:** If you launch an application in a Windows guest OS and the application's icon does not appear in the Dock, most probably the *Show Dock icons in Coherence only* option is enabled in the *Applications* pane (p. 184). With this option enabled, the icons of the running applications will be displayed in the Dock only when the virtual machine is working in the Coherence view mode (p. 144).

---

**Setting Guest OS Applications to Work with Mac CD/DVD Discs**

Parallels Desktop allows you to set Windows guest OS applications to open CD/DVD discs with music/video/pictures inserted in your Mac. For example, if you want to play music/video or view pictures using Windows Media Player, you can set it to open such discs. You can also set a guest OS application to work with blank CD/DVD discs.

**Note:** This feature is available only for Windows virtual machines with Parallels Tools installed (p. 74). These virtual machines must have the *Share Windows applications with Mac* option enabled in the *Applications* pane (p. 184) and Mac OS X CD/DVD-ROM must not be selected in the *Connect to* menu of the *CD/DVD* pane (p. 200).

To set a guest OS application to work with Mac CD/DVD discs, follow these steps:

1. Go to Mac OS X *System Preferences* - > *CDs & DVDs*.
2. Select the necessary CD/DVD type (blank, music, picture, or video), click its menu, and choose *Open other application*.
3 In the displayed window, go to the `<your username>/Applications` directory. You will see the folders with your virtual machines' applications. Each folder corresponds to a specific virtual machine.

4 Click the folder of the virtual machine that has the necessary application installed, select this application, and click **Choose**.

5 Close the **CDs & DVDs** window. Now if you insert the selected CD/DVD type (blank, music, picture, or video) into your Mac, the selected guest OS application will launch and open the disc.

**Note:** If you insert the selected CD/DVD type but the virtual machine storing the necessary application is shut down, this virtual machine will start in the Coherence view mode (p. 93).

**Launching Windows Applications From Spotlight**

You can launch guest OS applications installed in your Windows virtual machines from Mac OS X Spotlight. You can do this provided that:

- These Windows virtual machines have Parallels Tools installed (p. 74);
- The **Share Windows applications with Mac** option is enabled in the **Applications** pane (p. 184); and
- These virtual machines were started for at least one time after you enabled the **Share Windows applications with Mac** option.

To launch a Windows application from Spotlight, open Spotlight and start typing the application's name. Spotlight will display the list of items containing these letters. In this list, find the application you need and click it. The application will start in the Windows guest operating system if the virtual machine with this application installed is running. If the virtual machine is shut down, clicking the application in the Spotlight list will start the virtual machine and the application will open when the guest operating system boots up.

**Viewing Task Progress in the Dock**

If an application running in a Windows 7 virtual machine is performing a time consuming task like copying, downloading, etc, the progress bar of this task appears in the application's Dock icon. For example, if you start copying some files from an external storage to your Windows 7 virtual machine, the Windows Explorer icon with a progress bar appears in the Dock and you can view the copy progress:
If you decide to work with Mac OS X or any other virtual machine when the application is still performing its task, this progress bar allows you to monitor the task progress.

Note: If you start an application in the guest operating system but the application's icon does not appear in the Dock, make sure the Share Windows applications with Mac option is enabled and the Show Dock icons in Coherence only option is disabled in the Applications pane (p. 184) of the Virtual Machine Configuration dialog.

Sharing Windows System Tray Icons With Mac OS X

In the Crystal variation (p. 148) of the Coherence view mode, the integration between Mac OS X and a Windows guest operating system, installed in the virtual machine, is extended. In Crystal, Windows system tray icons are shared with Mac OS X and become displayed in the Mac OS X menu bar. You can use the system tray applications by clicking these icons.

Using SmartSelect

SmartSelect allows you to open files of particular types, stored in Mac OS X, in Windows guest OS applications. Moreover, you can also open files of particular types, stored in Windows guest OSs, in Mac OS X applications.

Note: To use SmartSelect, you should install Parallels Tools (p. 74) in the virtual machine and disable the Isolate Mac from Windows option in the Security pane (p. 179) of the virtual machine configuration.

SmartSelect is available for the following guest OSs:

- Windows 2000
- Windows Server 2003
- Windows XP
- Windows Vista
- Windows Server 2008
- Windows 7

Opening Files in Mac OS X With Windows Applications

To make the description of opening files in Mac OS X with Windows applications more vivid, let us assume that you have the doc.txt file stored in Mac OS X and you want to open it with Notepad.

- If you want to open the doc.txt file with Notepad only once, right-click this file, choose Open With from the shortcut menu, and select Notepad. If there is no Notepad in the context menu, click Other, and select Windows Applications for Windows > Notepad in Finder.
- If you want to open all .txt files stored in Mac OS X with Notepad from now on:
  1. Right-click the doc.txt file, choose Open With from the shortcut menu, and select Notepad.
  2. Right-click the Notepad icon in the Dock, and choose SmartSelect from the shortcut menu.
3. A list of SmartSelect file associations will open. You may edit the list by selecting the applications to open files with particular types of extensions.

![SmartSelect File Associations](image)

4. Find the .txt extension, select the Notepad application, and click **OK** to save the associations. From now on, all .txt files stored in Mac OS X will open in Notepad.
When trying to open a file stored in Mac OS X with the associated Windows guest OS application, mind the following:

- If the virtual machine containing this application is shut down, suspended, or paused, double-clicking the file will start or resume this virtual machine. When the guest OS boots up, the file will open in the application.
- If the virtual machine containing this application is deleted or removed from the Parallels Virtual Machines dialog, you will not be able to open the file with the associated application. In this case, choose another application to open this file using the Open With list accessible through the shortcut menu.

The SmartSelect File Associations After You Remove Parallels Desktop

If some types of Mac OS X files are associated with certain Windows applications, after you remove Parallels Desktop, it will be impossible to open them in the Windows applications they are associated with. When you try to open such a file after Parallels Desktop is removed, you will have to choose a Mac application to open this file using the Open With list accessible through the shortcut menu. To restore the SmartSelect file associations, reinstall Parallels Desktop on your Mac, and register the virtual machine that has the associated Windows applications installed.

Opening Files in Windows Guest OS With Mac OS X Applications

To make the description of opening files in Windows guest OSs with Mac OS X applications more vivid, let us assume that you have the doc.txt file stored in the Windows guest OS and you want to open it with TextEdit.

- If you want to open the doc.txt file with TextEdit only once, right-click this file, choose Open With from the shortcut menu, and select TextEdit.
- If you want to open all .txt files stored in this Windows guest OS with TextEdit from now on:
  1. Right-click the doc.txt file, choose Open With from the shortcut menu, and click Choose Program.
  2. Select TextEdit, choose Always use the selected program to open this kind of file, and click OK to save the association.

From now on, all .txt files stored in this Windows guest OS will open in TextEdit.
Sharing Web Applications

When you work with Mac OS X and Windows applications simultaneously, you may notice that clicking a hyperlink in a Windows application opens the corresponding web page in the browser set as default in the Windows guest OS. In the meantime, clicking a hyperlink in a Mac OS X application opens the corresponding web page in the Mac OS X default browser.

Parallels Desktop allows you to specify where you want to open similar types of hyperlinks from both Mac OS X and Windows applications - in Mac OS X or in Windows.

**Note:** This functionality is available only for Windows virtual machines with Parallels Tools installed (p. 74).

In the Applications pane of the Virtual Machine Configuration dialog, you can specify where you want to open the following types of hyperlinks:

- **Web pages.** Web pages accessible through the HTTP and HTTPS protocols.
- **E-mail.** Links in the mailto format.

If you click More Applications, you will also be able to specify where you want to open:

- **Newsgroups.** Links in the news. format.
- **FTP.** Locations accessible through the FTP protocol.
- **RSS.** RSS feeds.
- **Remote access.** Locations accessible through the Telnet and Secure Shell (SSH) protocols.

For each type of these hyperlinks, you can specify the following options:

- **Default.** If you select this option, the corresponding type of hyperlinks will open in the web application set as default in that operating system where you open this type of hyperlinks. For example, if you click a hyperlink in the Windows guest OS, it will open in the web browser set as default in Windows. If you click a hyperlink in Mac OS X, it will open in the web browser set as default in Mac OS X.
- **Open in Windows.** If you select this option, no matter where you open the corresponding type of hyperlinks - in Windows or in Mac OS X, it will open in the web application set as default in the Windows guest OS.
- **Open in Mac.** If you select this option, no matter where you open the corresponding type of hyperlinks - in Windows or in Mac OS X, it will open in the web application set as default in Mac OS X.

For more information about setting up shared applications, refer to Applications Settings.

**Usage Tip**

Sharing the web applications can be useful in software development and web site building to check the compatibility with different Internet browsers. Create several virtual machines and install the necessary Internet browsers in each of them. Right-click the file you want to check and specify the browser to use through Open With.

**Note:** The Open With list displays only the Internet browsers available through the virtual machines that are currently running.
Browsing Virtual Hard Disks in Finder

For easy access to your virtual machines files, you can mount their hard disks in Mac OS X Finder together with other disks and storage devices.

If you want your virtual hard disks to be mounted to the Mac OS X desktop when the virtual machine is running, perform the following actions:

1. Open the Sharing pane (p. 181) of the Virtual Machine Configuration dialog and enable the Mount virtual disks to Mac desktop option.

   **Note:** To be able to edit the settings in the Sharing pane, you should have Parallels Tools (p. 75) installed in the virtual machine and the Isolate Mac from Windows option disabled in the Security pane (p. 179).

2. Open the Finder Preferences, click the General tab and select the Connected servers option in the list of items displayed on the desktop.

If you want to manage the virtual machine content without starting the virtual machine, you can mount the virtual hard disks manually using Parallels Mounter:

1. Browse the virtual machine files in Finder. For Parallels virtual machines, right-click the virtual machine name in the Parallels Virtual Machines list and select Show in Finder from the context menu.

   The default paths for storing Parallels virtual machines are /Users/<UserName>/Documents/Parallels/ and /Users/Shared.

2. To mount the hard disk of a particular virtual machine, right-click this virtual machine's file and choose Open With > Parallels Mounter or Open With > Other > Library > Parallels > Parallels Mounter from the shortcut menu. You can mount the following virtual machines and hard disks:
   - Parallels bundle (.pvm) or configuration file (.pvs) or virtual hard disk file (.hdd).
   - VMware configuration file (.vmx,.vmwarevm) or virtual hard disk file (.vmdk).
   - Virtual PC configuration file (.vmc,.vpc7) or virtual hard disk file (.vhd).
   - VirtualBox configuration file (.xml) or virtual hard disk file (.vdi).

   If you choose the PVM file of a Parallels virtual machine or the configuration file of a third-party virtual machine that has several virtual hard disks, all its volumes will appear as mounted in Finder.

   If you want to mount a single virtual hard disk, double-click the virtual hard disk file to mount it with Parallels Mounter. The icon for the selected hard disk appears in the sidebar of the Finder window, together with other Mac OS X icons.

3. To browse the contents of a volume, click its icon in the sidebar of the Finder window.

   You can manage the virtual machine files just as you manage your Mac OS X files in Finder windows.
Note: If you are browsing the contents of a suspended virtual machine in Finder, you cannot delete, move, or otherwise modify its files.

4 To unmount the volume, use the Eject button next to the disk icon.

Note: If a hard disk that has several volumes was mounted and you want to open it or the virtual machine using it in Parallels Desktop, you should disconnect its volumes one by one by clicking the Eject button.

Copy and Pasting Between Mac and Windows

For closer integration between Mac OS X and your Windows guest OS, Parallels Desktop provides the possibility to copy and paste formatted text and pictures and drag and drop files between Mac OS X and the virtual machine operating system.

Note: To use these functionalities, you should have Parallels Tools (p. 74) installed in the virtual machine, the Isolate Mac from Windows option disabled in the Security pane (p. 179), and the Share Mac clipboard and Preserve text formatting options enabled in the Advanced pane (p. 193).

Copying and Pasting Formatted Text

When you work with your Mac and Windows-based virtual machines side by side, you may need to copy and paste text between them.

Parallels Desktop allows you to copy and paste text of any size between Mac and Windows applications. This text can be italic/bold/underlined, it can be of various colors/fonts/sizes and contain spaces.

You can copy and paste text from:

- Mac OS X applications to the virtual machine applications (Word, Excel, Outlook, Notepad, Wordpad, etc)
- the virtual machine applications to Mac OS X applications (TextEdit, Safari, Mozilla Firefox, MS Office for Mac, etc)

Copying and Pasting Pictures

When you work with your Mac and virtual machines side by side, you may need to copy and paste different pictures between them.

Parallels Desktop allows you to copy and paste pictures between Mac and Windows picture or graphic editors.

Dragging and Dropping Files

Close integration of Mac and Windows-based virtual machines allows you to drag and drop different files between them.
Enabling Parental Control in a Virtual Machine

If you are a user with administrator rights, Parallels Desktop allows you to apply your parental control settings, configured in Mac OS X for managed accounts, to Windows virtual machines. Restrictions for virtual machines include launching specific applications and viewing specific websites.

To apply parental control settings to your Windows virtual machines, do the following:

1. Install Parallels Tools (p. 74) in the virtual machines.
2. Add Parallels Desktop to the list of allowed applications for the users to whom you apply parental control.

After that, when such a user starts a Windows virtual machine, the parental control settings configured for this user will take effect in the guest operating system. This means the user will not be able to launch the restricted guest OS applications and view the restricted websites.
CHAPTER 9

Configuring the Virtual Machine

This chapter explains how you can edit your virtual machine configuration:

- Configure general parameters (the name, amount of memory, number of processors, etc).
- Edit different virtual machine options (p. 173) (Optimization, Security, Sharing preferences, etc).
- Configure the virtual hardware devices (p. 195) currently available inside the virtual machine and add new devices.

In this chapter, you can also find detailed information about networking in a virtual machine (p. 109).

The configuration of an existing virtual machine can be changed in the Virtual Machine Configuration dialog. You can open the Virtual Machine Configuration dialog by doing one of the following:

- Click the Configure button on the toolbar of the virtual machine main window.
- Choose Configure from the Virtual Machine menu.
- In the Parallels Virtual Machines list (p. 33), right-click the virtual machine and choose Configure.

In This Chapter

General Settings ................................................................. 171
Options ............................................................................. 173
Hardware Settings ............................................................ 195
General Settings

You can view and change the virtual machine name, processors number, amount of memory, and add description to the virtual machine.

To edit these settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click Configure.
2. In the Virtual Machine Configuration window, click General.

Note: Some of these settings can be changed only when the virtual machine is not running.
General Settings include the following:

- The virtual machine name. The Name field displays the name assigned to the virtual machine. The length of this name is limited to 50 characters. The name of the virtual machine is displayed in its guest OS window (p. 36).

- The guest OS type and version. This field displays the type of the operating system installed in the virtual machine or declared to be installed in the future. The OS type and version field should reflect the real operating system type and version installed in the virtual machine.

- The number of processors. The CPUs field allows you to change the number of virtual CPUs that will be used to handle the processes running in the virtual machine. The maximum allowable number of virtual CPUs is automatically calculated by Parallels Desktop. The calculation is based on the number of physical CPUs available to your Mac OS X computer.

  **Note:** It is reasonable to use more than one CPU in your guest OS if you are going to use applications that perform better under multi-core processors.

- The memory amount. In the Memory field, you can set the amount of RAM that will be available to the virtual machine. To configure the main memory limit, drag the slider or type the value directly into the Memory field.

  **Note:** If your Mac has 1 GB of RAM, it is strongly recommended to assign not more than 512 MB to a single virtual machine.

- The virtual machine description. The Notes field displays additional information related to the virtual machine.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
The virtual machine options include the following settings:

- **Startup and Shutdown.** In this pane, you can define a number of parameters related to the procedures of starting and shutting down your virtual machine.

- **Optimization** (p. 176). These settings relate to the virtual machine performance.

- **Security** (p. 179). These settings determine the overall level of virtual machine isolation from Mac OS X.

- **Sharing** (p. 181). In this pane, you can manage sharing parameters between the host and guest operating systems.

- **Applications.** These settings relate to sharing applications between the guest Windows OS and Mac OS X.

- **Backup** (p. 186). In this pane, you can schedule the automatic creation of snapshots.

- **Coherence** (p. 188). In this pane, you can configure a number of options related to the Coherence view mode.

- **Full Screen** (p. 190). In this pane, you can configure a number of options related to the Full Screen view mode.

- **Modality** (p. 192). In this pane, you can configure a number of Modality-related options for your virtual machine.

- **Advanced** (p. 193). In this pane, you can configure the Parallels Desktop additional settings.
Startup and Shutdown Settings

Using the **Startup and Shutdown** settings, you can define a number of parameters related to the procedures of starting and shutting down your virtual machine.

To edit these settings, do the following:

1. Open the **Virtual Machine** menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click **Configure**.
2. In the **Virtual Machine Configuration** window, click **Options** and select the settings name in the sidebar.
Starting the Virtual Machine Automatically

The **Start automatically** option defines the cases in which the virtual machine can be started automatically.

- Select **Never** if you do not want your virtual machine to be started automatically in any case.
- Select **When window opens** if you want your virtual machine to start automatically when you open it from the **Parallels Virtual Machines** list (p. 33).
- Select **When Parallels Desktop starts** if you want your virtual machine to start automatically every time you start Parallels Desktop.

Startup View

The **Startup view** option defines the mode in which the virtual machine will work after you select it from the **Parallels Virtual Machines** list (p. 33) and start. If the **Window**, **Coherence**, **Full screen**, or **Modality** option is selected, the virtual machine will automatically switch to the specified view mode (p. 93). If the **Same as last time** option is selected, the virtual machine will start in the same mode that was applied to it before it was turned off.

Action on the Virtual Machine Shutdown

The **On shutdown** option defines the operation to be performed when you stop the virtual machine.

- Select **Keep window open** if you want the virtual machine window to stay open after the virtual machine is stopped.
- Select **Close window** if you want the virtual machine window to automatically close after the virtual machine is stopped.
- Select **Quit Parallels Desktop** if you want Parallels Desktop to quit after the virtual machine is stopped. If there are any other running virtual machines, Parallels Desktop will ask what to do with them before closing.

Action on Closing the Virtual Machine Window

The **On window close** option defines the operation to be performed when you close the virtual machine window.

- Select **Suspend** if you want the virtual machine to be suspended when you close its window.
- Select **Force to stop** if you want the virtual machine to be shut down when you close its window.

If you select **Ask me what to do**, you will be prompted to choose the operation to perform with the virtual machine each time you close its window.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Optimization Settings

Using the Optimization settings, you can optimize your virtual machine performance.

To edit these settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click Configure.

2. In the Virtual Machine Configuration window, click Options and select the settings name in the sidebar.
Optimizing Performance

The **Performance** option defines the priority of distributing the main physical computer memory resources:

- Click the **Performance** field and select **Faster virtual machine** to allocate more physical computer memory resources to the virtual machine and its applications. Selecting this option may significantly increase the virtual machine performance; however, it may slow down the productivity of your Mac OS X applications.
- Click the **Performance** field and select **Faster Mac OS** to allocate more memory resources to the physical computer and its applications. In this case, the memory resources usage will be optimized to provide better performance of your Mac OS X applications.

Using Adaptive Hypervisor

Select the **Enable Adaptive Hypervisor** option to automatically allocate the host computer CPU resources between the virtual machine and Mac OS X applications depending on what application you are working with at the moment. If your virtual machine window is in focus, the priority of this virtual machine processes will be set higher than the priority of the Mac processes. As a result, more CPU resources will be allocated to the virtual machine. If you switch to the primary OS window - the priority of its working applications will be set higher and the CPU resources will be relocated to Mac OS X.

Tuning Windows for Speed

You can make your Windows virtual machine work even faster by selecting **Tune Windows for speed**. This option disables some of the additional Windows features that tend to slow down the Windows performance.

Optimizing Power Consumption

The **Power** option allows you to control the virtual machine power consumption when Parallels Desktop is installed on a Mac laptop computer that is running on batteries (for example, MacBook Pro):

- If you select **Longer battery life** in the **Power** field, the virtual machine power consumption will be automatically reduced to provide a longer life for your Mac laptop battery.
- If you select **Better performance**, the virtual machine and its applications will operate at the maximum possible speed. However, enabling this option may significantly reduce your Mac laptop battery life.

If you select the **Show battery in Windows** option (or **Show battery in Linux** for Linux virtual machines), the battery status will be displayed in your virtual machine each time your Mac laptop computer runs on batteries. This option is available only on laptop Macs.

Compressing the Disk Automatically
If you use an expanding (p. 217) virtual hard disk in your virtual machine, its image file size on the physical hard disk increases as you add new data to the virtual hard disk. When you delete some data from this virtual hard disk, free unused space appears on the disk but the amount of space your virtual machine occupies on the hard disk of your Mac does not reduce. To regularly free the unused space back to Mac, use the **Automatically compress virtual disks** option. The virtual hard disk in an expanding format will be reviewed twice a day and, if the unused space occupies more than 50 percent of the hard disk image size, it will be compressed and the hard disk image file size will be decreased. As a result, there will be more free space on your Mac hard disk.

**Note:** Compressing can be performed for virtual machines without snapshots (p. 134) and with the Undo disks option (p. 179) disabled.

In the **Hard Disk** pane (p. 202), you can compress the disk manually whenever you want.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Security Settings

You can set restrictions for performing some actions and make your virtual machine isolated from your Mac using the Security settings.

To edit these settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click Configure.

2. In the Virtual Machine Configuration window, click Options and select the settings name in the sidebar.
Setting Restrictions

You can set restrictions on the following operations for non-administrator users:

- **Exit full screen mode.** An administrator's password will be required to exit the Full Screen (p. 151) view mode.
- **Change virtual machine state.** An administrator's password will be required to start, stop (p. 90), suspend, or otherwise change the virtual machine state.
- **Manage snapshots.** An administrator's password will be required to create or delete a virtual machine snapshot (p. 134), or revert to a snapshot.

Isolating the Virtual Machine from Mac

If you want to isolate your virtual machine from Mac OS X, select the **Isolate Mac from Windows** option (or **Isolate Mac from Linux** for Linux virtual machines). This option disables all integration features, including Shared Folders (p. 181), Shared Profile (p. 181), Shared Applications (p. 184), SmartMount (p. 181), etc. You will also not be able to copy or move objects between the virtual machine and your Mac.

Using Undo Disks

The **Enable Undo Disks** option allows you to discard or apply the changes you made to the virtual machine hard disk during your working session. If you choose to discard them, the changes will be discarded when you shut down the virtual machine. When you start this virtual machine again, its virtual hard disk will have the same data it contained before you started the previous working session. If you choose to apply the changes on the virtual machine shutdown, the next time you start this virtual machine, its virtual hard disk will store the changes you made during the previous working session.

**Note:** When enabled, the **Undo Disks** feature is applied to all virtual hard disks this virtual machine uses.

You can choose whether you want to discard the changes you made to the virtual machine hard disk or choose the action to perform in the **On shutdown** field.

- **Discard changes.** Select this option if you want to discard the changes when you shut down this virtual machine.
- **Ask me what to do.** If this option is selected, you will be prompted to choose the action to perform with the changes (discard or apply them) each time you shut down the virtual machine.

**Note 1:** You cannot create snapshots of virtual machines that have the **Enable Undo Disks** option enabled.

**Note 2:** The **Enable Undo Disks** option cannot be enabled for the virtual machines using the Boot Camp partition.

Encrypting the Virtual Machine

Encryption allows you to protect your virtual machine from being accessed by unauthorized users. To encrypt the virtual machine, click **Turn On** and specify a password. To access the encrypted virtual machine, you have to enter this password every time you open it.
Warning! The specified password is very important. You must record it. Without this password, you will not be able to launch the virtual machine.

For more details about encrypting virtual machines, refer to Encrypting a Virtual Machine (p. 127).

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.

Sharing Settings

Sharing settings can be configured for Windows, Linux, and Mac OS X guest operating systems.

To edit these settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click Configure.

2. In the Virtual Machine Configuration window, click Options and select the settings name in the sidebar.

Note: To be able to edit the Sharing settings, you should have Parallels Tools (p. 75) installed in the virtual machine and the Isolate Mac from Windows (or Isolate Mac from Linux for Linux virtual machines) option disabled in the Security pane (p. 179).

You can also change the sharing settings at runtime. To learn how to do it, refer to the Changing the Configuration at Runtime section (p. 102)
Sharing Mac OS X Folders to the Guest OS

To configure access to the disks and folders on the physical computer from inside the virtual machine, click the **Share Mac folders** menu and select one of the following:

- Select **All disks** to provide the virtual machine with access to all disks and folders of your Mac.
- Select **Home folder only** to provide the virtual machine with access to the Home folder of your Mac.
- Select **None** to disable the Mac folders sharing.

**Note:** When you share the Mac disks or folders with a virtual machine, they still reside and occupy space on the hard disk of your Mac.

Defining physical computer folders to be shared

To specify one or more folders on your Mac to be shared with the virtual machine, click **Custom folders** and follow the steps described in the **Sharing Folders and Disks** section (p. 154).

Sharing Profile

The Shared Profile functionality allows you to make Mac OS X desktop and some of the Home folder items directly accessible from the Desktop and the corresponding folders in the Windows guest OS.

**Note:** The Shared Profile functionality is available for Windows guest operating systems only.

To enable Shared Profile, select **Share Mac user folders with Windows**, click **Configure**, and specify the following settings:

- Select **Desktop** to use the Mac desktop as the desktop in your Windows guest OS.
- Select **Documents** to use the Mac **Documents** folder on your Mac as the **My Documents** folder in your Windows guest OS.
- Select **Pictures** to use the **Pictures** folder on your Mac as the **My Pictures** folder in your Windows guest OS.
- Select **Music** to use the **Music** folder on your Mac as the **My Music** folder in your Windows guest OS.
- Select **Movies** to use the **Movies** folder on your Mac as the **My Videos** folder in your Windows guest OS (available for Windows XP/Vista/7 only).
- Select **Downloads** to use the **Downloads** folder on your Mac as the **Downloads** folder in your Windows guest OS (available for Windows Vista/7 only).

**Warning:** If you delete any Mac OS X file from the Windows desktop when the Mac OS X desktop sharing is enabled, you will not be able to find it in Mac OS X Trash or Windows Recycle Bin. The file will be permanently deleted from your computer.

For more information about the Shared Profile functionality, see **Using Shared Profile** (p. 158).

Mapping Mac Volumes to Guest OS
The SmartMount feature allows you to automate the detection and mounting of removable devices in your virtual machines. You can automate the detection and mounting of:

- **Removable drives.** External storage devices such as USB hard disks and USB flash drives will be mounted to your guest OS.
- **CD/DVD drives.** CD and DVD drives or CD/DVD images (DMG, ISO, and so on) will be mounted to your guest OS.
- **Network folders.** Network shares connected to Mac OS X will be mounted to your guest OS.

If the SmartMount functionality is enabled and you connect any of these devices to Mac OS X, this device is also automatically mounted to your guest operating system as a network drive. For example, a USB flash drive plugged in to your Mac will be accessible from both the /Volumes folder in Mac OS X and My Computer in the Windows virtual machine.

The permissions you will have for managing the mounted device from inside the virtual machine will coincide with those you have for this device in Mac OS X. So, if you can read from and write to a USB flash drive in Mac OS X, you will have the same permissions for this drive from inside the virtual machine. At the same time, if you are connecting a USB flash drive that is formatted with NTFS, you will have read-only access to it because Mac OS X cannot write to NTFS volumes.

To enable the SmartMount feature, select **Map Mac volumes to Windows** (or **Map Mac volumes to Linux** for Linux virtual machines).

### Sharing Windows disks to Mac OS X

**Note:** This option is not available for Linux and Mac OS X guest operating systems.

Select the **Access Windows folders from Mac** option to enable access to all virtual disks and partitions available in the virtual machine from the physical computer. You will be able to find the virtual machine disks in the virtual machine PVM bundle. Locate the virtual machine bundle in Finder, right-click its name, select **Show Package Contents** from the context menu, and open the Windows Disks folder.

You can also select **Mount virtual disks to Mac desktop** to mount the shared virtual hard disks to your Mac OS X desktop. After you enable this option, the virtual machine volumes will be accessible from the Mac OS X desktop where they will appear as connected volumes. Windows network shares cannot be mounted.

**Note:** If the virtual machine volumes are not mounted on the Mac OS X Desktop, go to Finder > Preferences > General and make sure that the **Connected servers** option is selected.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Applications Settings

Using the Applications settings, you can configure the applications sharing between Windows and Mac OS.

To edit these settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click Configure.
2. In the Virtual Machine Configuration window, click Options and select the settings name in the sidebar.

Note: These settings are available only when Parallels Tools are installed in the virtual machine and the Isolate Mac from Windows option disabled in the Security pane (p. 179).
Windows Applications

Select **Share Windows applications with Mac** to allow using Windows applications for opening the files in Mac OS X. Before using a Windows application in Mac OS X for the first time, you should open it once in the virtual machine guest OS. If you enabled this option, you can configure the following options:

- If you select **Show Windows Applications folder in Dock**, the folder with all applications installed in your Windows virtual machine will always be displayed in the Dock.
- When you launch a virtual machine application, its icon appears in the Dock. If you want the icons of the virtual machine applications to be displayed in the Dock only when the virtual machine is running in the Coherence view mode, select **Show Dock icons in Coherence only**.
- Select the **Pause Windows when no applications are open** option to save your Mac resources. Pausing a virtual machine releases the resources, such as RAM and CPU, currently used by this virtual machine. The released resources can then be used by the host computer and its applications or by other virtual machines running on the host computer.
  - If you select this option, the virtual machine will be automatically paused provided that:
    - the virtual machine is running but the virtual machine window is not active over 30 seconds
    - there are no applications running in the guest operating system (no icons of the guest OS applications are present in the Dock)

For more information on working with shared applications, refer to the **Using Shared Applications** section (p. 159).

Mac OS X Applications

To be able to open Windows files with Mac OS X applications, select **Share Mac applications with Windows**.

Internet Applications

In the **Applications** pane, you can also specify where you want to open similar types of hyperlinks from both Mac OS X and Windows applications - in Mac OS X or in Windows.

You can specify where you want to open the following types of hyperlinks:

- **Web pages**. Web pages accessible through the HTTP and HTTPS protocols.
- **Email**. Links in the mailto format.
  - If you click **More Applications**, you will also be able to specify where you want to open:
    - **Newsgroups**. Links in the news. format.
    - **FTP**. Locations accessible through the FTP protocol.
    - **RSS**. RSS feeds.
    - **Remote access**. Locations accessible through the Telnet and Secure Shell (SSH) protocols.

For more information on sharing web applications, refer to **Sharing Web Applications** (p. 165).
Backup Settings

Using the Backup settings, you can automate snapshots creation. You can find detailed information on snapshots and how to work with them in Working with snapshots (p. 134).

To edit these settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click Configure.

2. In the Virtual Machine Configuration window, click Options and select these settings name in the sidebar.

Note: When your virtual machine is paused, snapshots cannot be created.
Setting the Time Interval

Backing up with Time Machine

If you are using Time Machine for backing up your Mac, you may exclude the virtual machine from the Time Machine backups by selecting the Do not back up virtual machine option. Time Machine backups may decrease the performance of your virtual machine when it is running in parallel with the Time Machine backup. When your virtual machine is not running (when it is stopped or suspended), the Time Machine backups do not affect it in any way.

For more information about backing up your virtual machines, refer to Backing Up a Virtual Machine (p. 125).

Automating Snapshots Creation

The SmartGuard functionality allows you to automate snapshots creation.

Note: SmartGuard is available only when the Undo Disks feature is disabled and the virtual machine is not running in Safe Mode (p. 128).

To enable SmartGuard, click the SmartGuard menu and choose one of the following:

- **Optimize for Time Machine.** If you select this option, a snapshot will be taken every 24 hours. Time Machine, when backing up your Mac, will not back up the entire virtual machine, but only its latest snapshot. This allows you to reduce the amount of data that Time Machine backs up, to reduce the time Time Machine spends backing up the virtual hard disk(s), and to minimize the risk of data loss or corruption when restoring the virtual machine hard disk(s) from the Time Machine backup.

- **Custom.** If you select this option, you will be able to manually set the snapshots frequency and maximum number of snapshots to keep.

If you want to know when it is time to make the next snapshot and to be able to reject the snapshot creation, enable the Notify me before snapshot creation option.

Setting the Snapshots Frequency

Set how often snapshots should be made in the Take a snapshot every field. You can set from one to 48 hours.

If the time interval is less than 24 hours, SmartGuard will allow you to restore the latest hourly, daily and weekly snapshot. If the time interval is more than 24 hours, you will be able to restore the latest daily, weekly and monthly snapshot.

To manage the snapshots and restore any of them, use Snapshot Manager (p. 137).

Restricting the Snapshots Number

Use the Snapshots to keep field to set the maximum number of snapshots that can be stored on your Mac. The maximum available value is 100 snapshots. As soon as Snapshots Manager reaches the limit for snapshots and needs to make a new one over limit, it deletes the oldest snapshot.
If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.

Coherence Settings

Using the Coherence settings, you can configure a number of options related to the Coherence view mode for your virtual machine. This view mode is available only for Windows virtual machines that have Parallels Tools installed.

To edit these settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click Configure.
2. In the Virtual Machine Configuration window, click Options and select the settings name in the sidebar.

Note: For detailed information on the Coherence view mode, see Working in Coherence (p. 144).
In this pane, you can configure the following options:

- **Use Crystal mode.** With this option selected, the virtual machine switched to the Coherence view mode will be switched to the Crystal mode (p. 148). The Crystal mode is very similar to Coherence, however, it provides a higher level of integration between the host and guest operating systems.

- **Show Windows notification area in menu bar.** If you select this option, the Windows system tray icons will be available from both the Windows taskbar and the Mac OS X menu bar.

- **Disable Windows Aero.** This option is available for Windows 7 and Windows Vista guest operating systems. If you select this option, you will not be able to use the Aero theme in the Coherence (p. 144) and Crystal (p. 148) view modes. In other view modes (p. 93), the Aero theme will be available.

- **Hide minimized windows.** Select this option to make minimized Windows applications appear on the taskbar only. With this option disabled, all minimized Windows applications will appear both on the taskbar and in the Dock.

**Note:** If you use several displays, you can arrange how you will see applications when moving them from one display to another. To this effect, select **System Preferences > Displays > Arrangement** on the Mac OS X menu and arrange the available displays in the **Displays** dialog.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the **Lock icon** at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Full Screen Settings

Using the Full Screen settings, you can configure the virtual machine appearance and behavior when it is running in the Full Screen view mode. In the Full Screen mode, the guest operating system window occupies the whole screen and all Mac OS X and Parallels Desktop controls are hidden.

To edit these settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click Configure.

2. In the Virtual Machine Configuration window, click Options and select the settings name in the sidebar.

You can configure the Full Screen settings even when the virtual machine is running.
Active Screen Corners

You can set actions for screen corners in the Full Screen mode. Once you've set an active corner, move the mouse to the corresponding corner of your screen in the Full Screen mode to see the result.

To set an action for a screen corner, click the field near this corner and select the desired action from the menu:

- **Window.** On clicking the corresponding active corner, the virtual machine will switch to the Window view mode.
- **Coherence.** On clicking the corresponding active corner, the virtual machine will switch to the Coherence view mode (p. 144).
- **Modality.** On clicking the corresponding active corner, the virtual machine will switch to the Modality view mode.
- **Show menu bar.** On clicking the corresponding active corner, the Mac OS X menu bar and Dock will appear.

Adjusting the Host Computer Screen Resolution to the Virtual Machine Resolution in Full Screen

When you switch the virtual machine to the Full Screen mode, its screen resolution:

- changes to the physical computer screen resolution if you have Parallels Tools installed, or
- remains the same.

In the second case, if the virtual machine screen resolution is lower than that of your physical computer, in the Full Screen mode, the virtual machine screen will appear on a black background. If the virtual machine screen resolution is higher than that of the host computer, in the Full Screen mode, the virtual machine screen will have scroll bars.

To adjust the screen resolution of your physical computer to that of the virtual machine, select the **Adjust Mac resolution in full screen** option. In this case your computer will change its screen resolution each time the virtual machine is switched to the Full Screen mode.

Using All Displays in Full Screen

If you have multiple displays connected to your Mac, the guest operating system can use all these displays in the Full Screen mode. To enable this feature for the virtual machine, select **Use all displays in full screen**. Now if you change the view mode to Full Screen, your guest operating system will occupy all available displays.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the **Lock icon** at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Modality Settings

Using the **Modality** settings, you can configure the virtual machine appearance and behavior when it is running in the Modality mode. In the Modality mode, you can resize the virtual machine windows and place them side by side with your Mac applications. A Modality window can be scaled to any size, and its content will still be active. This allows you to monitor the tasks running inside the virtual machine while you are working on the Mac side.

To edit these settings, do the following:

1. Open the **Virtual Machine** menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click **Configure**.

2. In the **Virtual Machine Configuration** window, click **Options** and select the settings name in the sidebar.

You can configure the settings in this pane even when the virtual machine is running.
In the Modality mode, the virtual machine window becomes transparent by default. You can specify the level of visibility in the **Opacity** field by dragging the slider between **Transparent** and **Opaque**. You can change the level of transparency for your virtual machine that is running when it is in the Modality mode.

To manage the behavior of the virtual machine window in the Modality mode, use the following options selected by default:

- **Keep on top of other windows.** Clear this option if you do not want the virtual machine window to appear on top of all other open windows when the virtual machine is in Modality.
- **Capture keyboard and mouse on click.** Clear this option if you do not want the virtual machine to capture the keyboard and mouse input when in Modality.

To learn how to switch to Modality, refer to the **Changing View Modes** section (p. 93).

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.

### Advanced Settings

In the **Advanced** pane, you can configure the Parallels Desktop additional settings.

To edit these settings, do the following:

1. Open the **Virtual Machine** menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and click **Configure**.
2. In the **Virtual Machine Configuration** window, click **Options** and select the settings name in the sidebar.
SmartMouse

The **SmartMouse** option allows the mouse to move smoothly between the virtual machine and your Mac. With this option enabled, Parallels Desktop automatically grabs the mouse input when you move the pointer to the virtual machine, and releases it when you move it back to Mac OS.

- If you select **On**, the mouse input will be automatically captured in the virtual machine window when the mouse pointer hovers over it and then released when it moves back to Mac OS, which will make the mouse move seamlessly between your Mac and the virtual machine.
- If you select **Off**, you will need to click inside the virtual machine window to capture the mouse input, and press Ctrl+Alt to release it back to your Mac.

**Note:** Ctrl+Alt is the default key combination. You can define another key combination for releasing the mouse in the **Keyboard** (p. 45) pane of Parallels Desktop Preferences.

- If you select **Auto**, the option will automatically become disabled (**Off**) each time you use a game, graphic application, or any other program that uses its own mouse pointer instead of using the operating system pointer. The option will be automatically enabled (**On**) after you quit the application.

**Modifier Keys Optimization**

Select the **Optimize modifier keys for games** option if you actively use modifier keys (Alt, Ctrl, Shift) in action games. If you select this option, signals from these keys will be processed faster.

**Apple Remote**

Enable the **Apple Remote** option to use the Apple Remote to control some Windows applications.

For detailed information on using Apple Remote, see **Using Apple Remote** (p. 107).

**Time Synchronization**

Select the **Synchronize with Mac** option to synchronize the time settings of your virtual machine with those of your Mac.

If the time zone set in your virtual machine differs from that of your Mac, you can maintain this time difference by selecting the **Allow a different time than on Mac** option.

**Copy & Paste**

If you want to copy and paste data between the host and guest operating systems, select **Share Mac clipboard**. If the data you copy and paste between Mac OS X and your virtual machine is text and you want to preserve text formatting, select **Preserve text formatting**.

**Note:** This functionality is available only for virtual machines with Parallels Tools installed (p. 74).
If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.

Hardware Settings

Using the Virtual Machine Configuration dialog, you can configure the virtual hardware available in your virtual machine:

- Configure the devices currently available inside the virtual machine.
- Add or remove devices.
- Configure the boot order of your virtual machine.

Boot Order Settings

Using the Boot Order settings, you can configure the virtual machine boot sequence, that is, the order in which the virtual machine will try to load the operating system from different boot devices.

Note: These settings cannot be changed when the virtual machine is running.

To edit the Boot Order settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and choose Configure.
2. In the Virtual Machine Configuration dialog, click Hardware and select Boot Order in the sidebar.
The currently supported boot devices are listed below:

- **Hard Disk.** Select this device if you want the virtual machine to boot up from its virtual hard disk drive.
- **CD/DVD-ROM.** Select this device if you want the virtual machine to boot up from the media connected to its virtual CD/DVD-ROM drive.

  **Note:** The virtual machine will use the CD/DVD-ROM drive specified as **CD/DVD-ROM 1** in its configuration.

- **Floppy Disk.** Select this device if you want the virtual machine to boot up from a floppy disk image connected to its virtual floppy disk drive.
- **Network Adapter.** Select this device if you want your virtual machine to boot from a network adapter using PXE (Pre-Execution Environment).

  **Note:** The virtual machine will use the network adapter specified as **Network Adapter 1** in its configuration.

Every time you start the virtual machine, it tries to boot from the device specified as the first one in the **Boot Order** list. If the virtual machine cannot boot from the first device (for example, no media is connected to it), the virtual machine proceeds to the second device in the list and tries to boot from this device, and so on.

In this pane, you can perform the following operations:

- Change the currently set boot sequence by selecting the name of the corresponding boot device in the **Boot Order** list and moving it up or down using the arrows to the right of the list.
- Remove a boot device from the sequence by clearing the check box next to its name.

If you choose the **Select boot device on startup** option, you will see the following message at the virtual machine startup: "Press ESC to select boot device". If you press ESC pending 5 seconds, you will be able to select a boot device. If you do not press ESC, the virtual machine will try to boot from the devices specified in the **Boot Order** list.

  **Note:** Make sure that the device you wish to use for your virtual machine booting (hard disk drive, CD-ROM drive, floppy disk drive, or network adapter) is available to the virtual machine and configured properly. If you do not have any boot devices configured in your virtual machine, you will see the following error message after you start the virtual machine: **“No boot device is available”**. In this case, you should stop the virtual machine and configure at least one boot device for it.

The **Boot flags** field is intended for specifying the flags that can change the virtual machine system behavior. The system flags can be used by the Parallels customer support team in cases when something goes wrong in your virtual machine. It is not recommended to type anything into this field without being instructed to do so by the customer support staff.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the **Lock icon** at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
**Video Settings**

To view and configure the amount of video memory available to the virtual machine video card, use the Video settings.

To edit these settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and choose Configure.
2. In the Virtual Machine Configuration dialog, click Hardware and select Video in the sidebar.

**Note:** These settings cannot be changed when the virtual machine is running.
In the **Video memory** field, you can set the amount of video memory that will be available to the virtual machine.

To configure the video memory limit, do one of the following:

- drag the slider
- use the spin box arrows
- type the value directly into the **Video memory** field

**Enabling 3D Acceleration**

If you want to use Windows Aero in your Windows virtual machines or use games and applications that require video cards that support DirectX or OpenGL, select the **Enable 3D acceleration** option. For more information, refer to **Using 3D Graphics Applications** (p. 106).

**Enabling Vertical Synchronization**

Sometimes in games and 3D applications, a newly rendered frame may overlap a previously rendered one and then screen tearing happens. This occurs when the video card or the software using it begins updating the actively-displayed memory in a manner that is out of sync with the monitor's refresh rate. To prevent screen tearing, select the **Enable vertical synchronization** option.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Floppy Settings

To view and configure the virtual machine floppy disk drive settings, use the Floppy Disk settings.

To edit the device settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and choose Configure.
2. In the Virtual Machine Configuration dialog, click Hardware and select this device name in the sidebar.

**Note:** If this device is absent, you can add it to Virtual Machine Configuration. For detailed information on how to add a device, refer to Adding and Removing Devices (p. 215).

Select the Connected option if you want the floppy disk drive or floppy disk image to be automatically connected to the virtual machine on its startup.

In the Source field, specify the source device or image file that will emulate the virtual machine floppy disk drive:

- If you want to use a real floppy disk drive, click the Source field and select the real device name from the list.
- If you want to use a floppy disk image, click the Source field, click Choose an image file, and specify the path to the desired floppy disk image file.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
CD/DVD-ROM Settings

To configure the virtual machine CD/DVD drive settings, use the CD/DVD settings. Virtual CD/DVD drives can be connected either to physical CD/DVD drives or to CD/DVD images.

Note: You can connect up to 4 IDE devices (hard disks or CD/DVD drives), 6 SATA, and 15 SCSI devices to a virtual machine. Each device is listed separately in the Virtual Machine Configuration dialog and has its own number.

To edit the device settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and choose Configure.

2. In the Virtual Machine Configuration dialog, click Hardware and select this device name in the sidebar.

Note: If this device is absent, you can add it to Virtual Machine Configuration. For detailed information on how to add a device, refer to Adding and Removing Devices (p. 215).
Select the **Connected** option if you want the CD/DVD drive to be automatically connected to the virtual machine on its startup.

To emulate the virtual CD/DVD drive, you can connect one of the real CD/DVD drives on your physical computer or a CD/DVD image file to the virtual machine.

**Note:** Parallels virtual machines support ISO and DMG image files and may support CUE and CCD image files.

In the **Connect to** field, the source device or image file that emulates the virtual machine CD/DVD drive is specified. You can change the source device:

- To use a real CD/DVD drive as the virtual machine CD/DVD drive, click the **Connect to** field and select the real device name from the list.
- To use an image file as the virtual machine CD/DVD drive, click the **Connect to** field and choose the image file from the list, or click **Choose an image file** and specify the path to the desired image file on your Mac.

In the **Location** field, you can specify the type of interface for connecting the device:

- **IDE.** Using this interface type, you can connect up to 4 virtual devices (hard disks or CD/DVD drives).
- **SATA.** Using this interface type, you can connect up to 6 virtual devices (hard disks or CD/DVD drives).
- **SCSI.** Using this interface type, you can connect up to 15 virtual devices (hard disks or CD/DVD drives).

**Note 1:** The Mac OS X guest OS does not support the SCSI controller. In the latest Linux distributions (e.g. RHEL 5.3), the SCSI driver may be not installed. In this case, you should install this driver in your Linux guest OS to be able to use the SCSI controller.

**Note 2:** The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI controller itself.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the **Lock icon** at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Hard Disk Settings

To view and configure the virtual hard disk settings, use the **Hard Disk** pane of Virtual Machine Configuration. Parallels Desktop allows virtual machines to use hard disk images in the `.hdd` format and Windows Boot Camp partitions.

**Note:** You can connect up to 4 IDE devices (hard disks or CD/DVD drives), 6 SATA, and 15 SCSI devices to a virtual machine. Each device is listed separately in the **Virtual Machine Configuration** dialog and has its own number.

To edit the device settings, do the following:

1. Open the **Virtual Machine** menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and choose **Configure**.
2. In the **Virtual Machine Configuration** dialog, click **Hardware** and select this device name in the sidebar.

**Note:** If this device is absent, you can add it to Virtual Machine Configuration. For detailed information on how to add a device, refer to **Adding and Removing Devices** (p. 215).
In the **Source** field, the virtual hard disk file (\*.hdd) that emulates the virtual machine hard disk is specified. You can change the hard disk source:

- To use the Boot Camp partition as the virtual machine hard disk, click the **Source** field and select the Boot Camp partition name from the list.
- To use a virtual hard disk file as the virtual machine hard disk, click the **Source** field and choose the virtual hard disk file from the list, or click **Choose an image file** and specify the path to the desired image file (\*.hdd) on your Mac.

In the **Location** field, you can specify the type of interface for connecting the device:

- **IDE**. Using this interface type, you can connect up to 4 virtual devices (hard disks or CD/DVD drives).
- **SATA**. Using this interface type, you can connect up to 6 virtual devices (hard disks or CD/DVD drives).
- **SCSI**. Using this interface type, you can connect up to 15 virtual devices (hard disks or CD/DVD drives).

**Note 1:** The Mac OS X guest OS does not support the SCSI controller. In the latest Linux distributions (e.g. RHEL 5.3), the SCSI driver may be not installed. In this case, you should install this driver in your Linux guest OS to be able to use the SCSI controller.

**Note 2:** The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI controller itself.

### Compressing the Disk

If you use an expanding (p. 217) virtual hard disk in your virtual machine, its image file size on the physical hard disk increases as you add new data to the virtual hard disk. When you delete some data from this virtual hard disk, free unused space appears on the disk, but the amount of space your virtual machine occupies on the hard disk of your Mac does not reduce. To free the unused space back to Mac, click the **Compress** button. The virtual hard disk will be compressed and the hard disk image file size will be decreased. As a result, there will be more free space on your Mac hard disk.

**Note:** Compressing can be performed for virtual machines without snapshots (p. 134) and with the Undo disks option (p. 179) disabled.

In the **Optimization** pane (p. 176) of Virtual Machine Configuration, you can enable regular automatic disk compression.

### Editing the Disk

If you find that the capacity of your virtual machine hard disk does not fit your needs anymore, you can change its size. Click the **Edit** button and the dialog for changing the disk size will appear.

**Note:** If your virtual machine is running, has snapshots, or uses a Boot Camp partition as a hard disk, its virtual hard disks cannot be resized.
To change the disk size, drag the slider or type the new size in the **Size** field. Select the **Resize file system** option if you want to change the file system size:

- If you select the **Resize file system** option when increasing the disk size, the additional disk space will be added to the last volume. If you clear the **Resize file system** option, the added space will appear as unallocated space and will be invisible to the guest operating system. To allocate this space, you will have to either create a new partition or expand an existing partition. For instructions on allocating the added space, see *Initializing the Newly Added Space* (p. 218).

- If you select the **Resize file system** option when decreasing the disk size, the disk will be decreased via removing the unallocated space and decreasing the size of the disk partitions. If you clear the **Resize file system** option when decreasing the disk size, you will be able to remove the unallocated space of the disk only and the disk partitions will remain untouched.

If the format of the virtual hard disk is *expanding*, you can convert it to *plain* by clearing the **Expanding disk** option.

If you want the virtual hard disk to be split, select the **Split the disk image into 2 GB files option** option.

---

**Note:** For more information about virtual hard disk types, please refer to *Support for Virtual and Real Disks* (p. 217).

---

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the **Lock icon** at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Compressing Virtual Hard Disks

If you use an expanding (p. 217) virtual hard disk in your virtual machine, its image file size on the physical hard disk increases as you add new data to the virtual hard disk. When you delete some data from this virtual hard disk, free unused space appears on the disk, but the amount of space your virtual machine occupies on the hard disk of your Mac does not reduce. To free the unused space back to Mac, you can compress the virtual hard disk. The hard disk image file size will be decreased and, as a result, there will be more free space on your Mac's hard disk.

You can compress virtual hard disks either **manually** or **automatically**:

- **To compress the virtual hard disk manually at any time**, select **Configure** from the **Virtual Machine** menu, click **Hardware**, open the hard disk setting (p. 202), and click the **Compress** button.

- **To regularly free the unused space back to Mac**, use the **Automatically compress virtual disks** option. The virtual hard disk in an expanding format will be reviewed twice a day, and, if the unused space occupies more than 50 percent of the hard disk image size, it will be compressed and the hard disk image file size will be decreased. The **Automatically compress virtual disks** option can be enabled for all hard disks of a virtual machine in the **Optimization** pane (p. 176) of Virtual Machine Configuration.

**Note**: Compressing of virtual hard disks can be performed for virtual machines without snapshots (p. 134) and with the **Enable Undo disks** option (p. 179) disabled.
Network Settings

Using the Network settings, you can change the network type used in your virtual machine.

To edit the device settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and choose Configure.

2. In the Virtual Machine Configuration dialog, click Hardware and select this device name in the sidebar.

Note: If this device is absent, you can add it to Virtual Machine Configuration. For detailed information on how to add a device, refer to Adding and Removing Devices (p. 215).
Select the **Connected** option if you want the virtual machine to start up with this network adapter connected.

You can choose one of the following network types for the virtual machine network adapter:

- **Shared Network**. Select this option to enable the Network Address Translation (NAT) feature for the virtual machine. In this case, your virtual machine will share whatever network connection is currently used by the host computer.
  
  See [Shared Network](p. 109) to learn how to configure this network type.

- **Bridged Network**. Select this option to allow the virtual machine to access the local network and Internet through one of the network adapters installed on the host computer. In this case, the virtual machine is treated as a stand-alone computer on the network and should be configured in the same way as a real one. You can choose the physical adapter where the virtual machine adapter will be bridged in the list below the **Bridged Network** option.
  
  See [Bridged Ethernet Network](p. 111) to learn how to configure this network type.

- **Host-Only Network**. Select this option to allow the virtual machine to connect to the host computer and the virtual machines residing on it and to make it invisible outside the host computer.
  
  See [Host-Only Network](p. 112) to learn how to configure this network type.

In the **MAC address** field, you can change the MAC address currently assigned to the virtual machine. MAC addresses are automatically generated during the virtual machine creation. However, you can modify the default MAC address by typing another value in the **MAC address** field or clicking the **Generate** button. When entering a new MAC address, make sure that it is unique within your network.

**WiFi Bridging Support**

To be able to connect to wireless networks from your virtual machine:

1. Click the **Type** field.
2. Choose the **AirPort** adapter from the **Bridged Network** list, and click **OK** to apply the changes.

After you perform these steps, your virtual machine will be able to connect to the Internet through the AirPort adapter of your Mac.

When you try to connect to the Internet via WiFi, and the WiFi Access Point has the **Validate DHCP packets** option enabled, you may experience problems connecting to the Internet. In this case, enable the **Send the host's MAC address to DHCP server** option to ensure that your virtual machine gets an IP address for accessing the Internet.

**Note:** Enabling the **Send the host's MAC address to DHCP server** option will not work with some DHCP servers - your virtual machine may get the same IP address as the physical computer.

If you cannot configure your virtual machine to work in the Bridged Ethernet mode, you can consider using another network mode: Shared Network mode (p. 109) or Host-Only Network mode (p. 112).
If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.

**Printer Port Settings**

Using the Printer Port settings, you can configure the virtual machine printer port settings. A virtual machine can have up to three printer ports.

To edit the device settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and choose Configure.

2. In the Virtual Machine Configuration dialog, click Hardware and select this device name in the sidebar.

*Note:* If this device is absent, you can add it to Virtual Machine Configuration. For detailed information on how to add a device, refer to Adding and Removing Devices (p. 215).
Select the **Connected** option if you want the virtual machine to start up with the printer port connected.

In the **Source** field, the source device that emulates this printer port is specified. A printer port can be emulated by one of the following devices:

- **Printers.** You can use any of the printers connected to your Mac in your virtual machine. Click the **Source** field and select the appropriate printer from the list.
  
  For the detailed information on how to set up a printer in your virtual machine, please refer to *Setting Up a Printer in a Virtual Machine* (p. 117).

- **Real printer port.** If your Mac has a physical printer port, you can connect it to your virtual machine. Click the **Source** field and select the physical port name from the list.

- **Output File.** You can emulate the virtual machine printer port by using an output file. Click the **Source** field and choose an output file from the list, or click **Choose an output file** and specify the path to the desired output file on your Mac.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the **Lock icon** at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Serial Port Settings

In the Serial Port pane, you can configure the virtual machine serial port settings.

To edit the device settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and choose Configure.
2. In the Virtual Machine Configuration dialog, click Hardware and select this device name in the sidebar.

Note: If this device is absent, you can add it to Virtual Machine Configuration. For detailed information on how to add a device, refer to Adding and Removing Devices (p. 215).

Using serial ports, you can establish a connection between:

- The virtual machine and the host computer devices (using a real port); or
- Between two virtual machines located on the same host computer (using a socket).

If you want to connect your virtual machine to the host computer device, you should create a serial port emulated by a real port. The Source list comprises the devices on the host computer that are available for connection. The connected device, being used in any virtual machine, cannot be used by the host computer. To be able to use it in the host computer, you should first disconnect it from the virtual machine. To do that, use the virtual machine status bar (p. 39).

If you want to connect two virtual machines with each other, you need to create a serial port emulated by a socket in each virtual machine. The names of the serial ports should be identical. The connection between the virtual machines via serial ports is bidirectional. It means that the working modes of the sockets set during the port creation can be changed later in the Serial Port pane.

If you need to log the performance activity of your virtual machine or to record the data from it and use this information later on, you can connect your virtual machine serial port to an output file on the physical computer. You will be able to view and analyze the activity history of the virtual machine any time you need by exploring this file.

You can add a new serial port to your virtual machine using Add Hardware Assistant. For the instruction on how to add serial ports, refer to Adding and Removing Devices (p. 215).

Note: You can connect up to four serial ports to a virtual machine.
Select the **Connected** option if you want the virtual machine to start up with the serial port connected.

In the **Source** field, the source device that emulates this serial port is specified. Serial ports can be emulated by the following devices:

- **Real Port.** To connect the virtual machine serial port to one of the existing serial ports on the host computer, choose the appropriate port on the host computer in the **Source** list.

- **Socket.** To connect two virtual machines through the sockets, click the **Source** list and choose the appropriate socket. If there are no sockets available, click **New socket** and specify its name in the **Enter a socket name** field.

You should also configure the role the virtual machine will play in the connection by selecting the necessary role in the **Mode** list. Selecting **Server** enables you to use this virtual machine to direct the other one. Selecting **Client** enables you to direct this virtual machine from the other one.

**Note:** If you change the socket mode of the first virtual machine, make sure the socket mode of the second virtual machine is also modified.

- **Output File.** To connect the virtual machine serial port to an output file, click the **Source** list and choose the appropriate output file. You can also click **Choose an output file** to locate the necessary file.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Sound Settings

The Sound pane of Virtual Machine Configuration allows you to configure the virtual machine sound device parameters.

To edit the device settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and choose Configure.
2. In the Virtual Machine Configuration dialog, click Hardware and select this device name in the sidebar.

Note: If this device is absent, you can add it to Virtual Machine Configuration. For detailed information on how to add a device, refer to Adding and Removing Devices (p. 215).
Select the **Connected** option to have the sound device automatically connected on the virtual machine startup.

Use the **Input** list to choose the necessary device. You can choose one of the following devices:

- **Default.** Select this option if you want to use the input device set as default in Mac OS.
- **Built-in Input.** Select this option if you want to use one of the input devices from your Mac.
- **Null device.** Select this option if you want to mute the input device.

Use the **Output** list to choose the necessary device. You can choose one of the following devices:

- **Default.** Select this option if you want to use the output device set as default in Mac OS.
- **Built-in Output.** Select this option if you want to use one of the output devices from your Mac.
- **Null device.** Select this option if you want to mute the output device.

Use the **Channels** list to choose the type of sound reproduction. You can choose one of the following types:

- **Auto.** If you select this option, Parallels Desktop will check the sound card connected to your Mac and to the virtual machine. If this sound card is 5.1 surround-capable, the virtual machine output device will reproduce 5.1 surround sound. If the sound card does not support 5.1 surround sound, the virtual machine output device will reproduce stereo 2.0 sound.
- **Stereo Sound.** Select this option if you want the output device to reproduce stereo 2.0 sound.
- **Sound Surround 5.1.** If you have a 5.1 surround-capable sound card connected to your Mac (via USB or FireWire) and you want to use it in your virtual machine, select this option.

**Note 1:** If you want to use a 5.1 surround-capable sound card in your virtual machine, make sure this card is selected in the **Output** list.

**Note 2:** If you choose to use a 5.1 surround-capable sound card in your virtual machine, you may need to set up this sound card in the guest operating system. For the information on how to do that, please refer to this operating system documentation.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
**USB Settings**

A virtual machine can emulate only one USB controller, which provides you with the possibility to connect up to eight USB 2.0 and five USB 1.1 devices to the virtual machine.

To edit the device settings, do the following:

1. Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac menu bar (in the Crystal view mode) and choose Configure.

2. In the Virtual Machine Configuration dialog, click Hardware and select this device name in the sidebar.

**Note:** If this device is absent, you can add it to Virtual Machine Configuration. For detailed information on how to add a device, refer to Adding and Removing Devices (p. 215).

In the USB Controller pane, you can see the USB devices currently connected to your virtual machine.

If you want to prevent Virtual Machine Configuration from unauthorized changes, click the Lock icon at the bottom of the window. The next time someone wants to change the settings in any pane of Virtual Machine Configuration, an administrator's password will be required.
Adding and Removing Devices

Adding new devices to a virtual machine is easier than connecting new devices to a real computer. Removing or disconnecting devices is also easy. The following virtual devices can be added to the configuration or removed from it:

- virtual hard disk drive
- CD/DVD drive
- floppy disk drive
- network adapter
- serial port
- printer port
- sound device
- USB controller

Any of the aforementioned devices can be added to the corresponding virtual machine only when it is stopped.

**Note:** To be able to connect any virtual device to a real one, you should have system privileges to access the real device. Otherwise, the real device will not appear in the list of available devices even though it is installed on your computer.

Adding a New Device to a Virtual Machine

1. Choose **Configure** from the **Virtual Machine** menu to open Virtual Machine Configuration.
2. Click the **Hardware** button at the top of the **Virtual Machine Configuration** dialog to open the pane for editing hardware devices.
3. Click the **Add** button in the bottom part of the **Virtual Machine Configuration** dialog and select the device to be added to your virtual machine.

**Note:** The **Add** button is disabled when the virtual machine is running. You need to stop the virtual machine before you can use this button.
4 If you selected any device except for a hard disk, the corresponding device with a typical configuration is added at once and ready for use.

If you selected a hard disk, you should specify some parameters:

- The hard disk type: a new image file or an existing one. Select Boot Camp if you want to add an existing Boot Camp partition as a hard disk to your virtual machine.

- The hard disk location. Provide the path on your Mac to the existing image file or the path and name for the new image file. By default, Parallels Desktop offers to save the new image file in the virtual machine PVM bundle (p. 13).

- The hard disk size for the new hard disk image file.

- For the new hard disk image file, you can choose one of the following formats: Expanding or Plain. By default, the hard disk will have the Expanding format. To create a Plain hard disk, clear the Expanding disk option. If you want the virtual hard disk to be split, select the Split the disk image to 2 GB files option. For more information on hard disk formats, refer to Support for Virtual and Real Disks (p. 217).

Click OK, to add the hard disk. After you added a new virtual hard disk to the virtual machine configuration, it will be invisible to the operating system installed inside the virtual machine until the moment you initialize it. For detailed information on how to initialize the newly added hard disk, see Initializing the Newly Added Disk (p. 219).

After the new device is added, you can manage its properties as usual and start using it.

Removing Devices From the Virtual Machine Configuration

1 Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration.

2 Click the Hardware button at the top of the Virtual Machine Configuration dialog to open the pane for editing hardware devices.

3 Select the device you want to remove and click the Remove button in the bottom part of the Virtual Machine Configuration dialog.

Note: If you accidentally click the Remove button, click Cancel in Virtual Machine Configuration. Once you click OK, the device will be removed.
Support for Virtual and Real Disks

This section lists the types of disks that can be used by Parallels virtual machines and provides the information about basic operations you can perform on these disks.

Supported Types of Hard Disks

Parallels virtual machines can use either virtual hard disks or Boot Camp partitions as their hard disks.

Virtual Hard Disks

The capacity of a virtual hard disk can be set from 100 MB to 2 TB.

Virtual hard disks can be of either plain or expanding format.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>plain</td>
<td>A plain virtual hard disk image file has a fixed size. The size is determined when the disk is created. Plain disks can be created with the help of New Virtual Machine assistant (the Custom mode.)</td>
</tr>
<tr>
<td>expanding</td>
<td>An expanding virtual hard disk image file is small initially. Its size grows as you add applications and data to the virtual hard disk in the guest OS.</td>
</tr>
</tbody>
</table>

When you create a virtual machine, the disk is created in the expanding format. You can change the disk format in the Hard Disk pane (p. 202) of the Virtual Machine Configuration dialog. To add a plain hard disk to your virtual machine, clear the Expanding disk option when adding a hard disk to the virtual machine (p. 215).

Split disks

A virtual disk of either format can be a single-piece disk or a split disk. A split disk is cut into 2 GB pieces and is stored as a single .hdd file.

Boot Camp Partitions

With Parallels Desktop, you can choose how to use your Boot Camp Windows XP, Windows Vista, or Windows 7 operating system: to boot in it natively (via Boot Camp) or in a virtual machine (via Parallels Desktop). A Boot Camp Windows partition can be used as a bootable disk or as a data disk in Parallels virtual machines. For detailed information, see Using the Boot Camp Partition in a Virtual Machine.

Note: You cannot create snapshots or use the Undo Disks option for a virtual machine that uses the Boot Camp partition.

CD/DVD Discs and Their Images

Parallels Desktop can access real CD/DVD discs and images of CD/DVD discs.

Parallels Desktop has no limitations on using multi-session CD/DVD discs. A virtual machine can play back audio CDs without any limitations on copy-protected discs.

If your host computer has a recordable optical drive, you can use it to burn CD or DVD discs in a virtual machine.
Parallels Desktop supports CD/DVD disc images in the ISO, CUE, and CCD formats.

**Note:** DMG disk images made with Mac OS X Disk Utility are also supported by Parallels Desktop. When creating such an image, make sure you create a *read-only* and *uncompressed* image without any encryption.

**Floppy Disks and Floppy Disk Images**

Parallels Desktop can use two types of floppy disks:

- Real diskettes inserted into a real floppy disk drive that is connected to the virtual machine.
- Floppy disk image files having the `.fdd` extension and connected to the virtual machine.

Parallels Desktop treats floppy disk images like real diskettes. Parallels Desktop supports floppy disk image files that have the `.fdd` extension and 1.44 MB size.

**Initializing the Newly Added Space**

This section provides some general guidelines on initializing new virtual hard disks or new space added to your existing virtual hard disks.
Initializing the Newly Added Disk

After you added a new blank virtual hard disk to the virtual machine configuration, it will be invisible to the operating system installed inside the virtual machine until the moment you initialize it.

Initializing the New Virtual Hard Disk in Windows

To Initialize the new virtual hard disk in a Windows guest OS, you will need the Disk Management utility available through:

- In Windows Vista: **Start > Control Panel > System and Maintenance > Administrative Tools > Create and Format Hard Disk Partitions > Disk Management.**
- In Windows XP: **Start > Control Panel > Administrative Tools > Computer Management > Storage > Disk Management.**

When you open the Disk Management utility, it automatically detects that a new hard disk was added to the configuration and launches **Initialize and Convert Disk Wizard**:

1. In the introduction window, click **Next**.
2. In the **Select Disks to Initialize** window, select the newly added disk and click **Next**.
3. In the **Select Disks to Convert** window, select the newly added disk and click **Finish**.

The added disk will appear as a new disk in the Disk Management utility window, but its memory space will be unallocated. To allocate the disk memory, right-click this disk name in the Disk Management utility window and select **New Simple Volume** in Windows Vista or **New Volume** in Windows XP. The **New Simple Volume Wizard**/**New Volume Wizard** window will appear. Follow the steps of the wizard and create a new volume in the newly added disk.

After that your disk will become visible in **Computer/My Computer** and you will be able to use it as a data disk inside your virtual machine.

Initializing the New Virtual Hard Disk in Linux

Initializing the new virtual hard disk in a Linux guest OS comprises two steps: allocating the virtual hard disk space and mounting this disk in the guest OS.

To allocate the space, you will need to create a new partition on this virtual hard disk, using the **fdisk** utility.

**Note:** To use the **fdisk** utility, you need the **root** privileges.

1. Launch Terminal.
2. To list the IDE disk devices present in your virtual machine configuration, enter:
   ```bash
   fdisk /dev/hd*
   ```
   **Note:** If you added a SCSI disk to the virtual machine configuration, use the **fdisk /dev/sd*** command instead.
3. By default, the second virtual hard disk appears as **/dev/hdc** in your Linux virtual machine. To work with this device, enter:
   ```bash
   fdisk /dev/hdc
   ```
   **Note:** If this is a SCSI disk, use the **fdisk /dev/sdc** command instead.
To get extensive information about the disk, enter:

```
p
```

To create a new partition, enter:

```
n
```

To create the primary partition, enter:

```
p
```

Specify the partition number. By default, it is 1.

Specify the first cylinder. If you want to create a single partition on this hard disk, use the default value.

Specify the last cylinder. If you want to create a single partition on this hard disk, use the default value.

To create a partition with the specified settings, enter:

```
w
```

When you allocated the space on the newly added virtual hard disk, you should format it by entering the following command in the terminal:

```
mkfs -t <FileSystem> /dev/hdc1
```

**Note:** `<FileSystem>` stands for the file system you want to use on this disk. It is recommended to use `ext3` or `ext2`.

When the added virtual hard disk is formatted, you can mount it in the guest OS.

To create a mount point for the new virtual hard disk, enter:

```
mkdir /mnt/hdc1
```

**Note:** You can specify a different mount point.

To mount the new virtual hard disk to the specified mount point, enter:

```
mount /dev/hdc1 /mnt/hdc1
```

When you mounted the virtual hard disk, you can use its space in your virtual machine.
Creating a New Partition in Windows

To create a new partition from the unallocated space on your virtual hard disk, you can use Disk Management, a Windows built-in utility for partitioning hard disks. The steps below provide instructions for creating a new partition in Windows XP. For other Windows operating systems, the procedure is very similar. For more details, see the documentation for the respective Windows operating system.

To create a new partition in Windows XP:

1. Start the virtual machine that uses the virtual disk with unallocated space.
2. To start the Disk Management utility:
   a. Choose Control Panel from the Start menu.
   b. Double-click Administrative Tools, and then double-click Computer Management.
   c. In the Storage section, select Disk Management.
3. In the Disk Management window, right-click Unallocated Capacity, and choose New Partition.
4. In the New Partition wizard Introduction window, click Next.
5. In the Select Partition Type window, select Primary partition, and click Next.
6. Specify the partition size, and click Next.
7. Assign a drive letter to the new partition, and click Next.
8. In the Format partition window, select Format partition with the following settings. Set File system to NTFS and Allocation unit size to Default. Type the volume name in the Volume label field, and click Next.
9. Carefully review the settings, and click Finish to start formatting.

Once the operation is complete, the new volume appears in the Computer Management window and in My Computer.
Creating a New Partition in Linux

In most Linux systems, you can use the `fdisk` utility to create a new partition and perform other disk management operations.

**Note:** To perform disk management operations using `fdisk`, you must have the root privileges.

As a tool with a text interface, `fdisk` requires typing the commands in the `fdisk` command line. The main `fdisk` commands are listed below:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>m</td>
<td>Displays all available commands for <code>fdisk</code>.</td>
</tr>
<tr>
<td>p</td>
<td>Displays the list of existing partitions on your <code>hda</code> drive. Unpartitioned space is not listed.</td>
</tr>
<tr>
<td>n</td>
<td>Creates a new partition.</td>
</tr>
<tr>
<td>q</td>
<td>Exits <code>fdisk</code> without saving your changes.</td>
</tr>
<tr>
<td>l</td>
<td>Lists partition types.</td>
</tr>
<tr>
<td>w</td>
<td>Writes changes to the partition table.</td>
</tr>
</tbody>
</table>

To create a new partition:

1. Start a terminal.
2. Start `fdisk`:

```
# /sbin/fdisk /dev/hda
```

`/dev/hda` stands for the hard drive you want to partition.

3. In `fdisk`, to create a new partition, type the following command:

```
n
```

- When prompted to specify the **Partition type**, type `p` to create a primary partition or `e` to create an extended one. There may be up to four primary partitions. If you want to create more than four partitions, extend the last partition, and it will become a container for other logical partitions.
- When prompted for the **Number**, in most cases, type `3` because a typical Linux virtual machine has two partitions by default.
- When prompted for the **Start cylinder**, type a starting cylinder number or press **Return** to use the first cylinder available.
- When prompted for the **Last cylinder**, press **Return** to allocate all the available space or specify the size of a new partition in cylinders if you do not want to use all the available space.

By default, `fdisk` creates a partition with a **System ID** of `83`. If you are unsure of the partition’s **System ID**, use the

```
l
```

command to check it.

4. Use the

```
w
```

command to write the changes to the partition table.
5 Restart the virtual machine:
```
reboot
```

6 When restarted, create a file system on the new partition. We recommend that you use the same file system as on your other partitions. In most cases it will be either the ext3 or ReiserFS file system. For example, to create the ext3 file system, run the following command:
```
/sbin/mkfs -t ext3 /dev/hda3
```

7 Create a directory that will be a mount point for the new partition. For example, to create a new directory and assign the name data to it, enter:
```
mkdir /data
```

8 Mount the new partition to the directory you have just created:
```
mount /dev/hda3 /data
```

9 Edit the `/etc/fstab` file to specify the information on the new partition. For example, you can add the following string to this file:
```
/dev/hda3 /data ext3 defaults 0 0
```

In this string, `/dev/hda3` is the partition you have just created, `/data` is a mount point for the new partition, `ext3` is the file type of the new partition. For the exact meaning of other items in this string, consult the Linux documentation for the `mount` and `fstab` commands.

### Expanding an Existing Partition

If you want to add the unallocated space to a partition that is not the last one on the given virtual hard disk, you can use third-party applications (e.g. Acronis® Disk Director Suite) designed to easily reorganize the hard disk drive without losing the data on it.

**Note:** For registered users of Parallels Desktop for Mac, Acronis Disk Director Suite is provided free of charge. You can download it from the Parallels Download Center (http://www.parallels.com/download/desktop/pdfm5-en_US) page.
CHAPTER 10

Troubleshooting and Limitations

This chapter describes how to troubleshoot known issues.

In This Chapter

Getting Technical Support ................................................................. 224
Reporting a Problem to Parallels Team ............................................. 225
Checking the Build Number ......................................................... 226
Installing Windows 98 as a Guest OS ............................................. 227
Using the F8 Key in Windows Virtual Machines ........................... 229
Upgrading or Installing Parallels Tools in Text Mode in a Linux Guest OS .............................. 230
Installing the GCC Package and Kernel Sources in Linux .......... 231
Memory Usage Problems ............................................................... 232
Configuring Network in Linux ...................................................... 233
If Your Virtual Machine Is Slow .................................................. 234
Problems with Setting Up Network .............................................. 235
Problems with Antivirus Software .............................................. 235

Getting Technical Support

If you have problems using Parallels Desktop, please first view Parallels Knowledge Base (http://kb.parallels.com/). This online resource includes valuable articles about using Parallels Desktop.

Our friendly technical support team is ready to help. Describe your problem and submit a free support request to the Parallels support team http://www.parallels.com/en/support/desktop/.

Telephone support is available on a per incident fee basis. For more information, please visit the Parallels support http://www.parallels.com/en/support/desktop/ page.
Reporting a Problem to Parallels Team

To help improve the Parallels Desktop quality, you can send problem reports to Parallels support team. If a fatal error occurs in a virtual machine, Parallels Desktop automatically opens the Problem Report for Parallels Desktop window prompting you to send a report. If you notice unusual virtual machine behavior, you can create a report manually by choosing Report a Problem from the Help menu and filling out the form. Parallels Desktop will create a status report and create a screen shot of the running virtual machine.

**Note:** Parallels team collects error reports and uses them for identifying performance issues, but does not respond to them. If you need assistance in resolving the issue, visit Parallels forum or Support page, or log us a support call.

The Problem Report for Parallels Desktop window looks as follows:
In the **Specify the problem type** field, you can select the type of your problem from the list. In the next field, you can add a short problem description. These two fields are optional.

In the **Name** and **Email** fields, type your name and email. This information will be used by the Parallels support team to address you for more technical details, if needed.

You can review the problem report components that will be sent to the Parallels support team and deselect some of them in the **Parallels Problem Report Details** window, if desired. To open this window, click **See Details**.

**Sending a Report**

After you revise the problem report components, click **Send Report**. The report will receive its unique id number and will be sent to the Parallels support team.

---

**Checking the Build Number**

To check the version and build number of the Parallels Desktop software you are using, choose **About Parallels Desktop** from the **Parallels Desktop** menu. The **About Parallels Desktop** dialog will open. See your version and the build number in the upper part of this dialog.

**Note:** The **About Parallels Desktop** dialog also provides you with the useful information about your copy of Parallels Desktop, including the licensing information and a link to the Parallels support web page.
Troubleshooting and Limitations 227

Installing Windows 98 as a Guest OS

All Windows 95 and some of Windows 98 installation packages include a bootable floppy (a startup floppy disk). The floppy is used to perform disk partitioning and formatting by means of MS-DOS. Since modern Macs have no floppy drives, you will need an external USB floppy drive or an image of a bootable floppy disk. Such an image can be created using third-party tools.

If you have a bootable CD with Windows 98 installation, you can use it as is or create an ISO image of it.

Below we describe how to install Windows 98, the case when you have a startup floppy image and a CD with the installation files. The installation of Windows 95 is similar to that.

Preparing a Virtual Machine for Windows 95/98 Installation

1. Create a Windows 98 virtual machine using New Virtual Machine Assistant. Select the Customize settings before installation option in the Name and Location window.

2. In the Virtual Machine Configuration dialog, click Hardware > Boot Order, and configure the floppy disk to be the first boot device.

3. Below the Boot Order item, select Floppy Disk to open the virtual floppy disk drive settings. In the Floppy Disk pane, do the following:
   1. Make sure the Connected option is selected.
   2. Specify the floppy disc image in the Source menu.
4 Click **OK** to save the virtual machine configuration.

**Initial Partitioning and Formatting**

1 Start the virtual machine. You will see the black screen and messages indicating the process of booting to MS DOS.

2 When prompted, enter the following command:

```
fdisk
```

Fdisk (MS-DOS utility) is used to partition hard disks and floppy disks.

3 The Fdisk options will be listed. Choose the operation to perform (the default choice is 1) and press Return (Enter) to continue.

4 Fdisk prompts you to create a partition. Select the **Create Primary DOS Partition** option if you are going to have only one partition or less than four, and enter:

```
1
```

Other choices are for the case when you want to create more than four partitions.

5 Then Fdisk prompts you to define the size of the primary partition. Press Return (Enter) if you wish to create a partition of the maximum size available.

To define other size type **N** and press Return (Enter). You will be prompted to specify the size.

6 Fdisk creates the partition and then prompts you to restart the computer (virtual machine).

7 Reboot the virtual machine using the same image of the boot floppy disk. That is, press Ctrl+Alt keys to release the keyboard input and then click the **Shut Down** button to stop the virtual machine. Then click the **Start** button.

8 When the booting is complete, you should format the system drive **C:**.

Enter the following command:

```
format c:
```

Confirm that you want to format the disk **C:** when prompted. Type **y** and press Return(Enter).

You may be prompted to choose how exactly to format your disk. Windows 95/98 supports FAT16 and FAT32 file systems.

FAT16 partition cannot be greater than 2 GB. Larger disks can be formatted with FAT32. But do not use larger disks if you are going to run legacy applications.

The program starts formatting the disk **C:**.

Format other disks too (if you created more than one primary partition or if you created a custom virtual machine with more than one disk). Use **E:**; **F:** drive letters.

9 Enter a label for each disk (11 character string). The label is optional, you can press Return (Enter) to skip this step.

10 Shut down the virtual machine.

Now you are ready to start the installation of the Windows 98 operating system.

**General steps of Windows 98 installation**

1 Start the virtual machine using the same bootable floppy image.
2 Insert the Windows 98 installation CD or connect an ISO image of the installation disc choosing CD/DVD > Connect Image from the Devices menu.

3 If you created only one primary partition (disk C:\), by default, your CD/DVD drive will have the drive letter D:. Type the command:

```
D:\setup.exe
```

and press Return(Enter). The installation starts and the files are copied from the CD to the virtual hard disk.

4 Follow the on-screen instructions of the Setup. Note that you can add or remove some options later.

5 Read and accept the License Agreement. Enter the license key.

6 Confirm the default system directory or specify another one.

7 In the Setup options dialog choose the type of installation. Typical is recommended.

8 (only for Windows 98) If you are going to use networking, select the network card when prompted.

9 Turn off the virtual machine.

10 Eject the installation CD or disconnect the ISO image.

11 Choose Configure from the Virtual Machine menu, go to Hardware > Boot Order, and select the hard disk to be the first boot device. Click OK to save the configuration.

12 Restart the virtual machine. This time, it will boot from the hard disk.

---

### Using the F8 Key in Windows Virtual Machines

You may face some difficulties when trying to use the F8 key or Ctrl+Arrow keys combinations in a Windows virtual machine. It happens because in Mac OS X, the F8 key and Ctrl+arrow key combinations are reserved for the Spaces utility.

Possible solutions:

- Click the Keyboard icon on the virtual machine's status bar (p. 39) and choose F8.
- Change the Spaces utility hotkeys settings. To learn how to do it, refer to Mac OS X documentation.
Upgrading or Installing Parallels Tools in Text Mode in a Linux Guest OS

After upgrading to Parallels Desktop, the X Server may fail to start in Linux virtual machines. To fix the problem, you need to install Parallels Tools in text mode.

1. Start the virtual machine.
2. When you see a message that X Server failed to start, switch to another virtual console using Ctrl+Alt+F1 and enter your login details.
3. Choose Install Parallels Tools from the Virtual Machine menu to connect the Parallels Tools ISO image to your virtual machine.

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be installed in your guest operating system. To see the list of guest OSs supported by Parallels Tools, refer to the Parallels Tools Overview section in Parallels Desktop User's Guide.

The prl-tools-lin.iso image file will be connected to the virtual machine's CD/DVD drive.

4. In the virtual machine console, type the following command to gain the root privileges:

   su

5. Check if the Parallels Tools CD image is mounted by entering:

   mount | grep iso9660

   If this command does not return anything, proceed to the next step.
   If this command returns anything like

   /dev/cdrom on /media/cdrom type iso9660 (ro,exec,nosuid,nodev,uid=0),

   skip the next step and proceed to the following one.
   If this command returns anything like

   /dev/cdrom on /media/cdrom type iso9660 (ro,noexec,nosuid,nodev,uid=0)

   with the noexec option present in parentheses, you need to unmount the disc using the following command and then proceed to the next step:

   umount /dev/cdrom

6. To mount the Parallels Tools installation disc image, enter the following:

   mount -o exec /dev/cdrom /media/cdrom

   Note: /dev/cdrom is the virtual machine's CD/DVD drive and /media/cdrom is the mount point for this device. In some of the Linux operating systems the virtual CD/DVD drive may appear as /dev/hdb and the mount point /mnt/cdrom. Some Linux OSs do not have the CD/DVD drive mount point. In this case, you should create the mount point directory manually.

7. When the installation disc image is mounted, change the directory to the CD/DVD drive directory using:

   cd /media/cdrom/

8. In the CD/DVD drive directory, enter the following to launch Parallels Tools installation:

   ./install
Installing the GCC Package and Kernel Sources in Linux

When installing or upgrading Parallels Tools in a Linux virtual machine, you may need to install the gcc package and kernel sources in your Linux guest OS. Kernel sources can be either downloaded from the Internet or installed from Linux distribution disks.

To install the gcc package and kernel sources in the RHEL/Fedora/CentOS Linux distribution, enter the following command in a terminal:

```
yum install gcc kernel-devel
make
```

To install the gcc package and kernel sources in the Debian/Ubuntu Linux distribution, enter the following command in a terminal:

```
apt-get install gcc make linux-headers-$\{(uname -r)\}
```

For information on how to install the gcc package and kernel sources in other Linux distributions, refer to the documentation for these distributions.

If you still experience any problems, try to find a solution in Parallels Knowledge Base (http://kb.parallels.com/) or refer to the Parallels support team http://www.parallels.com/en/support/desktop/.

---

**Note:** You must have the root privileges to run this command.

9 Follow the Parallels Tools Installer instructions to complete the installation.

10 When the installation of Parallels Tools is complete, restart your virtual machine.

For general information on installing Parallels Tools in Linux, refer to Installing Parallels Tools in a Linux Guest OS (p. 79).
Memory Usage Problems

The amount of the host computer physical memory required for each virtual machine operation can be represented as follows:

Virtual Machine Memory = Guest OS Memory + Video Memory + Virtual Machine Monitor Memory

- **Guest OS Memory** is the amount of RAM available to your guest OS. You can configure the guest OS memory amount in the **Virtual Machine Configuration** dialog.

- **Video Memory** is the amount of physical memory available to the virtual machine's video card. You can adjust the video memory amount in the **Video** pane (p. 197) of Virtual Machine Configuration.

- **Virtual Machine Monitor** is the module responsible for the guest operating system virtualization. It consumes memory to perform operations of guest virtual devices and performs virtual paging emulation. The amount of memory required for the Virtual Machine Monitor operation depends on the guest OS and varies from 50 MB to 200 MB.

Memory Overcommitment

If you have several virtual machines running simultaneously and you are trying to start one more virtual machine, you may come across the memory overcommit. The application will inform you with the corresponding message. If you start one more virtual machine, this may significantly slow down all your virtual machines. To solve this problem, you can:

- Stop one or several of your running virtual machines; or
- Edit your virtual machines' configurations so they consume less memory.
Configuring Network in Linux

When setting up network in Linux, you may need to configure the DHCP client to send the virtual machine's ID in DHCP requests. For information on how to configure your DHCP client, refer to the DHCP client documentation.

For example, in Red Hat Linux guest OSs, you need to edit the DHCP client configuration file.

1. Open the `dhclient.conf` file and make sure that the following lines are present.

   ```
   interface "eth0" {
     send dhcp-client-identifier 1:<MAC address>;
   }
   ```

2. If there are no such lines, add them manually to the file and save it.

   When the `dhclient.conf` file contains these lines, DHCP client sends the virtual machine's ID to the DHCP server. The DHCP server sends an IP address in response.

Tip

To locate the `dhclient.conf` file, in a terminal, enter:

```
strings /sbin/dhclient | grep etc | grep dhclient.conf
```

or:

```
rpm -ql dhclient
```
If Your Virtual Machine Is Slow

The most common reasons why a virtual machine becomes slow are as follows:

**Reason 1 - Not enough memory or CPU time on your Mac**

If you run a number of memory-consuming applications on your Mac and a virtual machine simultaneously, the virtual machine performance may become slow because your Mac does not have enough memory or CPU time. In this case, use Activity Monitor (Mac OS X utility) to view what applications consume your Mac's memory. If you do not really need these applications (for example, you forgot to close them or you are going to use them later), quit them.

**Reason 2 - Not enough memory set to the virtual machine**

The amount of memory set to a virtual machine by default (p. 66) is usually enough for the guest operating system and applications that do not consume much memory (for example, Microsoft Office). However, if you run memory-consuming applications, you need to increase the amount of memory set to the virtual machine. You can do this on the **General** tab (p. 171) of the virtual machine configuration.

**Reason 3 - Antivirus software may slow down your virtual machine**

Your virtual machine may become slower after you install antivirus software in it. To be protected, you have to sacrifice performance.

**Note:** Do not install more than one antivirus application in a virtual machine.

**Reason 4 - The virtual machine is running from an external storage**

If you start a virtual machine stored on an external storage connected to your Mac (for example, an external USB disk drive), its performance will be lower than of the same virtual machine stored on your Mac.

**Reason 5 - The virtual machine is not tuned for speed**

To speed up a Windows virtual machine, select **Tune Windows for speed** in the **Optimization** pane (p. 176).

**Reason 6 - Parallels Desktop creates detailed log messages**

If you select **Use detailed log messages** in the Advanced pane (p. 53) of Parallels Desktop Preferences, Parallels Desktop will start creating a more detailed log file. It can be helpful for the Parallels support team, but uses more hard disk space and may slightly lower the system performance.
Problems with Setting Up Network

If you create a new virtual machine and your Mac is connected to the Internet, the newly created virtual machine automatically becomes connected to the Internet. By default, this virtual machine is configured to work in the Shared Networking mode. You can set up another networking mode in the Virtual Machine Configuration dialog (p. 170). For more details on how to set up another networking mode, refer to the Networking in a Virtual Machine section (p. 109).

However, if you meet any difficulties with setting up the desired mode or just unable to access the Internet, you can refer to the Parallels support team http://www.parallels.com/en/support/desktop/ for a qualified assistance.

Problems with Antivirus Software

Because of the close integration with the host operating system, some actions performed by the Parallels Desktop processes may be detected as malicious by the antivirus software installed on your Mac.

However, such actions are necessary to ensure the proper functioning of Parallels Desktop. That is why you should prevent the antivirus software from blocking them. If you do not want the alerts to appear in future, perform a full system scan using the antivirus software and add these processes to the list of trusted ones if no viruses are detected. To find out how to do this, refer to your antivirus software Help.

Note: The names of Parallels Desktop processes usually start with prl or parallels.
This glossary defines terms and spells out abbreviations used in Parallels Desktop documentation. References to terms defined elsewhere in the glossary appear in *italics*.

**Administrator.** A user with administrative privileges.

**Activation key.** A unique set of symbols that activates the Parallels Desktop application on your Mac and lets you use the Parallels Desktop functionality to its full extent.

**Active operating system.** The operating system where Parallels Transporter Agent is launched.

**Active volume:** The volume of the physical source computer that is used as a boot volume for the active operating system.

**Bootable hard disk.** A disk used by the operating system to boot from, usually a disk that has an operating system installed.

**Boot Volume.** A hard disk partition from which the operating system boots.

**Boot Camp partition.** A partition on the hard disk of your Mac that can be used for installing a Windows operating system on it (for Mac host computers only).

**Bridged networking.** Virtual machine network connection mode that enables the virtual machine to appear as any other computer on the network, with its own IP address and network name.

**Configuration file.** A file specifies the virtual machine's hardware configuration, the devices it uses, and other settings. It is created automatically when you create a new virtual machine. See also *PVS file*.

**CPU.** Stands for central processing unit. It is an internal part of the computer. See also *Processor*.

**Disks in the old format.** Disks of virtual machines that were created in Parallels Desktop 2.5 and earlier or Parallels Workstation 2.2.

**Disks in the new format.** Disks of virtual machines that were created or used in Parallels hardware virtualization products starting from version 3.0.

**Expanding format.** A virtual hard disk format. An expanding virtual hard disk image file resides on your host computer and is small initially. Its size grows as you add applications and data to the virtual machine.

**FireWire connection.** A wired connection that enables a high-speed data transmission between computers.

**Guest operating system (guest OS).** An operating system installed inside your virtual machine.
**Host computer**: The computer that is used to run virtual machines. In case of Parallels Desktop for Mac, it is your Mac. In case of Parallels Desktop for Windows or Parallels Desktop for Linux, it is the Windows- or Linux-based physical computer where Parallels Desktop is installed. In the Parallels Transporter documentation, this term may define the computer that hosts the result of migration.

**Hot key.** A user-defined key or combination of keys that provides quick access to applications and commands. See also *Shortcut*.

**HDD file.** During the creation, the *virtual machine* acquires a virtual hard disk file with the `.hdd` extension. See also *virtual hard disk file*.

**Host-only networking.** Virtual machine network connection mode that creates a private network between the host computer and its virtual machines, which makes the virtual machines available from the host computer only.

**ISO image.** A special file that contains the entire contents of a CD or DVD disc commonly used to install an operating system.

**Image file.** A single file containing the complete contents and structure of a data storage medium or device, such as a hard disk drive, CD, or DVD.

**IP address.** A unique address that is assigned to a physical computer or a virtual machine that participates in computer networking.

**Linux computer.** A physical computer that has a Linux operating system installed.

**Merged disk.** A *split* disk whose parts were merged into a single disk.

**Migration.** The process of transferring data from a physical computer or a third-party virtual machine into a Parallels virtual machine or virtual disk.

**OS.** An operating system.

**Parallels Desktop for Mac.** An application that enables you to create, manage, and use virtual machines on your Mac.

**Parallels Mounter.** An application that enables you to browse the contents of your virtual machines and virtual hard disks directly in Mac OS X Finder.

**Parallels Tools.** A set of Parallels utilities that ensures a high level of integration between the primary and the guest operating systems.

**Parallels Transporter.** An application that uses data of a physical or virtual computer for creating a Parallels virtual clone of this physical or virtual computer. The resulting virtual machines can be used with Parallels Desktop.

**Parallels Transporter Agent.** An application that collects data on a physical computer and transfers it to Parallels Transporter installed on your Mac.

**Plain format.** A virtual hard disk format. A plain virtual hard disk image file resides on the *host computer* and has a fixed size that cannot be changed.
**Preboot Execution Environment (PXE).** An environment to boot computers using a network interface independently of available data storage devices (like hard disks) or installed operating systems.

**Primary operating system (primary OS).** Operating system that controls the I/O devices of the computer and that is loaded when the physical computer is turned on. It is the operating system of the physical computer where the Parallels Desktop application is installed.

**Processor.** The central processing unit, or CPU. It is an internal part of the computer.

**PVS file.** A virtual machine *configuration file* that contains information about the virtual machine resources, devices and other settings.

**Shared networking.** Virtual machine network connection mode that allows the virtual machine to use the host computer network connections. In this mode, the virtual machine is invisible to other computers on the network the host computer belongs to.

**Shortcut.** A user-defined key or combination of keys that provides quick access to applications and commands. See also Hot key.

**Snapshot.** A copy of the virtual machine state at a particular point of time. The files related to snapshots are stored in a special subfolder in the virtual machine's folder.

**Source computer.** The computer from which you are going to migrate data using Parallels Transporter.

**Split disk.** A split disk is cut into 2 GB pieces, but is stored as a single HDD file. Split disks allow you to transfer the data stored on a split disk piece by piece using a USB drive or other media that have limited space and cannot store a large virtual hard disk image file.

**Terminal.** In Mac OS and GNU/Linux operating systems, a utility that enables you to access the command line.

**Third-party virtual machine.** A virtual machine created in a third-party virtualization product, that can be converted to a Parallels virtual machine with the help of Parallels Transporter.

**Virtual hard disk (virtual disk).** A file that emulates the virtual machine's hard disk.

**Virtual Machine.** The computer emulated using Parallels Desktop. A virtual machine has its own virtual hardware and requires an operating system to control its hardware. The installed operating system and its applications are isolated inside the virtual machine and share physical hardware resources of the host computer.

**Virtual Machine Configuration.** Like any physical computer, a virtual machine has its own configuration which is set during the creation and can be later modified. The virtual machine configuration settings are stored in a PVS file.

**Virtual machine files.** Files stored in a virtual machine folder. A virtual machine has at least two files: *configuration file* and virtual hard disk file.

**Virtual hard disk file.** During the creation, the virtual machine acquires a virtual hard disk file with the .hdd extension. This file performs the functions of a real hard disk. See also HDD file.
Virtual machine template. A virtual machine that can be cloned to multiple virtual machines that will have the same configuration and data that the virtual machine template had.

VM. See Virtual Machine.

Windows computer. A physical computer that has a Windows operating system installed.
Index

3
3D acceleration - 106, 197

A
About Parallels Desktop - 8
Accessing shared folders - 154, 157
Acronis applications - 105
Activating Parallels Desktop - 22, 23
Active corners - 151, 190
Active volume - 236
Adaptive hypervisor - 176
Adding devices - 215
Adding virtual machine - 60
Address
  IP address - 53, 206
  MAC address - 206
  MAC address in a clone - 129
Administrator - 236
Administrator password - 53
Aero theme - 188
AirPort, using in virtual machine - 113
Aliases for applications - 159
Antivirus for Mac - 104
Antivirus for Windows - 104
Apple Remote - 107, 193
Automatic snapshots - 186
Automatic update check - 26

B
Backing up virtual machines - 125, 134, 186
  SmartGuard and Time Machine - 125, 186
Battery life - 176
Bonjour Printer - 120, 208
  setting up a Bonjour printer - 120
Boot Camp partition
  Boot Camp virtual machine - 71
  Importing Boot Camp - 71
Boot order - 67, 195
Bootable hard disk - 236
Bridged Ethernet networking - 109, 111, 206, 236
Browsing virtual disks in Finder - 167
Browsing virtual machines and disks
  using Finder - 33, 167
  using Parallels Mounter - 167
Build number - 226

C
CAC reader - 114
CD/DVD-ROM drive
  adding/removing - 215
  connecting/disconnecting - 39, 102
  setting up - 200
Changing
  configuration at runtime - 102
  default folder for virtual machines - 42
  toolbar icons set - 41
  view modes - 93
Changing hard disk format - 202
Chrome OS - 73
Cleaning up unused space - 202
Clips - 100
Cloning virtual machine - 129
Coherence - 144, 162
Compressing virtual disks - 205
Configuration file - 14, 236
Configuration, editing - 170
Connecting devices - 39, 215
Connecting USB devices - 49, 114, 214
Converting third-party virtual machines - 70
Copying and pasting - 168
CPU, virtual - 171
Creating a virtual machine - 60
Creating new partition
  in Linux - 222
  in Windows - 221
Crystal view - 148

D
Default folder for virtual machines - 42
Default key combinations - 45
Deleting virtual machine - 142
Devices
  adding - 215
  configuring - 195
  removing from virtual machine - 215
DHCP scope - 53, 109
Disconnecting devices - 102, 215
Disk format - 202
Disk size, changing - 202, 205
Dock
adding Windows application to - 159
using Dock in Coherence - 144
using Dock in Full Screen - 151
Documentation feedback - 12
Drag & Drop - 168
DVD-ROM drive
  adding - 215
  configuring - 200
  connecting/disconnecting - 39, 102
  removing - 215

E
Editing virtual machine - 170
Enabling 3D acceleration - 106, 197
Encrypting virtual machine - 179
Exchanging data - 154, 168
Expanding disks - 202, 217
Exploring virtual machines - 167
Expose in virtual machines - 144
Express installation - 63

F
F8 key - 229
Faster virtual machine - 176, 205
Files
  Drag & Drop - 168
  sharing files - 154
    virtual machine files - 14
Floppy disk drive - 199
Folder - 42
  for virtual machines - 42
    sharing folders - 154, 181
    Windows Applications folder - 144, 184
Full Screen mode - 151, 190

G
Gaming - 106, 193
General preferences - 42
Gestures - 107
Getting support - 224, 225
Guest operating system - 8
  definition - 236
  installing - 63, 67
  supported guest operating systems - 61, 67

H
Hard disk
  adding - 215, 218
  compressing hard disk - 205
  configuring - 202
  formats and types - 14, 217
  resizing - 202
  using Boot Camp as hard disk - 71, 202
  viewing hard disk content - 167
Hardware - 195, 215
HDD file - 14
Hidden messages - 42, 53
Host computer
  definition - 236
  hardware requirements - 17
  software requirements - 17
Host-only network - 59, 112, 236
Hot keys - 45, 99, 236

I
Increasing hard disk capacity - 202, 218
Installing
  guest operating system - 63, 67
  Parallels Desktop - 16, 18
  Parallels Tools - 74
  Windows 98 - 227
  Windows applications - 99
Interface basics - 30
Internet access - 109
IP address - 53, 112
iPhone - 51, 141
iSight camera - 114
Isolating virtual machine - 69, 179

K
Key combinations - 45, 99, 229
Keyboard and mouse
  capturing and releasing - 98
  F8 key in Windows guest OS - 229
  keyboard preferences - 45
  keyboard profiles - 45
  keyboard shortcuts - 45, 99
Keyboard shortcuts - 45, 99

L
Linux
  creating new partition - 222
  installing Parallels Tools - 75, 79
  printers in - 118, 122
  supported versions - 61
Log messages - 53

M
MAC address - 206
MacLook theme - 152
Making screen shots - 100, 101
Making snapshots - 134, 135, 186
Manual update check - 27
Memory
  in virtual machine - 14, 171, 232
  required on host computer - 17
  troubleshooting - 232
  video memory - 197
Migration from PC - 72
Modality view - 95, 192
Mount virtual disks - 167, 181
Mouse
  capturing in virtual machine - 98
  synchronization - 75

N
Network adapter
  adding - 215
  connecting and disconnecting - 102
  networking in virtual machine - 109
Network printer - 122
Networking
  Bridged - 111
  Host-only - 112
  Shared (NAT) - 109, 206
  WiFi - 113
OpenGL - 106, 197
Opening a virtual machine - 70
Operating system
  installing in virtual machine - 63, 67
  supported guest OSs - 61

P
Parallel port - 208
Parallels Desktop
  activating - 22, 23
  installing - 16, 18
  preferences - 42
  registering - 24
  starting - 30
  uninstalling - 28, 29
  updating - 25
  upgrading - 21
Parallels download center - 18
Parallels Image Tool
  creating new partition - 221, 222
Parallels Internet Security - 104
Parallels Mounter - 167
Parallels network adapter - 206
Parallels Tools
  installing in Linux - 79
  installing in Mac OS X - 82
  installing in Windows - 77
  overview - 75
  uninstalling - 88
  updating - 86
Parallels Transporter - 72
Parental control - 179
Partition
  creating new in Linux - 222
  creating new in Windows - 221
  expanding existing partition - 223
Password protection - 179
Pausing virtual machines - 91
Permanent activation key - 23
Plain disks - 217
Port forwarding - 109
Power, saving - 176
Pre-configured virtual machines - 73
Preferences for Parallels Desktop - 42
Primary operating system
  definition - 236
  supported primary OSs - 17
Printer
  setting up a Bonjour printer - 120
  setting up a network printer - 122, 205
  sharing Mac printer - 118
Printer port - 208
Problem report - 225
Protecting virtual machine by password - 179
PVM file - 14
PVS file - 14

R
Reducing disk size - 205
Registration - 24
Releasing keyboard and mouse - 98
Remapping keys - 45
Removing
  devices - 215
  Parallels Desktop - 28, 29
  Parallels tools - 88
  snapshots - 137
  virtual machine - 142
Reporting problems - 224, 225
Restoring hidden messages - 42, 53
Resuming virtual machines - 90

S
Safe Mode - 128, 179
SAV file - 14, 91
Screen Resolution - 75, 190, 197
Screen shots
for problem reports - 225
of virtual machine - 101
Screen tearing prevention - 197
Searching Parallels disks - 167
Security settings - 53, 179
Serial port - 210
Setting preferences - 42
Setting up a printer - 117
Shared applications - 159, 162, 165
Shared folders - 154, 157
Shared network (NAT) - 109, 206, 236
Shared Profile - 158, 181
Shared web applications - 165, 184
Sharing
files and folders - 154, 181
Windows disks to Mac OS - 154, 167, 181
Shortcuts for applications - 159
Shutting down virtual machine - 90
SmartGuard - 125, 179, 186
SmartMount - 167, 181
SmartMouse - 193
SmartSelect - 144, 162
Snapshot Manager - 134, 137
Snapshots - 134
working with - 134, 135, 137
Software license agreement - 18
Software requirements - 17
Sound device - 212
Split disks - 14, 217
Starting
Parallels Desktop - 30
Parallels Transporter - 72
virtual machine - 33, 90
Startup mode - 174
Status bar
connecting and disconnecting devices - 39, 102
Stopping virtual machine - 90
Support - 224
Supported file formats and systems - 217
Supported guest operating systems - 61
Suspending virtual machine - 91
Switching between view modes - 93, 95
Switching from PC to Mac - 72
Switching to Coherence - 144
Switching to Full Screen - 151
Synchronizing
Palm OS device with guest OS - 99, 117
Screen vertical synchronization - 197
System requirements - 17
T
Technical support - 224, 225
Third-party virtual machines - 70
Time Machine backup - 125, 186
Time synchronization - 193
Toolbar - 36
Touchpad gestures - 107
Trial activation key - 23
Troubleshooting - 224
Turning off virtual machine - 90
Typical virtual machines - 66
U
Unallocated space
creating a partition - 218
Unused space, cleaning up - 202, 205
Update check - 25
Updating Parallels Desktop - 25
automatically - 26
manually - 27
Updating Parallels Tools - 86
Upgrading from previous versions - 21
URL handling - 165, 184
USB
configuring USB - 214
using USB devices in virtual machine - 114
V
Video memory - 197
View modes - 93, 95
Virtual appliances - 73
Virtual hard disk
adding new virtual disk - 202, 215, 218
backing up data - 125, 134
browsing in Mac OS - 167
changing format - 202
configuring - 202
disk formats - 14, 217
HDD file - 14, 236
increasing capacity - 202
Virtual machine
backing up - 125
cloning - 129
color - 33
configuring - 170
creating - 60
deleting - 142
exploring - 167
opening - 33, 70
pausing - 91
resetting - 90
resuming - 90, 91
saving state - 134
shutting down - 90
starting - 90
suspending - 90, 91
typical configurations - 66
virtual machine files - 14
Virtual machine configuration - 170
Virtual machine technology overview - 13
Virus protection - 104
VMware virtual machine
  using in Parallels Desktop - 70

W
Web applications - 165
Welcome screen - 31
WiFi - 113
Window view mode - 93, 95
Windows Aero - 188
Windows applications
  adding to Dock - 159
  adding to Favorites - 159
  Parallels Tools - 75, 77
    Windows applications folder - 14, 144, 148
Windows disks folder - 14
Windows taskbar
  in Coherence mode - 144